FORTH

InsightCM™

3.171.1 User Manual

A~/ |
e ' peak-Peak
2

/
/ AN A, —
o
I|'| i A /,"‘\ et . S A e ./
\ f J
[ f \
/ [N I|III I ll [\] peak-Peak
| » -
f o NN B/
P I Vs Pt -/‘//\J 2018-05-14 09:59:59
ATV 1¢ Peak-Peak 430
2% Peak-Peak 7.66

22 May 24 May 26 May
O w & &

16 May 18 May 20 May

14 May
G608 N gal ~apioE=

08 May

gazf=
| Y X
L @\ 6||
[ # ’.a“"_""-\
N.':",.r/ - y % 4|| B
| | = 2
L II| \\l:‘ y :,0‘ E '.g |
of 2|
: 0 I| I| . i | -
ml mil UU 200 400 600 . 800 1000 1200 1400
x:-0.378mill, y:20.790mil
v 4 o2 gl e&= o8 2aol O o=
Name CrestF.. | Gap(v- | Peak.. | RMS | ;
| ] A ", f | r’ A II". \ g
x 162 868 766 253 J (. /' I(" /. fy / l, !. [, g
X 1.64 244 430 1.38 ‘;."'!l I ( .'lﬂl ( i,ﬂ” "“ /\| (] q‘l A f( | »
| | If '
= of | | | I | |
UL
na nJd I- 1| i |: I / |
.gﬂ .'I ¢ I-' L‘ f L'Ui' l.'J|| /I L‘I. }k.'ll/\' / \\ll ‘l'l \.I \'l _\-;"En
| / f =
[V -."Jl v o L / |L-I L’ ! &
4I
0 0.05 0.1 0.15
Time (5)
1X- 1xMag: 3.91mil pk-pk, 1xPhase: 147.62¢, Speed: 3600.05rpm

The Power of Innovation

ICM3.11.1 Rev A




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

Table of Contents

1. ABOUE CUESTOPTN ..o e 6
1.7, CUESTOrth ProdUCES ..o 6

1.2. Cutsforth Field SErVICES .......c.oviiiii 6

1.3. Cutsforth Automation and Control SErVICES ............cc.viiiiiiii 6

2. Legal INformation ... 7
2.7, LIMIEEA VWAITANTY ... e 7

P a0 o o | | 8
2. 8. PaEBNES it 8

3. SafEly INfOPMIEEION ... 9
3.1. Safety Information [ENglish] ... 9
3.71.71. Safety CONVENLIONS ..o 9

3.1.2. General Safety INSEPUCEIONS ... e 9

3.2. Consignes de SEcUrité [FranCaisS] .......ovoeiiieiie e 10
3.2.71. Conventions de SECUNILE .......ouieir i 10

3.2.2. Consignes de Securite GENErales ...........coooiiiiiiiii e 11

49 10 1=1Te ] a1 @ \V/ I a1 ol o (U o1 A a] o NN 12
4.1. InSIghtCM NEW FEAEUPES ... .. et 12

5. INSIGhtCM READIME ... e 13
BT INSIGhECM BT T T o 13

6. Overview of the INSIghtCOM SYSEEM ... e 15
6.1. User Interface Quick BEfErENCE .......ooieii e 15

B.2. SEEUP ProCESS DVERVIEW ....viiiitiit e 16
B.2.7. Reserved CharaCters ........o.ouieiriiiii e 17

6.2.2. Options and Features Requiring a Password Configuration ....................o..... 18

B. 3. BlOS S Ay ittt e 19

Q72 =] v To T 7= 1= 22
7.7, Installing INSIghtlM ... 22
7.1.1. InsightCM Data DIirECEONIES . ..euieeiiiii e 23

7.1.2. Changing the Data Dir€CEONY .......ouiuiii i 23

7.2. Upgrading INSIghtCIM ... 23

7.3. Licensing INSIghtCIM SBPVER ... e e 24

7.4, Configuring YOUP ASSEE TP ..iuiiiiitii it 25
7.4.7. Organizing YoUr ASSEES ......c.iuiiiiii e 26

7.4.2. Adding Equipment Assets and MONILOrS .........cooiiiiiiiiiii 26

7.4.3. Adding SENSOP ASSEES ...ttt 27

7.4.4. Validating YoUPr ASSEBES ....viieieiii e 27

7.4.5. Adding Notes and Instructions About an ASSEL ..........cocvvviviiiiiiiiiiiia, 28

7.4.8. List Of FEAEUPES ... 29

7.4.7. List 0f ASSEE PropertiEs .....iviiiii 33

7.5. Adding Cutsfarth Monitoring DEVICES .......oviiiiii e 43
7.95.7. ContinUOUS DBVICES ... .uiuiiiiii i e 43

7.5.2. Wireless Gateways and DEVICES ...........ccuieiiiiiiiii e 49

7.5.3. Thermal Imaging DeVICE TYPES ....urii e a7

7.6. Finding or Setting a Device IP ADAress .........oooiiiiiii e 63

7.7. Permission-Based Access to the Web Application .............cooiiiiiiiiiiii 65

8. Customizing Your INSightCM SYSEEM .. iu et e 66
8.7, Configuring AlBIIMIS ... 66

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

8.1.1. Configuring a Trend Alarm RUIE ..., 67
8.1.2. Configuring Spectral Alarm RUlIES .........oiiiii 73
B.71.3. OPErating SEatES .....uiiiiitit e 74
8.1.4. Setting up Email Alarm NOEGIfications .........oiiiiii e 80
8.1.5. Acknowledging a@n Alarm ... 87
8.1.6. Conditions for Setting and Clearing Alarms ..........coiiiiiiiiiiie e 88

B.2. DALA SOUNCES ...niitt ittt e 90
8.2.1. Modbus CommMUNICATION ... ...t aenees 90
8.2.2. OPC UA CommUNICATION ...ttt eenes 90
B.2.3. Historian SOftware ... ... 90
8.2.4. Creating and Configuring @ Data SoUrCe ..........ccooviiiiiiiiii 90
8.2.5. Data Source TYpe PropertiES ......o.iiiiiii e 91

8.3. Maodifying Device Communication and Configuration .............cccocoiiiiiiiiiiiiieens 93
8.3.1. Changing Device Configuration Settings ........cccoiiiiiiiiiii e, 94
8.3.2. Reintegrating Quarantined Endpoints ..o 94
8.3.3. Adding or Removing Units of Data .........cccoiiiiiiii e 95
B.3.4. SUPPOrtEd UNIES oottt 95
8.3.5. Changing Measurement Type Units ta MEtric ...........cocooviiiiiiiiiiiiii 96
8.3.6. Updating Device SOfEWAre ........c.ouiiiiiii e 96
8.3.7. Upgrading Device HardwWare .............ccooieiiiiiiii e 97
8.3.8. Uploading or Removing Software Packages ...........c.ccooviiiiiiiiiiiniiin, 97
8.3.9. What Happens to Files When You Update Device Applications ...................... 97
8.3.10. Review Detailed Device Information ..........c.cooiiiiiiiii e 98
8.3.11. Device Property Configurations ...........coviiiiiiii e 99
8.3.12. Resetting a Device to Factory Settings .........cccovviiiiiiiiiiii e, 101

B.4. Modifying an ASSEE TY P ...ttt 101
8.4.1. Editing the Behavior of an Asset TYPE ....vvviiiiiiiiccc e 101

B.5. CollEeCtiNg DEEA ...t 102
8.5.1. Configuring Data Collection for Wireless Equipment ..., 103
8.5.2. Configuring Collection Conditions for Thermal Imaging Devices .................... 104
8.5.3. Deactivating @ SBNSOI .. ...t 104
8.5.4. Disabling ASSEES ... ...ttt 105

8.6. Adding Bearings or Fault Frequency Groups to an ASSEBE .........cccoveiiiiiiiiiiiaannn. 105
8.7. Assigning FEatures £0 SENSOMS ...t 106
8.7.1. Defining Feature Options for SENSOrS .........cooiiiiiiiii 107

B.8. BatCh Editing ASSBES ...viiiiii i 107
8.8.1. Asset Definition Spreadsheets .........ccoiiiiiiiii 108
8.8.2. Batch Updating Device Configurations with a Device Spreadsheet ................ 112

8.9. Validating SENSOP Data .....viiiiitii e 113
8.9.1. Difference Between Range Check and Input Range ............cocoooiiiiiiiiinn, 114
8.9.2. Audit Logger Tab on System Page ........cooiiiiiiiiii 114

. VIBWING DA ..ottt e 115
9.1, Viewing Trend Data .....o..oeieiii e 115
9.2. Parts of the Data VIBWED ... 116
9.2.7. Operating MOGBS ......couiiiii e 117
9.2.2. Switching between Periodic and Stream Data Modes ................cocooiiiine. 117

O, 2.3, AULO-PE BN . 117
9.2.4. Multiple Trend VIEWEE CUPSONS ...ttt 117

9.3, Streams Of Data ... 118

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

9.3.1. INtroduction £0 SEPBAMIS .....uiiiie e 118
9.3.2. How Streams WWOrK ... 118
9.3.3. RUN-UP EXGMPIE ... 119
9.3.4. Behavior when Devices Monitor Multiple Pieces of Equipment or Multiple
Devices Monitor the Same EqUIPMENE ... 119
9.3.5. Streams versus Periodic ACQUISITIONS ......o.ieiiieiii e 120
9.4, Watching @ LiVe SEPEaM ... vt 120
9.5. Loading Historical SEramMS ... 121
9.6, Data PaCKAgES ... c.iuitiitiii e 121
Y = o 122
9.7.1. Adding Harmonic and Sideband Cursors to Viewers ..............cccociiiiiiiinnnn. 123
9.7.2. Adding, Changing, and Removing VIEWEPRS ..........ccooiiiiiiiiiiiiiceeeee, 124
9.7.3. Stacking Charts in the Same VIEWER .........ccoiiiiiiiiiee e 125
9.7.4. Madifying Default Units and Scaling for Data ...........ccooviiiiiii, 125
B T T 7= T ol Y o1 125
9.7.6. Keyboard ShOPECULS .....c.ieie i 131
9.8, EXIt CONAIBIONS ...ttt e e 132
9.9, ANAIYZING DEEA ... et 132
9.9.1. ANNOtating Data ... 132
9.9.2. Changing the Time Range of Trends ..........c.coiiiiiiiii e 133
9.9.3. Compensating for SIow-Roll Data ..........cccoviiiiii 133
9.9.4. Compensating for DC Gap OffSet .......ocviii 134
9.9.5. Analyzing Unusual Data EVENES ..o 134
9.9.6. Integrating or Differentiating Data ... 135
9.9.7. Correlations of Data to Speed and Events ...........cccooiiiiiiiiiiiii e, 135
G.10. Preserving Data ...o.o.iiiiiii e 136
G170, Deleting Data ....voeieiiii e 137
9.12. User-Initiated TrigQerS ...t 137
9.12.1. What Happens When Triggers Occur During Data Collection? .................. 138
9.12.2. Force Triggering an Acquisition for One Data Group ...........cocoevvviiiinnnnn. 138
9.12.3. Manually Requesting Temporary High-Resolution Data Acquisition .............. 139
9.13. Baselines and Data Event ReferenCeS .........coouieiiiiiii i 140
9.13.1. Creating a Trend Baseling ...........cooiiiiiiii 140
9.13.2. Displaying Individual Trend Values ..o, 140
9.13.3. Viewing Historical Data ..........ccoiiiiiiii 141
9.13.4. DoWNSAMIPIING . .eniii e 143
9.13.5. Comparing Measurements from Different Sources or Times .................... 143
10. Server Configuration and MaintenanCe ..........ciiiiii i 145
10.1. Configuring INSIGhtCM ... .. e 145
10.1.1. Opening Required Ports for Communication ...........c.ccooviiiiiiiiiiiienns 145
10.1.2. Generating an APIKBY ... 146
10.1.3. Accessing InsightCM Data Services Using HTTP APl ..........ocooiiiiiiiints 147
10.1.4. Enabling SSL CONNECEIONS ...ttt et aeenes 150
10.1.5. Requiring SSL CONNECHIONS ...ttt ittt e aeenas 151
10.1.6. Integrating InsightCM with Windows Active Directory ...........cccocoviveiinenn. 1591
10.1.7. Managing Roles and PEermissions ..........c.cocoiiiiiiiiiiiice 152
10.1.8. Historian Software ..o 157
10.1.9. Configuring Your Server FIBBE ......cooviiiii i 167
10.1.10. Defining @ TranSCEIVER .....utiiiiiee et eees 168

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

10.1.11. Transferring InsightCM Data to a New Server ............ccocooiviiiiiiiiiiinnnnn. 168
10.2. Maintaining INsSightCM ... . 169
10.2.1. Managing Packages ..........ociuiuiiiiiiii e 169
10.2.2. AQING SEPAEERgIES .. vuiuiiititii et 170
10.2.3. Configuring @an Aging SEratEgY ......eirieieieii e 171
10.2.4. Preserving Data from Aging Strategies ..........cocviiiiiiiiiiiiiiiiieieeeans 172

1. TroUBIESNOOTING ... 174
11.1. Logging Important Event Details ... 174
11.1.1. Exceptions for Device-Related Tracepoints ............coooviiiiiiiiiiiiiiiie, 174
11.1.2. Notable TraCePOINTS ...t 175
11.2. Resolving and Clearing an Invalid Configuration ..............cocoiiiiiiii 175
11.3. Troubleshooting Deployment ISSUES .........iiiiiii e 176
11.4. Troubleshooting Devices That Do Not Come Onling .........cooooviiiiiiiiiiiiieeee, 176
11.4.1. Logging Information about the Connection Process ..............cccovviiiiiinnnnn. 177
11.5. Troubleshooting the Connection between the Server and a Device ....................... 178
11.6. Troubleshooting Email DeliVErY ..o 178
11.7. Errar Values for Integrated FEAtUrES ...........ccouiiiiiii e 179
11.7.1. Common Causes of ThiS ISSUE ..o 179
11.7.2. How Filtering Affects the Duration of Integrated Data ...............cccoooeienne. 180
11.7.3. Working Around ThiS ISSUE ... 180
11.8. Replacing a Device in INSIGhtCM ... 180
11.9. Testing Sensors to Validate Hardware ..o 181

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

1. About Cutsforth

1.1.

1.2.

1.3.

Cutsforth specializes in developing innovative new technologies and services to support the power
generation industry. Cutsforth's patented EASYchange® brush holder design, online truing service,
InsightCM™ condition monitoring software, and patented shaft grounding and monitoring systems
have been installed across the globe in generators of all sizes and in nearly every industry application,
including nuclear, natural gas, coal, wind, and hydroelectric.

Cutsforth's knowledge and commitment to excellence drives our innovative solutions for the changing
needs of the power industry. Whether it is a quick response to a critical situation or a new way of solving
an old problem, our commitment to quality ensures that our customers receive best-in-class products
and services—Cutsforth is the Power of Innovation.

Cutsforth started back in 1991 as a small company focused primarily on making replacement

brush holders for generators and exciters. Today, after 30+ years in business, Cutsforth's experience
and innovative designs have brought its best-in-class excitation brush holder and shaft grounding
replacements and collector ring services to some of the world's largest power companies.

Cutsforth Products

= EASYchange® Removable Brush Holders

= EASYchange® Brush Condition Monitoring
= Cutsforth Shaft Grounding Systems

= Rotor Flux Monitoring

= Electro-Magnetic Interference Monitoring

* InsightCM™ Condition Monitoring Software

Cutsforth Field Services

Cutsforth provides comprehensive product installations for all product offerings as well as on-site
training after the installation. We work efficiently during your outage to ensure a smooth upgrade to
our innovative solutions such as Product Installations, Online Collector Ring and Commutator Truing,
Spiral Groove Restoration, and Consulting and Emergency Services.

Cutsforth Automation and Control Services

Cutsforth provides comprehensive Automation and Control services which include data historian
integration, InsightCM™ integration, DCS logic, engineered drawings and much more. This further
complements our turnkey monitoring system installations.
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2. Legal Information

2.1. Limited Warranty

This document is provided ‘as is" and is subject to being changed, without notice, in future editions.
Cutsforth reviews this document carefully for technical accuracy; however, CUTSFORTH MAKES NO
EXPRESS OR IMPLIED WARRANTY AS TO THE ACCURACY OF THE INFORMATION WITHIN THIS
MANUAL AS IT RELATES TO SPECIFIC INSTALLATION. THE CUSTOMER IS RESPONSIBLE FOR
VERIFYING INSTALLATION AND OPERATING CONDITIONS AT EACH INSTALLATION LOCATION AND
FOR EACH GENERATOR TYPE. Cutsforth warrants that its hardware products will be free of defects
in materials and workmanship that cause the product to fail to substantially conform to the applicable
Cutsforth published specifications for one (1) year from the date of invoice.

For a period of ninety (90) days from the date of invoice, Cutsforth warrants that (i) its software products
will perform substantially in accordance with the applicable documentation provided with the software,
and (i) the software media will be free from defects in materials and workmanship. If Cutsforth receives
notice of a defect or non-conformance during the applicable warranty period, Cutsforth will, in its
discretion: (i) repair or replace the affected product, or (i) refund the fees paid for the affected product.
Repaired or replaced hardware will be warranted for the remainder of the original warranty period or
ninety (90) days, whichever is longer. If Cutsforth elects to repair or replace the product, Cutsforth may
use new or refurbished parts or products that are equivalent to new in performance and reliability and
are at least functionally equivalent to the original part or product. You must obtain an RMA number from
Cutsforth before returning any product to Cutsforth. Cutsforth reserves the right to charge a fee for
examining and testing hardware not covered by the Limited Warranty.

This Limited Warranty does not apply if the defect of the product resulted from improper or inadequate
maintenance, installation, repair, or calibration performed by a party other than Cutsforth; unauthorized
modification; improper environment; use of an improper hardware or software key; improper use or
operation outside of the specification for the product; improper voltages; accident, abuse, or neglect; or a
hazard such as lightning, flood, or other act of nature.

THE REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND THE CUSTOMER'S SOLE REMEDIES, AND
SHALL APPLY EVEN IF SUCH REMEDIES FAIL OF THEIR ESSENTIAL PURPOSE.

WARNING REGARDING USE OF CUTSFORTH SHAFT MONITORING EQUIPMENT: CUSTOMER IS
ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY AND RELIABILITY

OF THE PRODUCTS WHENEVER THE PRODUCTS ARE INCORPORATED IN THEIR SYSTEM OR
APPLICATION, INCLUDING THE APPROPRIATE DESIGN, PROCESS, AND SAFETY LEVEL OF SUCH
SYSTEM OR APPLICATION. PRODUCTS ARE NOT DESIGNED, MANUFACTURED, OR TESTED FOR USE
IN LIFE OR SAFETY CRITICAL SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF THE
PRODUCT OR SERVICE COULD LEAD TO DEATH, PERSONAL INJURY, SEVERE PROPERTY DAMAGE
OR ENVIRONMENTAL HARM (COLLECTIVELY, "HIGH-RISK USES"). FURTHER, PRUDENT STEPS MUST
BE TAKEN TO PROTECT AGAINST FAILURES, INCLUDING PROVIDING BACK-UP AND SHUT-DOWN
MECHANISMS. CUTSFORTH EXPRESSLY DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY OF
FITNESS OF THE PRODUCTS OR SERVICES FOR HIGH-RISK USES.
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2.2.

2.3.

CUTSFORTH DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING

THE USE OF OR THE RESULTS OF THE USE OF THE PRODUCTS IN TERMS OF CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE. CUTSFORTH DOES NOT WARRANT THAT THE OPERATION
OF THE PRODUCTS WILL BE UNINTERRUPTED OR ERROR FREE. INCIDENTAL AND CONSEQUENTIAL
DAMAGES, INCLUDING LOSS OF USE, ARE SPECIFICALLY EXCLUDED FROM THIS WARRANTY; THE
MAXIMUM VALUE OF A WARRANTY CLAIM CANNOT EXCEED THE ORIGINAL VALUE OF THE ASSEMBLY
OR COMPONENT.

Copyright

Under copyright law, this publication may not be reproduced or transmitted in any form, electronic or
mechanical, including photocopying, recording, storing in an information retrieval system, or translating,
in whole or in part, without the prior written consent of Cutsforth. Cutsforth respects the intellectual
property of others, and we ask our users to do the same. Cutsforth software is protected by copyright
and other intellectual property laws. Cutsforth software is only licensed to be run on the intended
hardware for which it was purchased. Reproduction of software or written materials is prohibited unless
Customer has obtained a license for that express purpose.

Patents

Please send patent information requests to patents@cutsforth.com.
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3. Safety Information

3.1. Safety Information [English]

Following is important safety information. For safe installation and operation of this equipment, be sure to

read and understand all cautions and warnings.

3.1.1. Safety Conventions

o NOTE:
Additional information.

CAUTION

Indicates a hazardous
situation that, if not avoided,

>

ELECTRICAL DANGER

Indicates an action or specific equipment
area that can result in personal injury or
death from an electrical hazard if proper
precautions are not taken.

WARNING

Indicates a hazardous situation that, if not
avoided, could result in death or serious

could result in minor injury.
or moderate injury or
equipment damage.

B>

ROTATING PART ‘ DANGER

CAUTION Indicates a hazardous situation that, if not
Indicates possible injury avoided, will result in death or serious injury.
from rotating parts.

3.1.2. General Safety Instructions

>

ELECTRICAL DANGER

\\\
7 g

Only qualified personnel who recognize shock hazards and are familiar with the safety
precautions required to avoid injury should work with Cutsforth products. Among the
many considerations are the following:

= Avoid contact with energized circuits.

Avoid contact with rotating parts.
= Never install any component that appears not to be functioning in a normal manner.

= Always ensure proper installation of the holder assembly and shaft grounding rope.
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ELECTRICAL DANGER

Before working on the generator, de-energize, lock out, and tag out all power sources to
the generator, shaft, and accessory devices. Electric shock and death may result due to
failure to heed this warning.

ROTATING PART CAUTION

High-voltage and rotating parts can cause serious or fatal injury. Installation, operation,
and maintenance of this product must be performed only by qualified personnel, in
accordance with all applicable safety regulations and guidelines.

3.2. Consignes de Sécurité [Francais]

Les informations qui suivent sont essentielles afin d'assurer la sécurité de I'utilisateur lors de l'installation
et de l'opération de I'équipement. Assurez-vous de bien lire et de comprendre tous les avertissements et
mises en garde qui suivent.

3.2.1. Conventions de Sécurité

NOTE:

Informations
supplémentaires.

/f\ RISQUES DE CHOC ELECTRIQUE
(/ \\\

Indique que l'action ou la partie de
|'équipement concernée peut mener a des
blessures par électrisation ou a la mort par
électrocution siles précautions adéquates
ne sont pas prises.
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B>

MISE EN GARDE

Indigue la présence d'une
situation dangereuse qui, Si
elle n'est pas évitée, pourrait
mener a des blessures
mineures a modérées ou a
des dommages matériels.

MISE EN GARDE : PIECE
ROTATIVE

Indique la présence

de pieces d'équipement
rotatives pouvant causer des
blessures.

A

A

AVERTISSEMENT

Indique la présence d'une situation
dangereuse qui, si elle n'est pas évitée,
pourrait mener a des blessures séveres ou
alamort.

DANGER

Indique la présence d'une situation
dangereuse qui, si elle n'est pas évitée,
pourrait mener a des blessures séveres ou
alamort.
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3.2.2. Consignes de Sécurité Générales

RISQUES DE CHOC ELECTRIQUE

L'utilisation des produits Cutsforth n'est recommandée qu'aux professionnels qualifiés
qui savent comment reconnaitre la présence de risques de choc électrique ainsi que
les consignes de sécurité a suivre pour éviter les blessures liées a ces risques. Lesdites
consignes de sécurité incluent, sans s'y limiter :

Eviter tout contact avec des circuits alimentés;
= Eviter tout contact avec des piéces d'équipement rotatives:;
* Ne jamais installer de composante ne paraissant pas fonctionner normalement;

= Toujours s'assurer que la structure de soutien et le cable de terre de I'arbre de la
génératrice sont correctement installés.

RISQUES DE CHOC ELECTRIQUE

Avant de travailler sur la génératrice, désalimentez, cadenassez et étiquetez toutes

les sources d'énergies liées a la génératrice, a l'arbre et aux appareils accessoires.
L'opérateur s'expose a des risques de chocs électriques pouvant causer la mort s'il ne
tient pas compte de cet avertissment.

A MISE EN GARDE : PIECE ROTATIVE
) S G CERO

Les pieces d'équipement rotatives et sous haute tension peuvent causer des blessures
séveres ou fatales. L'installation, 'opération et la manutention de ce produit ne doivent
étre faites que par des professionnels qualifiés et en respectant toutes les regles et
consignes de sécurité applicables.
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4. InsightCM Introduction

The InsightCM™ Manual contains guidance for setting up new condition monitoring systems in the
InsightCM web application, instructions for customizing data collection and maintenance, information on
viewing data for analysis, and troubleshooting material.

Top Tasks
What do you want to do? Where to go
Add and configure assets that monitor your equipment in software. Configuring Your Asset Tree (page 25)
Map sensors to specific channels on a device and group all sensors Adding Cutsforth Monitoring Devices
for one equipment asset into a data group for which you can configure (page 43)

data-collection behaviors.

Force an initial acquisition to test whether your system is successfully Acquiring Data (page 48)
acquiring data.

Acquiring Data for Wireless Devices

(page 57)

Configure a trend alarm for an asset. Configuring a Trend Alarm Rule (page
67)

Review supported data historian. Historian Software (page 157)

4.1. InsightCM New Features

Refer to the InsightCM Release Notes to learn what's new in InsightCM.

Refer to the InsightCM README (page 13) for further technical information on each release.
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9. InsightCM README

9.1.

About InsightCM™

InsightCM is a software solution for online monitoring to be used with Cutsforth monitoring hardware. In
the InsightCM web application, you can configure and manage monitoring devices, set alarm rules, view
acquired data, determine how InsightCM stores data, and more.

InsightCM Release Notes lists changes for major and minor releases.

InsightCM 3.11.1

Refer to the Release Notes to learn what's new in InsightCM 3.11.1.
System Recommendations

The following sections describe the recommended specifications for the InsightCM Server. InsightCM
and SystemLink are incompatible and should be installed on separate servers.

Note Cutsforth recommends using solid state drives to improve disk throughput.

Note Cutsforth recommends using the following browsers and screen resolutions to access the
InsightCM web application. Internet Explorer is not a supported browser.

* The latest version of one of the following browsers:
= Google Chrome
* Microsoft Edge

= Screen resolution of 1920x1080 pixels or higher.

Note If you use the InsightCM Server Enterprise Gateway Toolkit add-on with OSlsoft Pl System software,
you must install the OSlsoft Pl Asset Framework (AF) Client.
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Systems with fewer than 10 Systems with fewer than 50 Systems with more than 50
Monitoring Devices Monitoring Devices Monitoring Devices
= Windows 10 or Windows 11, = Windows Server 2016, 2019, or = Windows Server 2016, 2019, or
64-bit Professional 2022 2022
= 2.2 GHz, 4-core processor = 2.2 GHz, 8-core processor * 3 GHz 16-core processor
= 16 GBRAM = 16 GBRAM = 32 GBRAM
= One physical hard drive for = Two physical hard drives: = Two physical hard drives:
OtSrFr)] rogrimf{lnsta_llz?lon, atn5dOO = For OS and program installation = For OS and program installation
stonng data fies eas —At least 250 GB disk space —At least 250 GB disk space
GB disk space
= For storing data files—At least 1 = For storing data files—At least 2
TB disk space TB disk space

Installation File Hash

The following table provides the installation file hash for InsightCM 3.11.1.

Insight Hash Function Hash Value
CM

Versio
n

3.11.1 SHA256 cdféaafOb3fadb1c468a386e6643c5a0b8066d57e945982dd504f236fa149ade
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6. Overview of the InsightCM System

The InsightCM™ Manual refers to various nodes within the order of the InsightCM system. To orient you
at any stage during setup, learn the components of the InsightCM system and how each component
functions in relation to the others.

_» ——
And/ Continuous Devices
Or
-+ <— — -
Equipment Sensors Server Client Computer
— <> <+
Endpoint MON-10496

Wireless Devices

System Component Description

Equipment The asset whose health you are using the InsightCM System to monitor.

Sensors InsightCM supports a variety of sensors that collect data from fixed points on your
equipment.

Wireless/Continuous The monitoring devices are used to relay data from the sensors to the InsightCM

Devices server.

Server The server with InsightCM is installed.

Client Computer The computer uses the InsightCM web application - a browser-based tool for
configuring monitoring devices and visualizing data - to access the InsightCM server.

6.1. User Interface Quick Reference

Use the diagram and the terms below to learn how to navigate the web application.

TTY T

@& - M Device configuration InsightCM Q v
@{ Devices Software
+ Add & Edit @ Remove filter by device A ¢ Auto Refresh: | 30sec ~ | & =

=
E&— U

Description

@ Navigation bar Links to pages users require most frequently.
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Term Description

@ Tabs When present, provides page-specific actions and
information.

@ Dashboard page Contains an overview of the system.

@ Asset and Device Configuration pages Enables you to configure your assets, sensors, and
devices.

@ Data Viewer page Enables you to explore and analyze the data collected
from your equipment.

@ Help button Links to help for the current page or tab.

@ Navigation menu Links to additional content not shown in the Navigation bar,
such as the Options dialog and System page.

Action menu When present, contains additional actions for the current
page or tab.

@ View menu When present, links to additional views for a device.

6.2. Setup Process Overview

Setup will generally follow the same order for all new InsightCM systems. Refer to the image below as you
set up to ensure that you are addressing all system dependencies.
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InsightCM
Server

Network Client Monitoring
Computers Devices

Add and
configure device

Device
added as an offline
device?

6.2.1. Reserved Characters

InsightCM has several configuration files that use the JavaScript Object Notation (JSON) format. Some
characters are reserved by the JSON format and cannot be used in InsightCM configuration files.

Below are some of the reserved characters in InsightCM configuration files that cannot be used.

\ Backslash

{ Left curly brace

} Right curly brace

Quotation mark
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Below is a list of characters that have been tested and are supported.

~ Tilde
Grave accent

Exclamation mark

@ At sign

# Number sign, Hash
$ Dollar sign

% Percent sign

A Circumflex accent

& Ampersand
* Asterisk

( Left parenthesis

) Right parenthesis

Low line

+ Plus sign

- Hyphen-minus

= Equal sign

[ Left square bracket

] Right square bracket

Semicolon

Colon

Apostrophe

, Comma

Full stop

< Less-than sign

> Greater-than sign
/ Slash (Solidus)

? Question mark

Degree sign

| Vertical bar

¢ Inverted Question Mark

Space

Greek acute accent

Latin Small Letter N with tilde
Latin Capital Letter N with tilde
Diaeresis (Umlaut)

5t

]

Inverted Exclamation Mark

6.2.2. Options and Features Requiring a Password Configuration

= Active Directory: If Active Directory is used to login to the server.
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= Mongo Configuration: Optional, it can use the default password.

= SMTP: Optional, if needed.

6.3. Glossary

acquisition

aging

asset
CompactRIO (cRIO)

connection information file

Cutsforth Monitoring System
data event

data set

Data Viewing page
device

device application

device configuration

device type

feature

Document #:
ICM3.11.1 RevA
2025-06-30

The act of a Cutsforth Monitoring System obtaining measurements
from sensors connected to device channels.

An automatic process that discards some data files after configurable
conditions are met. Aging is useful for conserving space on disk while
maintaining a desirable collection of data.

The equipment whose condition you monitor using the InsightCM
system.

The product family to which the controller and chassis in a Cutsforth
Monitoring System belongs.

A text file that contains connection-related properties, such as a
device IP address and credentials. If a device is offling, you can
transfer this file to the device via USB drive to bring the device online.

The CompactRIO-based system, configured via the InsightCM web
application, that acquires sensor data, monitors alarms, and more.

An event that leads to the collection of a data setor only a trend point.
Events include alarms, periodic acquisitions, and force triggers.

Data containing calculated frend points and the associated waveform.

The page on the InsightCM web application where you can load data
acquired from assets or to watch live data streams.

The monitoring hardware that receives and sends data from the
sensors on the asset to the web application.

Software that runs on Cutsforth Monitoring Devices and causes them
to perform operations such as calculating feature values from sensor
data. Each device type has a unique application.

The collection of properties that controls how a device operates,
including how and when it acquires data, from what sensors, and so
on. Defined on the Device Configuration page of the InsightCM web
application.

The arrangement of I/0O modules within the device chassis into a
specific pattern. Devices run unique application software according to
their device type.

A value calculated from a specific measurement that Cutsforth
Monitoring Devices acquire, often for the purpose of trending. For
example, RMS is a feature whose value InsightCM Server can
calculate from a standard periodic acquisition that occurs for a
multiple-second interval.
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feature set A customizable group of features and spectral bands that by default,
the InsightCM web application configures all sensors with a sensor
type and measurement type to calculate.

firmware The permanent software on the device that performs lower-level
operations than the device application.

high rate feature For vibration data, this is a feature that the device calculates once per
second on each one second data set that the device collects. When
you view data in the web application, the server calculates all high rate
features on the full file length of data. By default, high rate features are
time domain calculations such as RMS and True Peak.

low rate feature For vibration data, this is a feature that the device calculates based
on the file length you set for an operating state. By default, the device
calculates low rate features every 4 seconds. Since low rate features
are more processor intensive than high rate features, the device only
collects and processes data sets for low rate features when the
device has enough resources to calculate them. The server calculates
low rate features that the device cannot process. When you view data
in the web application, the server calculates all features on the full
file length of data. By default, low rate features are frequency domain
calculations such as 1x Magnitude and 1x Phase.

measurement A collection of data acquired from an individual sensor by a Cutsforth
Monitoring device.

periodic data Data from any acquisition that is not part of a stream, such as
acquisitions triggered by time interval or delta EU settings, an alarm, or
a force trigger.

Pl point A timestamped value stored in the Pl System software. InsightCM
Server uses the unique name of a Pl point to write values to the PI
System software.

Pl point mapping The mapping of a source tag in InsightCM Server to the name of a
Pl point. In other words, InsightCM Server interfaces with Pl System
points via point mappings.

settings file See connection information file.
spectral band A spectral band is the calculation of values within a window.
stream A group of measurements that a Transient, Periodic, and Event

Recorder device (CMS-9036) acquires when the equipment it is
monitoring enters certain operating states. A stream associates all
the acquisitions in one group so you can quickly visualize all the

data acquired during a stream-enabled operating state. You can view
streams live or playback recorded streams.

system image See device application.

tag A container that InsightCM Server uses to get and set the value of
a specific property. InsightCM Server uses these pre-defined tags to
maintain property values for both devices and internal services. Each
tag has a unique path, delimited by vertical bars, that identifies it. For
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example, the srv|prv]dev|DevNameconfigStatus tag contains
an OK and Error value.

tracepoint A flag that, when enabled, instructs InsightCM Server to log
messages about when particular events occur. For example, the
Storage.MajorOps tracepoint reports about events related to file 1/0,
such as when InsightCM Server receives a file from a device and

saves it.
trend Values of a feature plotted over time and displayed in the Trend viewer.
trend point Contains a single point value.
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7. Getting Started

1. Downloading InsightCM Software—Download the InsightCM software to your computer.
Installing InsightCM (page 22)—Install the InsightCM software.
Upgrading InsightCM (page 23)—Upgrade the InsightCM software.

H N

Set up Equipment Assets and Monitors (page 26)—Configure your asset tree with general and
equipment assets that accurately represent and organize the equipment you want to monitor.

5. Add Sensors to Equipment (page 27)—Assign sensor assets to each equipment asset to represent
the sensors collecting data from each equipment and to enable features and trend alarm rules.

6. Adda device to InsightCM.

Add a Continuous Device to Map a monitoring device that is powered and collects data via
InsightCM (page 45) wired connection to InsightCM.

Add a Wireless Device to Map a monitoring device that collects data wirelessly to
InsightCM (page 50) InsightCM.

Add a Thermal Imaging Device to Map a monitoring device that collects thermal data via ethernet-
InsightCM (page 58) wired connection to InsightCM.

7. Acquire data from devices.

Acquire Data with Continuous Devices (page 50) Begin acquiring data from your hardwired devices.

Acquire Data with Wireless Devices (page 57) Begin acquiring data from your wireless devices.

o Both data acquisition methods apply to thermal imaging devices.

7.1. Installing InsightCM

1. Right click the installer ISO and select Mount, or right click the installer ISO and click Open with and
click Windows Explorer.

2. RunInsightCM.exe.

3. Proceed through the installation dialog until you reach the Data page. If desired, specify custom
directories for the Database Folder and Data Folder. If upgrading from a previous version of
InsightCM, ensure that the installer properly detected the correct directories.

4. Proceed to the Summary page and select Install.

5. Aserver reboot might be required during installation. If prompted, select Restart and wait for
the server to reboot. Sign back into the same user account you were using previously and the
installation will proceed automatically.

6. After the installation is completed, select Launch InsightCM and confirm the web Ul successfully
launches.
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7.1.1. InsightCM Data Directories

InsightCM stores data in both a central database and as files on disk. By default, data is automatically
moved from the Database to the Data directory after 30 days. This archiving process results in better
performance by decreasing memory used by the InsightCM database and more uniform load time for
viewing data in the Data Viewer. The archived data can still be accessed in the Data Viewer. By default, the
following directories are used:

= Database Directory: C:\\ProgramData\Cutsforth\Insight CM\MongoDB
= Data Directory: C:\ProgramData\Cutsforth\Insight CM\Files

For optimal performance, Cutsforth recommends using separate SSDs for each data directory. Custom
directory locations can be specified when installing InsightCM.

7.1.2. Changing the Data Directory

1. Open Windows Command Prompt and run the following commands:
= cd "C:\Program Files\Cutsforth\Insight CM\"
* InsightCMConsole setdatadir -dir "<desired-data-directory-location>"

2. Restart the InsightCM service.

7.2. Upgrading InsightCM

The following upgrade instructions apply to servers running InsightCM 3.8.5 or higher. Please contact
Cutsforth Support to upgrade InsightCM versions prior to 3.8.5.

o InsightCM and SystemLink are incompatible and should not be installed on the same
server.

1. Backup your server by stopping the NI InsightCM 3.X and NI InsightCM MongoDB services and
copying "C:\ProgramData\Cutsforth\insight CM" to a safe location. If InsightCM is configured to use
non-default Database and Data File directories, backup those directories too.

2. Restart the services.
Run the installer. See the instructions under Installing InsightCM (page 22).

4.  Open aweb browser and navigate to http://localhost:82/icm or https://localhost:482/icm to confirm
that the upgrade was successful. Clear the cache on your web browser to prevent the browser from
being redirected to the previous version of InsightCM's web application. Refer to browser-specific
documentation to clear the cache.

Browse to the Assets page and confirm that the Asset tree was imported correctly.

6. Browse to the Device page and confirm that the device channels are mapped to the Asset tree
correctly.

7. Update Condition Monitoring devices applications and connect to the InsightCM Server:
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= Browse to the Software tab on the Devices page.

= Select a group of ten devices that you want to update and select Update Application. Check the
configuration status of the device to see when the update finishes and the devices' Deployment
Status will display Succeeded once complete.

= Repeat this process for the next group of ten devices until all devices are updated.

Custom units may not be imported and must be re-added manually after
upgrading.

7.3. Licensing InsightCM Server

Online Activations

If the serveris connected to the internet, you can use online activation to license the server.

1

2
3.
4

Open the web Ul and navigate to Navigation Menu > Licensing.
Enter your License ID, Activation Code, and an Installation Name you can use to identify the server.
Select the Enable online activation checkbox.

Select Activate.

Offline Activations

If the server is not connected to the internet, you must use offline activation to license the server.

.
2
3.
4

Document #:

Open the web Ul and navigate to Navigation Menu > Licensing.
Enter your License ID, Activation Code, and an Installation Name you can use to identify the server.
Select Activate.

To validate the license, the server will download a .zip file containing a license request. Transfer the
file to a computer with internet access, unzip it, and double-click it to open it in a web browser.

Select the Download button to download the response. See the figure below.
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LICENSE PORTAL

‘. License Portal Home » Manual Request (%) Lo In

Manual Request
Response

To copy the response (so that you may paste it into the application from which the request originated), either click the
Copy button below, or right-click in the box below and click "Select All." Then right-click in the box again and click "Copy."
Alternatively, you may click the "Download” button underneath the box to save the response to a file.

<Pxml version="1.0" encoding="utf-8"?>
<ActivateInstallationlicenseFile>
<EncryptedData Id="PrivateData"
Type="http://www.w3.org/2001/04/xmlenc#Element ™
xmlns="http://www.w3.0rg/2001/04/xmlencs” >
<CipherData>

<CipherValue>Dkkm61tCERrsT75h/Ek4y6TIodjgSv+BD/HGIpbTxQzDBHLIbQ7sgbOLvS2IbEBrBpu
aA/1nleWexymlnpv/DkonEzp8Uxyb1XYN7 sNBAbjOeZcoGGrcHONYSxpOWgLAX0Y 3qV72920BuGH1EC ~
VOQF 7on0zibU3bkTHSO1WYy161Te2 TeG24wkM6irLVy2dQioar7kjILONG+rt fFMOSEXprpith/dbCiBl

l-ﬁ_] Download % Copy

6. Transfer the file to the offline InsightCM server.
7. Select Upload and upload the license file.

Now that you have InsightCM installed on your server, you are now ready to begin setting up equipment
assets (page 26) in software.

Refreshing a License

If your InsightCM license has been updated to include more features, the license on the server must be
refreshed to apply those changes. Follow the offline or online activation instructions above but instead of
selecting Activate, select Refresh.

7.4. Configuring Your Asset Tree

Map your condition-monitoring system on InsightCM using location, equipment, and sensor assets.

1. Organize Your Assets (page 26)-Use location assets as an organizational element before adding
equipment and sensors.

2. Add Equipment Assets and Monitors (page 26)-Define the equipment assets and monitors in your
condition monitoring system on the Asset Configuration page.

3. Add Sensor Assets to Equipment (page 27)-Configure sensor assets for the equipment you are
monitoring.

4. (Optional) Add a Smart Motor Pump—-Configure equipment on the asset configuration page to
populate analysis and alerts in the Reliability dashboard based on your equipment data.

Validate Your Assets (page 27)-Verify that you have configured your assets correctly.
(Optional) Add Notes and Instructions (page 28)-Add notes and instructions about an asset if
multiple people are monitoring it.

Refer to Adding Cutsforth Monitoring Devices (page 43) to configure your monitoring device and/or
data source(s).
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7.4.1. Organizing Your Assets
Use location assets as an organizational element before adding equipment and sensors.

Before you begin, determine how you will organize your assets on the Asset Configuration page. For
example, you can group assets based on location, the technology you use to monitor your assets, or the
structure of a computerized maintenance management system (CMMS).

Add location assets at any level of your asset tree to keep your assets organized.

o Add location assets as child assets for additional levels of organization.

1. Click Configuration ( #) and select Assets.

2. Above the left-hand asset tree, click Add.

3. Expand General and select Location.

4. Give the location asset a descriptive name and specify how many location assets with this name to
add.

5. Click OK.

6. Repeat steps 1-5 as needed.

Now begin adding equipment assets and monitors (page 26).

7.4.2. Adding Equipment Assets and Monitors

Define the equipment assets in your condition monitoring system on the Asset Configuration page and
select and configure monitors (monitoring technology types) for each equipment asset..

Now that you have set up the organization of your asset tree using location assets, begin adding
equipment assets, assets that represent your equipment.

1. Click Configuration ( #) and select Assets,

2. Click Add, expand General, and select Equipment.

The equipment options in the dialog box correspond to toolkits you purchased with
your InsightCM system.

3. Give the equipment asset a descriptive name and specify the number of assets you want to add to
your asset tree and click OK.

4. Select monitors by checking boxes for one or more monitors for the equipment asset and click OK.
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In the right-side configuration panel, tabs will be added for each of the added

o monitors between the Properties tab and the Description tab. Clicking on any
monitor tab will reveal a row of tabs just below with settings and election attributes
(e.g.. Monitor, Sensors, Operating States).

5. To configure the newly added monitor for each added asset, select the monitor type within the
monitor tab, if the monitor tab is listed for the equipment asset. Changes to the monitor type
selection can impact other available setting and attribute tab option settings.

6. Repeat steps 2-5 to add additional equipment assets and monitors as needed.

Now that you have added your equipment and monitors, add sensor assets (page 27) and configure
data collection behavior (page 90) using each asset's configuration tabs.

7.4.3. Adding Sensor Assets

Configure sensor assets for the equipment you are monitoring. Added sensors will be associated with its
respective monitor.

Before you begin, add equipment assets and monitors (page 26) to the Asset Configuration page.

1. Click Configuration ( £ ') and select Assets.
2. Selectan equipment asset that needs a configured sensor(s).

Click Add, expand the category that will monitor the selected asset, and select a sensor. The sensor
is added to the asset tree.

By default, the added sensor is automatically added to the sensor list in the Sensor
tab of the respective monitor. If not, check that the equipment monitor type is
correct in the Monitor tab.

To manually add a sensor for a monitor, in the Sensors tab click Add, select the
sensor, and click Select.

4. Repeat steps 2 and 3 to define additional sensors until you have defined all sensors.

To configure wireless data collection settings, refer to Configuring Data Collection
for Wireless Equipment (page 103).

You have finished constructing your asset tree.

You are ready to map device channels to the sensors (page 46) you just added.
7.4.4. Validating Your Assets

Verify that you have configured your assets correctly.

1. Click the Configuration button ( - ) to navigate to the Asset Confirmation page.
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2. Select the asset(s) you want to validate.

3. Click Validate. InsightCM displays validation errors if there are any.

There are no A notification saying there are no errors appears. No further action required.

validation errors

There are The Validation Results dialog box appears with a list of validation errors. Take note of the
validation errors errors, click OK, fix the errors, and re-validate until there are no validation errors.

disappears. If still invalid, click Validate to identify why your

o InsightCM indicates a valid configuration when the red dot/outline
configuration is invalid.

7.4.5. Adding Notes and Instructions About an Asset

Add notes and instructions about an asset if multiple people are monitoring it.

1. Click Configuration ( £ ") and navigate to the Asset Configuration page.
Select an asset and click the Description tab in the right-hand asset configuration panel.

3. Click the Add button in the Comments toolbar to add a note or specific instruction about the
selected asset.

o You cannot edit comments once you add them.

4. Click the Add button in the Attachments toolbar to add an attachment relevant to the selected asset.

You can add standard notes and attachments to all existing and future assets of a specific type by
modifying the Comments and Attachments section in the Description configuration tab on the Asset
Definitions page.

o Attachments cannot exceed 10 megabytes.
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Properties Features Trend Alarms Spectral Alarms Description
Comments

+

Timestamp T User Text

Attachments

+

Timestamp Filename | Description

7.4.6. List of Features

An important part of the configuration for an asset is the lists of features that InsightCM calculates each
time the asset collects data. You can review and configure the list for a given asset on the Features tab of
the Asset Configuration page.

You cannot edit pre-configured features - only features that you add to an asset or an
asset type.

Feature Name Type Description

Active Power MCSA Total input active power, in watts or kilowatts, of the motor

Apparent Power MCSA Total input apparent power, in volt-amperes or kilovolt-
amperes, of the motor

Average Temperature Thermal Imaging The average temperature across an ROI

Crest Factor” Vibration True Pk

RMS

Delta Temperature Thermal Imaging The difference between the maximum temperatures of two
or more ROIs

Derating Factor MCSA The value to derate the motor output based on the

calculated motor voltage unbalance in compliance with
NEMA MG 1-2014

Derived Peak Vibration RMS +v2
Effective Service Factor MCSA Deratin q Factor

Load /Full Load
Efficiency MCSA Motor efficiency in percentage
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Feature Name Type Description
Envelope Total Power Vibration The total energy in the envelope spectrum.
Gap Vibration The DC value of the signal
Kurtosis Vibration
Ha
ot
Where ( Ha )is the fourth central moment and ( ¢ )is the
standard deviation.
Line Frequency MCSA Line frequency, in Hz, of the voltage bus
Load MCSA Output load, in kilowatts or horsepower, of the motor

Maximum Temperature

Thermal Imaging

The highest temperature across an ROI

MCSA RMS MCSA The RMS values of voltage or current waveforms in volts or
amperes

MCSA Speed MCSA Motor rotational speed in revolutions per minute (RPM)

Minimum Temperature Thermal Imaging The lowest temperature across an ROl

Peak-Peak” Vibration The greatest positive peak minus the least negative peak

Percent Full Load Amps MCSA Maximum RMS for motor startup currents each cycle
in percentage of the full load amperes on the motor
nameplate

Percent Load MCSA Motor load, in percentage of the full load on the motor
nameplate

Phasor: Magnitude MCSA Magnitude of the fundamental phasor, in volts or amperes,
of voltage or current waveforms

Phasor: Phase MCSA Phase of the fundamental phasor, in degrees, of voltage or
current waveforms

Power Factor MCSA Power factor of the motor

Reactive Power MCSA Total input reactive power, in volt-ampere reactives or
kilovolt-ampere reactives, of the motor

RMS" Vibration The root mean square of the signal

Rotor Bar Sideband MCSA Maximum magnitude, in decibels, of rotor bar sideband

harmonics. The decibel reference is the fundamental
component magnitude in the spectrum
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Feature Name Type Description

Smax Vibration The maximum value of shaft vibration in two dimensions.
This feature is available only for displacement sensors that
are part of a pair of orthogonal probes. InsightCM Server
also requires that each sensor in a pair have the following
properties configured on the Properties tab of the Asset
Configuration page. Otherwise, InsightCM Server logs an
error value (-1, by default).

= The Pair Sensor field must specify the name of the other
sensor.

= The Unit field for each sensor must match.

Smax is the result of the following equation, which
complies with the ISO 79194:1996(E) standard.

5 ax = [slitlllmax = [JLSA{HF - Lsﬁ{t}F]

where S1 is the instantaneous value of the shaft
displacement

max

SAlis the time-dependent measurement from one sensor
in the pair

SB1 is the time-dependent measurement from the other

sensor

Startup Peak Amps MCSA Maximum instantaneous peak value, in amperes, of startup
motor currents

Startup Time MCSA Time duration, in seconds, for the motor to remain in
startup state

Temperature Vibration N/A

Torque MCSA Output torque, in Newton meters or pound-foot, of the
motor

Torque Ripple MCSA Torqueaxy — Torque

% 100%
Torqueve
Total Power in Band EMSA The spectral energy in all frequency ranges

Use the Remove Spurs property for
this feature to ensure that feature

calculations do not include spikes.

True Peak Vibration The absolute value of the greatest positive peak or the
least negative peak, whichever is greater

Unbalance MCSA Unbalance, in percentage, of three-phase voltage buses or
three-phase motor currents in compliance with NEMA MG
1-2014

"The data is AC-coupled for the purpose of calculating this feature. If a sensor is configured as DC-coupled, the
InsightCM Server AC couples its data for the purpose of calculating these features.
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7.4.6.1. Spectral Bands

Name Toolkit Additional Explanation
Required
1x Magnitude Vibration The sum of the spectrum bins from 0.8x to 1.2x the speed.
2x Magnitude Vibration The sum of the spectrum bins from 1.8x to 2.2x the speed.
1x Phase Vibration The phase of the 1x component of the signal.
2x Phase Vibration The phase of the 2x component of the signal.
Asynchronous Vibration The spectral energy that is above 1x running speed and is not
synchronous.
EMSA Spectral Band EMSA The spectral energy between start and stop frequencies.

Use the Remove Spurs property for this feature to
ensure that feature calculations do not include spikes.

Envelope Spectral Vibration The sum of energy from the envelope spectrum.

Band

High Frequency Vibration The sum of the spectrum bins from 1000 Hz to the maximum frequency
value.

Non-synchronous Vibration The spectral energy that is not at integer multiples of running speed but is
above 1x running speed.

Order Domain Vibration The sum of energy from the order spectrum.

Spectral Band

Subsynchronous Vibration The sum of the spectrum bins from 0.2x to 0.8x the speed.

Synchronous Vibration The spectral energy at integer multiples of running speed.

Residual Vibration A measure of the energy left in a signal after you remove the energy

from all other spectral bands calculated for the sensor. Residual spectral
bands apply to a specific domain only, so the InsightCM web application
requires you to choose the domain. For example, consider that you assign
the acceleration Residual band to a sensor. The value of the band is

the energy left after removing the energy from other spectral bands in

the acceleration domain only. Therefore, if single integration is enabled,
the acceleration Residual band factors in energy removed from a 1x
Magnitude spectral band whose units are g rms, but not froma 1x
Magnitude spectral band in the velocity domain whose units are ips rms.

You can add one Residual spectral band for each
domain to a sensor.
Any phase spectral bands are not part of calculating
the Residual spectral band.

If a sensor contains spectral bands that overlap, the
algorithm removes the energy from the overlapping
region only once. Therefore, the value of residual
spectral bands is always greater than or equal to
zero.

The residual calculation accounts for the
subsynchronous spectral band.

User-Defined Vibration The sum of energy from a spectrum where the bands are defined by the
user.
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7.4.6.2. Examples of Residual Spectral Band Values

Energy in Signal Other Spectral Bands Residual Value

At 1x, 2x, and 3x the running speed Tx Magnitude All the energy from the 2x and 3x

components of the signal.

At 1x, 2%, and 3x the running speed = 1x Magnitude The energy from the 3x
component of the signal.

= 2x Magnitude

At 1x, 2%, and 3x the running speed = 1x Magnitude Zero
= 2x Magnitude
= A custom spectral band for 3x
magnitude
At 1x, 2x, and 3x the running speed A custom spectral band from 0.8 to Zero

3.2 orders

At 1x, 2x, and 3x the running speed
of 60 Hz

A custom spectral band from 50 Hz
to 70 Hz

All the energy from the 2x and 3x
components of the signal

7.4.7. List of Asset Properties

On the Asset Configuration page, the Properties tab in an asset's configuration panel contains a subset
of these properties. The properties available for a particular asset vary based on the property definition of

that asset type.

Property Required

Toolkit

Description

Additional Information

1x Magnitude None The 1x magnitude value when the On the Data Viewer page, Bode and
Reference shaft is at slow-roll speed Polar viewers subtract this slow-roll
value from channel data so that the
plots start at 0.
1x Phase None The 1x phase value when the shaft is On the Data Viewer page, Bode and
Reference at slow-roll speed Polar viewers subtract this slow-roll
value from channel data so that the
plots start at 0.
B
Bandwidth (Hz) EMSA The amount of data to acquire around N/A
a center frequency
Bearing None The units in which the Horizontal N/A
Clearance Unit Bearing Clearance and Vertical
Bearing Clearance properties
express the maximum possible orbit
of the shaft centerpoint inside the
bearing
Bearing Start None The location of the shaft within N/A
Position its bearing housing when at rest,
whether at the top, middle, or bottom
of the housing
C
Calibration MCSA The gain factor applied to the voltage N/A
Factor or current sensor data
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Property Required Description Additional Information
Toolkit
Coefficient K CMS Calculated using the Winter-Kennedy
Method Relative Flow Measurement
Coupling None AC or DC N/A
Current Phase MCSA The current transformer asset node When only two of the three current
A corresponding to phase A of the phase channels are configured in
motor current channels the Group Properties section of the
Properties tab, InsightCM calculates
the data of the third current phase
channel.
Current Phase MCSA The current transformer asset node When only two of the three current
B corresponding to phase B of the phase channels are configured in
motor current channels the Group Properties section of the
Properties tab, InsightCM calculates
the data of the third current phase
channel.
Current Phase MCSA The current transformer asset node When only two of the three current
C corresponding to phase C of the phase channels are configured in
motor current channels the Group Properties section of the
Properties tab, InsightCM calculates
the data of the third current phase
channel.
Custom None The A constant of the Callendar-Van Enter a value for this property when
Coefficients A Dusen equation you specify Custom for the RTD Type
property.
Custom None The B constant of the Callendar-Van Enter a value for this property when
Coefficients B Dusen equation you specify Custom for the RTD Type
property.
Custom None The C constant of the Callendar-Van Enter a value for this property when
Coefficients C Dusen equation you specify Custom for the RTD Type
property.
D
Detection EMSA Determines how amplitude is N/A
Mode detected:
= Average
= Peak
= Quasi-Peak
Detection Time EMSA The time, in seconds, that a sensor N/A
(seconds) takes to acquire amplitude at a point
Digital None Specifies what voltage values For example, if you set the digital
Threshold indicate that the channel is on or off threshold to 2, values greater than or
equal to 2 indicate that the channel is
on while values below 2 indicate that
the channelis off. The range of valid
threshold values is 0-60. This property
is only available on the 9219 module.
Double None The frequency, in Hz, at which to set N/A
Integration the highpass filter when performing
Cutoff double integration on asset data
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Property Required Description Additional Information
Toolkit
E
Efficiency @ MCSA The motor efficiency as a percentage N/A
75% Load (%) when the load is three quarters of the
full load
Efficiency @ MCSA The motor efficiency as a percentage N/A
50% Load (%) when the load is half of the full load.
Efficiency @ MCSA The motor efficiency as a percentage N/A
25% Load (%) when the load is a quarter of the full
load
Estimate Stator MCSA Whether the motor stator resistance InsightCM Server estimates the
Resistance value is manually specified by the motor stator resistance based on
user or estimated by the InsightCM the motor nameplate parameters.
Server If the motor nameplate information
is not appropriately specified, the
accuracy of the estimation may be
affected, which then affects the
accuracy of the motor Torque Ripple
and Torque Waveform calculation.
The following motor nameplate
parameters will affect the stator
resistance estimation: Synchronous
Speed (RPM), Full Load Speed (RPM),
Load, Full Load Efficiency (%), and Full
Load Amps (amp).
F
Full Load Amps MCSA Specify the motor full load current N/A
(@amp) in amperes according to the motor
nameplate
Full Load MCSA The motor full load efficiency as a N/A
Efficiency (%) percentage according to the motor
nameplate
Full Load Speed MCSA The motor full load speed in rotations N/A
(RPM) per minute according to the motor
nameplate
Full Scale EMSA The largest voltage range you expect N/A
Voltage the HFCT to detect
G
Gap Voltage None The DC value, in volts, of the The Data Viewer page subtracts
Reference displacement probe when the shaft this value from the DC voltages
is atrest measured during normal operation
and combines the results to generate
accurate plots in the Shaft Centerline
viewer.
H
Horizontal None The horizontal diameter of The Data Viewer page uses this
Bearing the maximum bearing clearance, value to display the maximum bearing
Clearance expressed in the units the Bearing clearance line in orbit and Shaft

Clearance Unit property specifies

Centerline viewers.
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Property Required Description Additional Information
Toolkit
Input Range None The input range of the module to You can find this value in the
which the channel belongs in the module [Operating Instructions and
same pre-scaled units in which the Specifications] document.
module acquires data
IEPE None Specifies to power IEPE sensors N/A
via the physical connection to the
channel. When true, the device also
reports open and short conditions for
the channel. Set this property to true
for IEPE sensors
L
Load MCSA The motor full load in the unit N/A
configured by the Load Unit property
according to the motor nameplate
Load Unit MCSA The unit of the motor load from N/A
horsepower or kilowatts
Low Frequency None The value at or below which N/A
Cutoff InsightCM attenuates frequencies.
Attenuation occurs immediately after
acquisition and prior to any feature
calculations. If you specify a low
frequency cutoff value of zero,
InsightCM does not attenuate any
signal frequencies.
M
Manufacturer MCSA The motor manufacturer according to N/A
the motor nameplate
Model MCSA The motor model according to the N/A
motor nameplate
N
Nominal MCSA The nominal frequency of the line N/A
Frequency power to the motor
Nominal Line MCSA The nominal line voltage, in volts, of N/A
Voltage (volt) the voltage bus
Nominal Speed None The theoretical speed if there is no N/A
load on the motor
Number of EMSA The number of sections an EMSA N/A
Intervals frequency range is divided into
O
Offset None The y-intercept, [b], of the linear scale To disable scaling, enter an offset of O
([yl = [mx] + [b]) applied to pre-scaled and a slope of 1.
data
P
Pair Sensor None The name of another asset to pair N/A
with this one for the purpose of
generating an orbit plot you can view
on the Data Viewer page
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Property Required Description Additional Information
Toolkit
Pl Point Name None The name of a Pl point whose Refer to the Point Mappings Tab
data you want to display on the on Historian Page (page 164) topic
Data Viewer page. For example, for more information about Pl point
Unit 1 _Motor_Accelerometer names.
Vertical Crest Factor
Power Factor MCSA The motor power factor at full load N/A
according to the motor nameplate
Probe Angle None The angle in degrees at which the The following image shows the driver-
sensor is positioned around the shaft to-driven perspective of a shaft with
two sensors attached. For the sensor
that is angled to the right on the shaft,
the probe angle is between 0 and 180
degrees. For the sensor that is angled
to the left, the probe angle is between
0 and -180 degrees.
0
a0 90
Probe angles are
independent of
the shaft rotation
direction.
Pulses Per None The number of pulses the N/A
Revolution tachometer generates per revolution
of the shaft. Refer to the sensor
documentation to determine this
value.
R
RO None The sensor resistance in ohms at O The Callendar-Van Dusen equation
degrees Celsius requires this value. Refer to the
sensor documentation to determine
this value.
Rated Volts MCSA Specify the motor rated voltage N/A
(volt) in volts according to the motor
nameplate
Resistance None The number of wires to use for N/A
Configuration resistive measurements
Reverse Polarity None Enable this control if the polarity of N/A
the sensor is reversely wired
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Property Required Description Additional Information
Toolkit
Rotation None The direction the shaft turns, whether N/A
Direction counterclockwise or clockwise

relative to the 12:00 position when
you look down the shaft starting from
the motor, from the driver-to-driven

perspective
RTD None The number of wires to use for N/A
Configuration resistive measurements and the

typical sensor resistance:

= RTD4W:Pt1000—Uses the 4-wire
resistance method and a platinum
RTD with a typical resistance of
1,000 kQ 0° C.

RTD4W:Pt100—Uses the 4-wire
resistance method and a platinum
RTD with a typical resistance of
100kQ0° C.

RTD3W:Pt1000—Uses the 3-wire
resistance method and a platinum
RTD with a typical resistance of
1,000 kQ 0° C.

RTD3W:Pt100—Uses the 3-wire
resistance method and a platinum
RTD with a typical resistance of

100kQ0° C.
RTD Type None The type of RTD connected to the If you select custom, you must use the
asset three Custom Coefficient properties
to supply the coefficients for the
Callendar-Van Dusen equation.
S
Sensitivity None The sensitivity value, in millivolts N/A
(mV/EU) per engineering unit, taken from the
documentation for the connected
sensor
Sensor Ratio MCSA The ratio of the sensor converting N/A
the raw signal to a lower level signal
acquired by C Series voltage or
current modules
Serial Number MCSA The motor serial number according N/A
to the motor nameplate
Service Factor MCSA The service factor of the motor N/A
according to the motor nameplate
Single None The frequency, in Hz, at which to set N/A
Integration the highpass filter when performing
Cutoff single integration on asset data
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Property Required Description Additional Information
Toolkit
Slope None The slope, [m], of the linear scale ([y] For example, a module might acquire
=[mx] + [b] ) applied to pre-scaled data in volts, but that module might
data be used with a temperature sensor
that outputs 100 mV for every 1 °C.
You can set this property to 0.01 to
implement the conversion from V to
°C. To disable scaling, enter an offset
of 0 and a slope of 1.
Speed Ratio None The ratio of the speed reference For example, enter a value of 4:10, if
value to the asset speed the sensor that the asset maps to is
located on a part of the equipment
that is spinning 2.5 times faster than
the speed reference.
Speed None An asset referenced by other assets N/A
Reference for the purpose of calculating speed
values to correlate with measurement
data
Start Frequency EMSA The frequency at which the HFCT N/A
(H2) begins a frequency sweep
Stator None The Stator Resistance in ohms This option is hidden if you enables
Resistance the Estimate Stator Resistance
(ohm) button. The accuracy of the specified
Stator Resistance affects the
accuracy of the motor Torque Ripple
and Torque Waveform calculation.
Stop Frequency EMSA The frequency at which the HFCT N/A
(Hz) ends a frequency sweep
Synchronous MCSA The synchronous speed in rotations N/A
Speed (RPM) per minute of the motor
T
Tachometer None An offset from the Tachometer This value is always positive. For
Hysteresis (volt) Threshold that the tachometer signal instance, if the Tachometer Threshold
must cross before the device (volt) is -5 V, the Tachometer
monitoring the tachometer can Hysteresis (volt) is 1V, and the
detect a new pulse Tachometer Slope is "falling", this
signal must cross -4 V before the
device will detect another pulse.
Tachometer None The direction of slopes in the signal, N/A
Slope whether rising or falling, that causes
the device to measure a pulse when
the slopes cross the Tachometer
Threshold
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Property

Tachometer
Threshold (volt)

Required
Toolkit

None

Description

The unscaled value at which slopes
in the signal of the specified direction
cause the device to measure a pulse

InsightCM 3.11.1
USER MANUAL

Additional Information

As an example, if the Sensitivity
property for the tachometer channel
is 200 mV/EU and a pulse should

be detected at 80 mils, this property
should be setto 16 V. Tachometer
Threshold (volt) = Sensitivity *
Tachometer Threshold (scaled).

For more
information about
tachometer-
related properties,
refer to

the lllustration

of Tachometer
Properties at the
bottom of this
topic.

Thermocouple
Type

None

The type of thermocouple connected
to the asset

Thermocouple types, named with
letters, differ in composition and
measurement range.
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Property

Terminal
Configuration

Required
Toolkit

None

Description

= RSE—Specifies that the analog
input assets are referenced single-
ended (RSE). A referenced single-
ended (RSE) measurement system
measures voltage with respect
to the ground, which is directly
connected to the measurement
system ground.

NRSE—Specifies that the analog
input assets are non-referenced
single-ended (NRSE). In an

NRSE measurements system, all
measurements are still made with
respect to a single-node analog
input, AISENSE, but the potential at
this node can vary with respect to
the measurement system ground.

Differential—Specifies that the
analog input assets are differential.
A differential measurement system
has neither of its inputs tied to

a fixed reference, such as earth

or building ground. A differential
measurement system is similar to
a floating signal source in that

the measurement is made with
respect to a floating ground that

is different from the measurement
system ground. Handheld, battery-
powered instruments and DAQ
devices with instrumentation
amplifiers are examples of
differential measurement systems.
This mode measures potential
between two inputs and therefore
reduces asset count by 2.

USER MANUAL

Additional Information

N/A

Unit

None

The units in which to measure sensor
data on the asset it monitors. For
MCSA devices, the units of voltage
and current channels match the units
of the Voltage and Current asset
types on the Units tab of the System
page. The default unit for voltage
channels is volts, and the default unit
for current channels is amperes.

The units in which to measure sensor
data on the asset it monitors. NA

\Y

Vertical Bearing
Clearance

None

The vertical diameter of the
maximum bearing clearance,
expressed in the units the Bearing
Clearance Unit property specifies

The Data Viewer page uses this

value to display the maximum bearing
clearance line in orbit and Shaft
Centerline viewers.
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Property Required Description Additional Information
Toolkit
Voltage Bus None The asset name of the voltage bus to N/A
which the motor is connected
Voltage Phase MCSA The potential transformer asset When you only configure two of the
A corresponding to phase A of the three phase sensors on the Properties
voltage bus voltage sensors tab, InsightCM calculates the data of
the third phase sensor.
Voltage Phase MCSA The potential transformer asset N/A
B corresponding to phase B of the
voltage bus voltage sensors
\oltage Phase MCSA The potential transformer asset N/A
C corresponding to phase C of the
voltage bus voltage sensors
W
Wiring MCSA The connection type of the voltage N/A
Configuration bus sensors

7.4.7.1. lllustration of Tachometer Properties

In the following illustration, the Tachometer Slope property is set as Falling.

Prouximity
Probe
Kienway Shot
Hystarasls
Thireshald

Tachamater Slapa = Falling

O

In this example, the signal demonstrates the following behavior.

= The device measures a pulse when the raw voltage signal first falls below the value of the Tachometer
Threshold property, as shown in the graph.

= The signal immediately rises above and then falls below the threshold when the keyway slot passes the
proximity probe. However, the device does not measure a second pulse because the signal does not
also rise above the hysteresis level.

The hysteresis is useful in this situation because it prevents the noisy signal from
triggering a second pulse when it falls below the Tachometer Threshold a second
time.

= The signal rises above both the threshold and hysteresis levels, which means the device is able to
measure a pulse again when the signal falls below the threshold a third time, near the end of the graph.
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7.5.

Adding Cutsforth Monitoring Devices

Set up monitoring devices in InsightCM to which the hardware maps.

Before you begin, work with your IT department to retrieve the correct IP addresses for each monitoring
device.

Select the type of monitoring devices you are adding to InsightCM and complete the corresponding
tasks for each device type below.

Adding Continuous Add a Cutsforth monitoring device that is wired to sensors, the network, and a
Devices (page 45) power source on InsightCM.
Adding Wireless Add a device that communicates wirelessly with endpoints on InsightCM.

Devices (page 50)

Adding Thermal Imaging Add a thermal imaging device on InsightCM.
Devices (page 57)

Now that you have added your Cutsforth monitoring devices, begin customizing your condition
monitoring system (page 93).

7.5.1. Continuous Devices

7.5.1

7.5.1

Familiarize yourself with the following concepts to help you work with Cutsforth monitoring devices that
are wired to sensors, the network, and a power source.

For more information regarding module types and compatibility, refer to Continuous Monitoring Device
Hardware for InsightCM (page 45).

.1. Device Models

Cutsforth Monitoring Devices are available in the following models;

= High-Performance Condition Monitoring Systems—Supports periodic and continuous file collection
when equipment enters an operating state of interest, such as a run-up or coast-down. The CMS-9036
is an example of a Transient, Periodic, and Event Recorder system.

= General Purpose Monitoring Systems—Supports periodic file collection when triggered by time or
data triggers. The CMS-9065 and CMS-9068 are examples of Periodic and Event Recorder systems.

.2. Device Types

When you add a new device, InsightCM requires you to specify the device type. The device type
describes the CompactRIO controller and the software application on the device. For example, the
CMS-9068 is based on the cRIO-9068 and runs an application designed for monitoring systems.

Each device model has one or more device types that it supports. For example, High Performance
Condition Monitoring Systems include device types based on the cRIO-9047 and the cRIO-9036;
General Purpose Monitoring Systems include device types based on the cRIO-9068, cRIO-9065,

cRIO-9055, and cRIO-9058. Each device runs a different application.
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The device type also determines which arrangements of I/O modules within the device chassis are
supported.

7.5.1.3. Device Types for High-Performance Condition Monitoring Systems

The application for High-Performance Condition Monitoring device types supports up to eight dynamic
C Series I/0 modules, such as the Cutsforth 9232. You must fill module slots in ascending order starting
with slot 1. You must fill slots 1 and 2. You cannot skip any slots, but you do not have to use every slot.

These device types come in two formats: one that powers IEPE sensors via the physical connection to
the channel and one that does not.

7.5.1.4. Device Types for General Purpose Monitoring Systems

InsightCM supports a set of arrangements for static and/or dynamic C Series I/0 modules in the
chassis. The following table lists the module types you can install under each arrangement, but does
not represent all possible valid configurations.

o You do not need to fill every slot, but you must fill slots in ascending order starting at slot

1.

CMS-9068
Chassis Slot Supported Module Arrangements in CMS-9068
Number
1 Static Dynamic Dynamic Dynamic
2 Static Dynamic Dynamic Dynamic
3 Static Static Dynamic Dynamic
4 Static Static Dynamic Dynamic
5 Static Static Dynamic Dynamic
6 Static Static Dynamic Dynamic
7 Static Static Static Dynamic
8 Static Static Static Dynamic
1 Static Dynamic Dynamic
2 Static Dynamic Dynamic
3 Static Static Dynamic
4 Static Static Dynamic

7.5.1.5. Guidelines for Chassis with Dynamic Modules

If the arrangement you choose contains any dynamic modules, such as the Cutsforth 9232, install
dynamic input modules in adjacent slots beginning with slot 1. You must fill slot 1, but you do not need to
fill every slot in the chassis.
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7.5.1.6. Guidelines for Chassis with Only Static Modules

For a list of I/O modules that Cutsforth Monitoring Devices support, contact Cutsforth customer support.

7.5.1.7. Types of Software for Devices

Firmware

Cutsforth Monitoring Devices run preinstalled firmware, the permanent software on the device that performs lower-
level operations than the device application. You do not directly interact with firmware unless you receive an updated
or patched version. Use the Package Management page to upload the firmware so you can apply it to devices. Then,
use the Software tab on the Device Configuration page to update the firmware on a device to the new version.

Applications for Devices

The Software tab on the Device Configuration page displays an overview of the application types and versions running
on each device. Update device applications to the latest version and reset the firmware to the preinstalled version
from the Software tab. You do not directly interact with the application unless you receive an updated or patched
version. Use the Package Management page to upload the application so you can apply it to devices. The Package
Management page refers to applications as system images.

Device Configurations

A gevice configurationis a collection of properties that controls how a device operates, including how and when it
acquires data and collects files. Define the configuration for a device on its Device Configuration page in InsightCM.

Click Update Configuration at the top of the Device Configuration page each time you make a change to a device's
configuration to send the updated configuration to the device. The device might require several minutes after the last
time you click Save to download the configuration and come online again.

7.5.1.8. Adding a Continuous Device

Add and configure a Cutsforth monitoring device that is wired to sensors, the network, and a power
source.

Before you begin, configure assets and monitors (page 26).
1. Click the Configuration pull-down ( #") and select Devices.

2. Click Add.

3. Inthe New Device dialog box, connect to an online or offline device.
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Option Description

Connect to 1. Select Connect to an online device and enter the IP address in the textbox.

an online

device If you do not know the device IP address, click Browse to see a list of
o devices on the same subnet as the server machine.

2. To check for common problems that prevent a device from connecting to InsightCM
and coming onling, click the Connect button. The web application opens the Test
Connection dialog box and checks for problems. If the check fails, this dialog box provides
troubleshooting information.

You can continue to add an online device without resolving failed
checks if the device passes the IP address check.

3. Click OK.
4. Select your device type from the Device Type pull-down menu.
5. Configure the slots to match the module configuration on your physical device.

If you need to update the module configuration in InsightCM at a later
time, navigate to the Hardware tab of the specific device's configuration

page.
6. Click Next.
7. Enter the following names for the device.

= Device Name—The name you want to appear throughout the web application. Assign an
easily identifiable name, such as one that indicates the physical device location or the
equipment it monitors.

= Hardware Name—The hostname of the device, which is in the format of N1 -
cRI10-Mode INumber-SerialNumber by default. If the device is online, InsightCM
automatically populates this name. Otherwise, find the two values printed on a label on
the back of the device.

Connectto 1. Select Create an offline device option and click Next.
Zgﬁggne 2. Select your device type from the Device Type pull-down menu.

3. Configure the slots to match the module configuration on your physical device.

If you need to update the module configuration in the web application
at a later time, navigate to the Hardware tab of the specific device's
configuration page.

4. Click Next.
5. Enter a descriptive name in the Device Name text field.

6. Once you have added an offline device, transfer a connection file to your offline
device (page 48).

4. Click Finish to add your device to the server.

Now that you have added continuous monitoring devices, map device channels (page 46).

7.5.1.9. Mapping Channels

Map sensors to device channels.
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Ensure that you have added at least one equipment asset (page 26) with sensor assets on the Asset
Configuration page.

To map a Sensor to a Device and select a Hardware Channel:

N o ok NN =

7.5.1

Click the Configuration pull down ( & ") and select Assets.

Expand the asset tree and select the equipment asset you desire to map channels.
Click on the name of the monitoring technology.

Click the Sensors tab.

Click the pencilicon in the Device section.

Click on the Device in the pop-up window list and click OK.

Click in the Hardware Channel cell for each sensor and select in the pull-down menu the hardware
channel.

Any changes you make on the Asset Configuration page will not be applied until you
click Update Configuration.

.10. Verifying Device Connectivity

After you send the connection information to the device, it automatically connects to the server.

Complete the following steps to verify that the device connects successfully.

Document #:

In the web application, click the Configuration pull-down ( & ) and select Devices.

@ - M Device configuration InsightCM Q v
Devices Software
+ Add & Edit @ Remove filter by device h 4 Auto Refresh: 30sec ~ | &
Name Device Type IP Address Serial Num...  Connection...  Config Status
CMS-9065 1899127 9232 CMS-9065 1023370 01899127 E
CMS-9036 No IEPE 1CO5BF3 9232 92...  CMS-9036 (IEPE Disabled) 10.2.33.8 01C95BF3 KE o«
MMS-9055 1E3AC3S 9242 9239 MMS-9055 1023345  01E3AC39 EEI update Configuration
CMS-9065 1899118 9230 CMS-9065 1023372 01899118 Disabled

On the Devices tab, verify that the Connection Status column for the device says Online, which
means the device finished updated and connected successfully to the server.

The device might require several minutes to download configuration files and
reboot before it connects to the server and comes online. During this time, the
device status might change multiple times. Click the Refresh button to see the
latest status.
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7.5.1.11. Transferring a Connection File to an Offline Device

Connect your offline device to the InsightCM Server by transferring a connection file to the device.

If you added the device configuration without entering the IP address, the device cannot yet connect
to InsightCM because it does not have the information needed to connect to the server. Complete the
following steps to transfer credentials to the device.

Click the Configuration pull-down ( - ) and select Devices.

Find the device connection file you exported when you added a device to the InsightCM Server.
If you did not export a connection file, return to the Device Configuration page.

1.  Select the device.

=)

2. Select the Action menu ( and hover over Connection.
3. Select Export Connection File.

Copy the file to a USB drive folder named upload in the following directory:
<RootLevel>:\InsightCM.

o If the upload folder does not exist, create it.

The filename must be in the format of DeviceHostname-SerialNumber,json or the
device will not read it.

Insert the USB into the USB port on the controller front panel and note that the USER1 LED light will
switch from blinking to solid when the device is reading the connection file.

When the USER1 LED returns to blinking steadily, remove the USB drive.

From the Device Configuration page, select the device to which you manually transferred a

connection file, click the Action menu ( — ) and select Reboot.

7.5.1.12. Acquiring Data

When the device is online with all relevant channels mapped to sensors, test your device's ability to
acquire data. Automatic acquisitions occur periodically, but you can force an acquisition at any time using
Force Trigger.

Complete the following steps to test whether or not the channels in your device can acquire data.

Document #:

Click the Configuration pull-down ( - ) and select Devices.
On the Devices tab, select the device you added.

In the Action ( — ) menu, select Force Trigger to perform an acquisition from all channels.

(11
(Optional) Click the Layout (®®) button on the viewer toolbar, hover over Chart Type, and select
Thermal Image to change the viewer to one that can view thermal imaging data.
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5. Wait several seconds for the acquisition to be complete before clicking the Data Viewer ( s ) button
to view the Data Viewer page. Click on a feature level asset for the equipment and confirm that data
has been acquired.

Before data is available, devices must finish performing the acquisition and the
o InsightCM server must receive and store the data. The duration of a force-triggered

acquisition is based on the file length of the equipment's Default operating

state (page 76).

For a complete list of ways you can configure a device to perform acquisitions, refer to Methods for
Initiating Device Acquisitions (page 50).

6. Repeat the force acquisition several times to acquire multiple data sets.

7.5.2. Wireless Gateways and Devices

Wireless gateways, wireless monitoring devices, and wireless vibration sensors eliminate the need for
extensive wiring by using wireless technology to transmit equipment data to the InsightCM server for
analysis while maintaining high levels of data acquisition.

7.5.2.1. Wireless Monitoring Gateways

A MON-10496is a wireless gateway device that sends data to the server and receives data
from endpoints. £Engpoints are wireless devices and wireless sensors that communicate data to the
MON-10496.

Environmental factors—such as physical obstruction and severe weather—can affect

o the performance of the wireless gateway and wireless monitoring device. Configurable
factors—such as frequency and size of data collections—can also affect the
performance of the wireless monitoring gateway, the wireless device, and the wireless
sSensor.

The endpoint is configured from the MON-10496's Device Configuration page and is added with an
association to an equipment asset.

7.5.2.2. Wireless Vibration Measurement Devices

A MON-10467is a wireless vibration measurement device that sends data wirelessly to the MON-10496
and can be configured with the following sensors:

= Accelerometer

= Displacement

Tachometer

= Velocity

Static voltage
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7.5.2.3. Wireless Vibration Sensors

A MON-7041717is a wireless vibration sensor that sends data wirelessly to the MON-10496 and has the
following built-in sensors:

= Three Accelerometers

= Wireless Temperature

7.5.2.4. Adding Wireless Monitoring Devices and Endpoints

Add a wireless monitoring device and an endpoint to the InsightCM server.

1. Click the Configuration pull-down ( #") and select Devices.
2. Click the Add button.
3. Inthe New Device dialog box, you can add a device in two ways.

Option Description

Connect to 1. If you do not know the IP address of your device but it is online, select Connect to an online
an online device and click Browse to see a list of devices on the same subnet as the server machine.
device

2. Select a device from the Subnet Devices dialog box and click OK.

3. Click Connect and the web application will automatically perform tests to verify the device
IP address, firmware, connection, and hardware.

= In the Testing Connection dialog box, you can see the results of
testing and information about how to resolve any issues.

= You can continue to add an online device without resolving failed
checks if the device passes the IP address check.

Click OK.

Select the wireless device type from the Device Type pull-down.

Configure the slots as needed to match the module configuration on your physical device.
Click Next.

Give the device a descriptive name in the Device Name text field.

S R AL

Connect to If your device is offline, ensure that the Connect to an offline device option is selected and
an offline click Next.
device

2. Select your device type from the Device Type pull-down.
3. Configure the slots as needed to match the module configuration on your physical device.
o If you need to update the module configuration in the web application

at a later time, navigate to the Hardware tab of the specific device's
configuration page.

4.  Click Next.
Give the device a descriptive name in the Device Name text field.

6. Once you have added an offline device, transfer a connection file to your offline
device (page 48).

4. Click OK and you will be automatically redirected to the Endpoints tab of the wireless monitoring
device's configuration page.
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5. Click Add pull-down menu and select Offline to add the endpoint as an offline device.

If the endpoint is powered and within range of the wireless monitoring device, click
Add to have your wireless monitoring device discover the endpoint.

6. Enter the serial number of your endpoint, designate the endpoint type as Wireless Sensor for a
MON-10411 or Wireless Device for a MON-10467, and click OK.

7. Inthe Select Wireless Equipment dialog box, select a wireless equipment asset to associate the
wireless device endpoint with and click OK to add your endpoint.

To change the asset endpoint associates with, be sure to remove the endpoint from
its current asset before adding it to the new one.

8. Use the pull-down under Channel in the Endpoint configuration panel to assign which channels from
the wireless gateway correspond to each sensor associated with the equipment.

If you have added more than one endpoint, you may need to resolve the collection

o time schedule by clicking Schedule and then Resolve All. If you do not resolve the
collection time, wireless endpoints will spend additional time communicating with
the gateway, which decreases endpoint battery life.

Now you have successfully added a wireless monitoring device and an endpoint to your InsightCM
server. Wireless devices default to having one collection time. You can reconfigure collection time in the
Collection tab of the wireless equipment's configuration panel.

7.5.2.5. Configuring Phantom Sensors

InsightCM supports the following Erbessd Phantom wireless sensors: V10E, V11E, ATX15, ATX16, T20,
T25,T70, and S40.

Commission Phantom Gateway

Before adding Phantom wireless sensor assets, commission the Phantom Gateway so it connects to
InsightCM.

1. Plug an ethernet-wired connection into the Phantom Gateway.
Power on the Gateway.
Note the displayed IP address on the Gateway screen.

Open a web browser window and access the Gateway IP address.

o K~ W

Update the firmware of the Phantom Gateway:

= Contact Cutsforth support to download the Phantom Gateway firmware officially supported by
InsightCM.

= Manually apply the firmware update on the System tools tab.
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System firmware update
CHECK ONLINE UPDATE

@J Firmware file

6. Pair Phantom Sensors to the Gateway using the Live State menu. Click the Pair button before
configuring the sensor in InsightCM.

L L Gateway Serial Number: 589245297
General o - o

Collection

Phantom Sync

€1 Analytic

Modbus

MaTT search

System tools

offine storage: Sertal uter - = A =
Security
About
«l B2 189256566 «I EA 189275135 «al B 189300550
serial sion: 1 0 Serial: 189275135 version: 10 ° Serial: 189300550 version: 182 @
Type: Thermagraphic Camera Tyge: Triid Vibewiion (Highrangs
Last seen: 0 seconds Last seen 0 seconds Last seen 0 secands
Battery voltage: v Battery voltage Velocity RMS X 1
Sensor Temperature: 7375 Sensor Temperature: Velocity RMS Y.
Ambient temperature: 27.95 Avg Image temperature: 28,54 °C Velocity RMS Z:
Object temperature: 31.27 Battery voltage: v
e B 0O & - Sensor Temperature: 27 °C
PAIR B & v
UNPAIR A 208 -~
102 16606 10 cotectiooconi |

7.  Within the General menu, ensure that “Send data to El Monitor/PhantomLib” and “Store data offline
until manually collected” are both checked.
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El Phantom (589245297)

Live state

[ Enable wiF)
General

[0 static IP Configuration
Collection

[J Enable Repeater
Phantom Sync

; Send data to El Monitor/PhantomLib
El Analytic

Modbus [ static Monitar
MQTT

[ Enable OPC UA Server (port 4334)
System tools

y Send data to custom Cloud
Ofine storage O

Security Store data offline until manually collected

st SAVE RESET

Optional: Within the General menu one has the options to setup a static IP address, and enable Wi-Fi and
unplug the ethernet-wired connection after Wi-Fi configuration.

Add Phantom Equipment Sensors
1. Click the Configuration 4 button and ensure that you are on the Asset Configuration page.

Ensure that the equipment asset is defined and the monitor type is configured as
"Wireless (Phantom)” for the Phantom sensor you are adding.

2. Inthe right-side configuration panel, select the Sensors tab.

3. Enter the Gateway IP address in the IP address textbox.
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Monitor Sensors Collection
Gateway
IP Address:

Password:

Serial Number:

4. Click Add, select Vibration » Phantom in the New Asset dialog box, select the desired Phantom
sensor and click OK.
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New Asset x

General
4 Vibration
I CMS
I NI Wireless
4 Phantom
Phantom IR Camera (T70)
Phantom RPM (540)
Phantom Thermocouple (T25)
Phantom Vibration (High Range)
Phantom Vibration (High Sensitivity)
I Static
ESA
MCSA
EMI
> Thermal imaging
Rotor Flux
Salient Flux
Shaft Grounding
Data Sources

Templates

4p

Name: Phantom IR Camera (T70) #]1

OK Cancel

5. Optionally enter the Gateway Password in the textbox, if the Gateway has a password previously
configured using the Security menu on the Gateway configuration web page.

6. Click on the Equipment node in the asset tree and within the Monitor tab in the right-side
configuration panel click on Update Configuration. Please note that the Update Configuration button
needs to be clicked anytime a change is made to Phantom sensors or equipment nodes to apply
changes.

7. Inthe Sensors tab, click on Discover.

& Update Configuration
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8. Sensors within range of the Gateway will appear. Select a paired sensor and click OK.
sensars

+ Add Q) Discover

9. New sensor nodes will appear in the left asset tree.

a. Alternative: Instead of using Discover, users have the option to manually add sensors in the asset
tree list first.

1. Click Add and select Sensors » Phantom and select the appropriate sensor. Within the right
Properties tab enter the Serial Number.

Properties

Serial Number:

2. After specifying a serial number, click the Add button on the Sensors tab to add them to the
equipment node.

Phantom Node Properties

= Rotating Equipment has three Speed Types available in the Monitor tab: Fixed Speed, Phantom Speed
Sensor, and Data Source Speed.

Speed

Speed Type: Fixed Speed

Fixed Speed
Nominal Speed: s Bt

Phantom Speed Sensor

Data Source Speed

= Phantom sensors have properties to configure their collection settings. Note, these settings may have
animpact on sensor battery life. Please refer to the Erbessd website for Phantom sensor property
details.

Sample Rate (Hz):

Lines of Resolution:

Range (£g):

Transfer Power (dBrm):

Interval (min):
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7.5.2.6. Acquiring Data for Wireless Devices

When the wireless gateway is online with all endpoints mapped to sensor assets, you can test your
wireless device's ability to acquire data. Automatic acquisitions occur periodically, but you can force an
acquisition at any time by using Force Trigger.

Complete the following steps to acquire data from one of your endpoints.

o Acquiring data from all of a device's endpoints can create network congestion.

1. Click the Data Viewer ( e ) button.

2. Expand one of the wirelessly monitored equipment assets, select a sensor asset, and then select
one of the features. By selecting a feature, you activate the Trend viewer chart.

3. Inthe Trend viewer chart, click the Action menu ( =

the endpoint mapped to this equipment asset.

) and select Force Trigger to acquire data from

4. Wait several seconds for the acquisition to complete and click the Refresh button to confirm that
your device received new data points.

If you force an acquisition for all endpoints, it could take several minutes for the
wireless gateway to complete the acquisition.
Repeat the force acquisition several times to acquire multiple data sets.
6. Select a feature level asset for a different equipment asset to confirm in the Trend viewer chart not
yet populated with new data.

Before the data is available, devices must finish performing the acquisition and the

o InsightCM server must receive and store the data. You can change the duration of
force-triggered acquisitions on the Operating States tab for the equipment being
monitored on the Asset Configuration page.

For a complete list of ways you can configure a device to perform acquisitions, refer to Methods for
Initiating Device Acquisitions (page 50).

7.5.3. Thermal Imaging Device Types

Using thermal cameras, monitor thermal data in a large area without extensive wiring to thermocouples.

Device Type Compatible Sensor Asset Description
Camera(s) Type
IR-3120" FLIR A35, FLIR A65 Delta, ROI Supports up to two thermal cameras. See the
IC-3120 help for more information.
IR-90552 Xi410 Delta, ROI Supports up to ten thermal cameras. See the
cRIO-9055 help for more information.
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TConnects directly to the device controller by ethernet connection, not by channels on a module.

2Connects to the device through a Power over Ethernet (PoE) adapter, not by channels on a module.

7.5.3.1. Adding a Thermal Imaging Device

Add a thermal imaging device to collect temperature data from thermal cameras.

1. Click Configuration ( - ) and select Devices.
2. Inthe Devices tab, click Add.

Select Connect to an online device and enter the IP address in the textbox.

If you do not know the device IP address, click Browse to see a list of devices on the
same subnet as the server machine.

4. Click the Connect button. The Test Connection dialog box prompts you if the device fails to connect
to the server machine and come online. Resolve all failures before continuing.

Click Next.

6. If the device passes all connection tests, the web application detects and displays the controller.
Click Next.

7. Enter the two types of names for the device.

a. Device Name—The name that will appear throughout the web application.

Assign your device an easily identifiable name, such as one that includes the
device location.

b. Hardware Name—The hostname of the device, which is in the format of NI-1C-
Mode INumber-SerialNumber by default. If the device is online, the server automatically
populates this name. Otherwise, you can find the two values printed on a label on the back of the
device.

Click Finish.

When the web application prompts you to send the connection information to the device web server,
click Yes.

Discover your FLIR (page 58) or Optris (page 61) cameras.

7.5.3.2. Discovering FLIR Cameras

Discover and add the FLIR A35 and/or FLIR A65 cameras you will use to monitor your equipment's
thermal data.

Ensure that you have completed the steps in Adding a Thermal Imaging Device (page 58) and that you
have the serial number for each camera you intend to add.

1. Click Configuration ( #") and select Devices.
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2. Onthe Devices tab, double-click the device to which the camera(s) connect.

o Cameras are connected and also powered through their connection to the device.

On the Cameras tab, click Add.

4. Inthe Add Cameras dialog box, click Discover and the serial numbers of all valid cameras connected
to the device appear in the table.

Select the cameras you want to add and click Apply.

6. When prompted, enter a descriptive name for each camera and click OK.

Allow several minutes after you add a thermal imaging device before attempting to
discover cameras.

Add regions of interest (page 62) and configure temperature deltas (page 63).

7.5.3.3. Preparing Optris Cameras for Discovery

Set up the Xi410 Optris cameras you will use to monitor your equipment's thermal data before you add
and configure them on InsightCM.

Before you begin, ensure the computer you use for the initial camera setup is compatible with PIX
Connect software and you can change the network settings securely.

1. Install and launch the latest version of PIX Connect software as an administrator.

2. Connect the Xi410 camera to the computer using the provided USB cable.

o Cutsforth recommends setting up one camera at a time.

3. Click Devices and verify that PIX Connect recognizes the camera.

® Optris PIX Connect (Rel. 3.14.3087.0)
File Edit View | Devices | Tools Help
= = 1 Refresh flag F5 ® b

Enable Ethernet
Ethernet settings (TCP/IP) ...

Set configuration to device

Get configuration from device

Xi410 (£21034207) J

Searching for Ethernet device
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4.

10.

11.

12.
13.
14.
15.

16.
17.

18.
19.
20.
21.
22.
23.

Document #:

Click Help > About and verify that the Imager Firmware version on the camera is at least 3814 or
newer.

Imager Firmware version is older than 3814 1. Click Tools - Extended — Update Firmware.

2. Deploy the latest firmware to the camera from PIX Connect.
3. Click Help - About to confirm the firmware update.

4. Click Close.

Imager Firmware version is 3814 or newer Click Close.

Click Devices > Ethernet Settings.
Set Device Address to 192.168.0.101.
If multiple Optris cameras will be connected to the same thermal imaging device,
o increment the last digit of the IP address for each successive camera.
Set Send to address to 192.168.0.100.
Set Subnet Mask to 255.255.255.0.
Set Port to 50000.

If multiple Optris cameras will be connected to the same thermal imaging device,
increment the final digit of the port number for each successive camera.

Disable the Auto assign port number checkbox to better track what data is coming from which
camera.

Set Listen on port number to 50000 (or—if another camera—to the same port number you assigned
to this camera).

Click OK.
Click Tools > Configuration.
On the Device tab, input a Temperature Range.

On the External Communication tab, select the Enable checkbox under Direct temperature mode.

o Temperature values will not be correct unless you enable this checkbox.

Click OK.

Click Devices > Set configuration to device to push your configuration settings to the camera. Once
the progress bar at the bottom of the window is complete, you have successfully configured your
Optris camera.

Disconnect and set aside the USB cable.

Connect the camera to the Power over Ethernet (PoE) adapter.

Using an ethernet cable, connect the PoE adapter to the PoE Switch.

Using another ethernet cable, connect the PoE Switch to the computer.

On the computer, navigate to View network computers and devices in File Explorer.

Select Network and Sharing Center.
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24. Click Change adaptor options.
25. Set up your ethernet port for a connection test with the Optris camera.

a. Select the Ethernet port that is connected to your Optris camera and click Change settings of
this connection > Properties.

b. SelectInternet Protocol Version 4 (TCP/IPv4) > Properties.

c. Select Use the following IP address.
After you successfully test the camera ethernet connection, revert this setting
so that your ethernet port resumes obtaining IP addresses automatically.

d. SetlIPaddressto 192.168.0.100.

e. SetSubnet maskto 255.255.255.0.

26. Test the ethernet connection to the Optris camera.

a. Launch PIX Connect.

b. Click Devices and select the Optris camera you want to test.

c. Select the Connect checkbox and verify that the UDP Port number is 50000.

o If you change the port number between when you configured it during initial

camera setup, you have to re-enter the correct port number each time you
launch the software.

As a result, your operating system firewall may request permission to communicate.

d. Select Private networks and Public networks and click Allow access.

If you are unable to see an image from the camera, you may need to disable

o the Windows Firewall until you complete this test. If you disable the Windows
Firewall, ensure that your computer is not connected to an open network while
the firewall is disabled.

e. Confirm that the direct temperature mode checkbox is enabled.
f.  Click Tools > Configuration > External Communication.

g. Confirm that a live image from the camera shows on the computer and that the Connected to IP
address matches the one you set for the Optris camera during setup.

o The corners of the live image should say Temperature Mode.

27. Close PIX Connect and disconnect the PoE switch from the computer.

28. Using an ethernet cable, connect the PoE Switch to the secondary ethernet port on the IR-9055.

Configure your thermal imaging device (page 58) and sensors (page 62) in InsightCM.

7.5.3.4. Discovering Optris Cameras

Discover and configure the Xi410 Optris cameras on InsightCM.

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

Before you begin, complete the set-up process (page 59) for the Optris cameras and add a thermal
imaging device (page 58). Have your camera IP address(es) and port number(s) ready.

1. Click Configuration ( #") and select Devices.

2. Onthe Devices tab, double-click the device to which the camera(s) connect.

o The camera's device connection both powers the device and carries the signal.

3.  Onthe Cameras tab, click Add.

4. Inthe Add Cameras dialog box, click Discover and the IP addresses and port numbers of all valid
cameras connected to the device appear in the table.

5. Select the cameras you want to add and click Apply.

6. When prompted, enter a descriptive name for each camera and click OK.

Allow several minutes after you add a thermal imaging device before attempting to
discover cameras.

Add regions of interest (page 62) configure temperature deltas (page 63)

7.5.3.5. Adding and Mapping Regions of Interest

Define the section of a camera image that you want to monitor for thermal data.

Complete the following steps to define a Region of Interest (ROI) to monitor using your thermal imaging
camera and device.

1. Click the Configuration pull-down ( - ) and select Devices.

2. Inthelist of devices on the Devices tab, double-click the device connected to the camera for which
you want to define an ROI.

3. Onthe Cameras tab, select the camera that monitors the equipment for thermal data and click
Manage ROls.

In the [Camera Name] ROlIs dialog box, click Add.
In the New ROl dialog box, select the piece of equipment the camera is monitoring.

In the box at the bottom of the New ROI dialog box, enter a descriptive name for the ROl and click OK.

N o g k&

In the ROIs dialog box, click the Capture Image button.

If you added your camera as an offline device, but captured an image that you took
from the device prior to connecting it to InsightCM, you may upload it as a JSON file
and identify ROIs using the uploaded image.

8. Use the Rectangle ROI or Polygon ROI button to draw an ROI on the captured image.
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You can use the arrow buttons along the side of the image to nudge the ROl if the
position of the camera shifts.

9. Without capturing a new image each time, repeat Steps 2-7 until you have added all your ROIs.

10. Click Close when you are finished adding ROls.

7.5.3.6. Configuring Temperature Deltas

7.6.

Deltas measure the difference between two ROIs that have the largest temperature difference in a group
of two or more ROls. The delta is calculated by subtracting the lowest maximum temperature from the
highest maximum temperature of a set of ROIs selected. You can set alarm conditions on deltas to
monitor when the difference between ROl temperatures exceeds the value you specify.

Complete the following steps to configure an ROI Delta.

1. Click the Configuration ( & ") button and ensure that you are on the Asset Configuration page.

2. Inthe asset treg, select the piece of equipment that contains the ROls for which you want to
configure a delta.

Click Add and select Sensors » Thermal Imaging » Delta in the New Asset dialog box.
Enter a descriptive name for the delta and click OK.

On the Properties tab for the new ROI delta, click the Edit button next to the Camera field.

S

In the Camera dialog box, select the camera containing the ROIls you want to configure a delta for,
click OK and a new row for ROls should appear.

7. Click the pull-down next to the ROIs field and select the ROIs you want the delta to compare. Your
changes will be saved automatically.

You can monitor delta values using the thermal imaging viewer on the Data Viewer page after you send
the connection information to the device.

Finding or Setting a Device IP Address

Locate or add the IP address of a device to add it to the server.

Before you begin, power on your Cutsforth monitoring device and connect a removable drive. Use either
atype C drive or a type A drive with a type C converter. If you are using an encrypted USB flash drive,
make sure that it is formatted to use the FAT32 file system.

Once you have mounted your Cutsforth monitoring device, either find and use the device's IP address or
set the IP address to one you receive from your IT department. In either case, save a copy of and update
several fields in the device's networkinfo.json file.

The following table shows all supported values for the IP Address Request Mode field:
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Value IP Address Type

Static

DHCP or Link Local

Link Local Only

AW N PP

DHCP Only

—_

> N

o o

© N

Document #:

Insert the USB drive into the USB port on the controller front panel.

When the USERT LED light is solid, it indicates that the device is reading from or writing to the
settings file.

Remove the USB drive when the USER1 LED starts blinking again.
Insert the USB drive into a USB port on a computer.

Navigate to the following directory on the USB drive:

<RootLevel>:\InsightCM\download\NI-cRI0-Mode INumber-SerialNumber
Create an upload folder in the InsightCM folder if one does not already exist.

Save a copy of the networkinfo_<device hostname>.json to the following location on the USB drive:

<RootLevel>:\InsightCM\upload

o If you save the file in another location, the device will not read it.

Open networkinfo_<device hostname>.json.

Locate the IP address within the object that contains ""IsPrimary" :""true".
The following name/value pair defines the IP address:

IPAdr:Xx.x.x.X

Enter a new value in the IP address field for the primary object.

If using dynamic host configuration protocol (DHCP), record the IP address.
However, Cutsforth recommends using static addresses.

. To assign a static IP address, change the IP Address Request Mode value to 1.

. Enter new values in the Subnet Mask and Gateway fields in the primary object according to the

information you receive from your IT department.

. Save and close the file.

. If you made changes to the file, complete the following steps to apply your changes to the device:

a. Insert the USB drive back into the USB port on the controller front panel.

When the USER1 LED light is solid, it indicates that the device is reading network and
connection properties.

b.  You can remove the USB drive when the USER1 LED returns to blink steadily.
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c. Reinsert the USB drive into a computer and browse to <RootLevel>\InsightCM.

d. Verify the applied folder contains networkinfo_<device hostname> json.

7.7. Permission-Based Access to the Web Application

The server implements authentication for users by providing permissions to groups of users. Permissions
serve as access rights that control the ability of the users to view or make changes to specific pages

in the web application. Therefore, you might not see pages, tabs, or components described in this help
system, or you might not be able to edit particular settings. When possible, this help system documents

the permissions required to perform actions so you can seek assistance from a user who possesses the
required permissions.
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8. Customizing Your InsightCM System

Configure the way your system performs different tasks.
Before you begin, set up equipment assets (page 26) and monitoring devices (page 43).
Complete the following tasks according to your customization goals.

= Configuring Alarms (page 66)— Set alarms to monitor unusual activity and configure alarms to send
email alerts.

= Learn about Device Communication and Configuration (page 93)—Review, update, and configure your
devices for your condition-monitoring needs.

= Learn about Data Sources (page 90)—Learn which data sources InsightCM supports.

= Modify an Asset Type (page 101)—Modify properties, default trend alarm rules, and default fault
frequency sets for all assets of a specific type.

= Learn about Operating States (page 74)—Use operating states to set different collection settings
and/or alarm levels for your assets.

= Add Fault Frequencies (page 105)—Configure fault frequencies for different assets on the Asset
Configuration page and view them with spectrum data in the data viewer.

= Assign Features (page 106)—Specify what features you want an asset to calculate.
= Batch Editing Assets (page 107)—Edit multiple assets at one time using an exported spreadsheet.

= Validate Sensor Data (page 113)—Ensure that sensors are returning valid data.

8.1. Configuring Alarms

Set alarms to monitor unusual activity and configure alarms to send email alerts.

Before you begin, configure your asset tree (page 25), add Cutsforth monitoring devices (page 43), and
acquire data (page 48).

Devices continuously evaluate alarm rules. However, some devices either do not have the ability to
evaluate the alarm rule or do not take continuous measurements. With the exception of Low Rate Feature
Trend Alarms, the server evaluates alarm rules wherever data is received from the device.

Configure alarms to trigger based on equipment activity.

1. Configure an alarm rule.

Configure a trend alarm Monitor the condition of your equipment by configuring trend alarm rules
rule (page 67) that indicate when an asset enters a severe state.

Configure a spectral alarm Configure an alarm for spectral frequencies to monitor the energy level of
rule (page 73) each frequency.
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2. Setup email notifications (page 80)-Receive immediate notification of assets entering a severe
state by directing InsightCM to send you email notifications.

3. Acknowledge trend data (page 87)-Move an alarm instance from Active Trend Alarm to a log of
alarm instances without clearing the instance.

4. Learn conditions for setting and clearing alarms (page 88)-Familiarize yourself with when and how
InsightCM sets and clears alarms and determine if you want to refine an alarm rule with hysteresis, on
and off delays, custom file lengths, and pre-triggers.

Define trend alarm rules either by asset types (page 67) or by auto-configuring levels (page 69).
8.1.1. Configuring a Trend Alarm Rule
Configure a trend alarm rule for an equipment asset.

Before you begin, assign at least one feature (page 106) to the asset for which you are configuring a trend
alarm rule.

A trend alarm ruleis a group of settings that causes InsightCM to set an alarm based on trend behavior.
In most cases, you will configure trend alarm rules for each sensor asset, but you configure trend alarm
rules directly on MCSA equipment assets. To set a trend alarm rule, define levels of severity for data that
will set the alarm. You can manually configure these levels or auto-configure them using a baseline of

data.

1. Click the Configuration button ( ~ ) to navigate to the Asset Configuration page.

2. Intheright side configuration panel, select the Trend Alarms tab.

3. Click Add to display the Trend Alarm Rule dialog.

4. Inthe top left corner of the dialog box, use the pull-down menu to choose a feature you want to

apply.

5. Inthe adjacent pull-down, specify whether this alarm trips for trend values that are greater than or
less than the compared value.

6. Using the Operating State pull-down menu, choose whether the rule applies to all operating states or
to one specific operating state.

If you select All for the Operating State pull-down menu, you can not auto-configure
levels from the baseline since the average data will differ for each feature type.

7. Use one of the following two methods to define severity levels for the trend alarm rule.
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Methods Instructions

Define levels based on a comparison 1. Click the Add button in the Levels section to display the Trend
value that you set. Alarm Rule dialog box.

2. Specify the urgency of the level in the Severity pull-down menu.

3. Specify the threshold you want the Cutsforth monitoring device
to compare trend values against in the Compare To field.

4. Check the Send Email checkbox to enable email options for the
web application to use when the alarm trips.

5. Ifthere is more than one level that you want to set for a trend
alarm rule, repeat these steps as needed.

Auto-configure levels based on a 1. Check the Auto-configure level from baseline checkbox and a
value that InsightCM calculates from new Edit button should appear.

previously acquired data. 2. Click the Edit button that appears next to the checkbox label to

display the Auto-Configure Alarm Rule dialog box.

To use auto- i )

configure, you 3. Inthe Calculation pull-down menu, specify how you want the
must have already Cutsforth monitoring device to calculate the compare value.
acquired data. 4. Click Add to display the Trend Alarm Rule Level dialog box.

5. Specify the urgency of the level in the Severity pull-down menu.

6. Inthe Compare To field, specify the initial value that the web
application uses to calculate the threshold.

7. Check the Send Email checkbox to enable email notifications to
be sent when the alarm trips.

8. (Optional) If you use auto-configured levels, set a baseline.
a. Click the Calendar button to bring up the Select Date Range dialog.

b. Define arange of dates in the Start and End text fields with data you want to use to calculate
a baseline. Click OK. Narrow the data set by clicking and dragging to zoom into a portion of the
timeline. Double-click the graph to zoom out again.

c. Click Set Baseline.

o If you do not set a baseling, InsightCM does not auto-configure levels.

8.1.1.1. Severity for Alarm Rules

Severity is a user-defined value that can be useful for setting the priority of an alarm condition. Use low
severity for conditions that are outside normal operating parameters but still within acceptable limits. Use
high severity for conditions where an analyst should review the data as soon as possible.

When an alarm is triggered, the server retains the data sets from that event. The server keeps track of
the maximum severity for the alarm instance. Whenever a new maximum severity is tripped, the server
retains the corresponding data sets. However, when an alarm transitions between severities, the server
only retains the trend point data.
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Table 1. Alarm Rules with Differing Severities

Feature Condition Set Point Severity Send Email?
True Peak Above 0.2 1 &
True Peak Above 0.4 2 W

Auto-Con

figuring Severity Levels

Use trend baselines to auto-configure severity levels for an alarm rule.

Before you begin, collect data from the asset for which you are configuring an alarm rule.

o~ W

= © ® N o

11.

Click the Configuration button ( ~ ") and select a sensor-level asset.

In the configuration pane, select the Trend Alarms tab.

Find and select an alarm and click Edit.

Select a feature and operator combination you want to auto-configure severity levels for.

Select an operating state using the Operating State pull-down menu.

o If you select All, you will not have the option to auto-configure levels from a baseline.

Check the Auto-configure levels from baseline checkbox to activate a new Edit button.
Click the Edit button.
Choose a calculation type using the corresponding pull-down menu.

Add severity levels and click OK.

0. Below the table of severity levels, click the calendar button to use data collected within a certain date

range as your baseline.

Click OK to select the date range and to activate the Set Baseline button.

12. Click Set Baseline and OK to save your changes.

The alarm you have just modified now has severity levels that InsightCM has configured based on
collected data.

Trend Baseline Minimum Data Ranges

Determine the minimum range of data that the web application should use to calculate a baseline.

Option Description

Minimum Trend Points Specifies the minimum number of trend points used to calculate a baseline.

Minimum Days Specifies the minimum number of days over which data must be collected before
calculating a baseline.

Minimum Standard Specifies a standard deviation to replace the actual standard deviation of the baseline if

Deviation the actual standard deviation goes below this value.
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8.1.1

8.1.1

.2. Configuring Hysteresis

Specify a threshold above or below the severity level that sets an alarm to reduce alarm instances from a
noisy signal.

o This functionality only applied to features calculated on the device.

Before you begin, configure a trend alarm rule (page 67).

Configuring hysteresis is useful for preventing an alarm from clearing immediately after it is set. To learn
more about hysteresis, refer to Conditions of Setting and Clearing Alarms (page 88). Specify an offset
value from the Compare To value that clears an alarm.

Click the Navigation menu and go to Alarms > Trend Rules.

Find and select the trend rule for which you want to configure hysteresis.

Click Edit to bring up the Trend Alarm Rule dialog.

Below the sample of data in the dialog, configure the hysteresis value in the Hysteresis text field.
Click OK.

o K~ W=

The alarm rule that you have modified now clears an alarm when trend values cross the threshold for the
hysteresis you specified.

If you want to refine the conditions for setting an alarm further, consider configuring an on and off
delay (page 70).

.3. Configuring On and Off Delay

Specify a time delay before InsightCM sets or clears an alarm to reduce alarm instances from a noisy
signal.

Before you begin, configure a trend alarm rule (page 67). Configure hysteresis (page 70) before
configuring Off Delay.

On Delay specifies the amount of time that trend values must remain above the Compare To value before
InsightCM sets an alarm. Off Delay specifies the amount of time that trend values must remain below or
above the Compare To, or at the hysteresis value, before InsightCM clears the alarm. To learn more about
On Delay and Off Delay values, refer to Conditions for Setting and Clearing Alarms (page 88).

Complete the following steps to set an On Delay or Off Delay value for an alarm.
1. Click the Navigation menu ( ¥ ) and select Alarms > Trend Rules.

2. Find and select the trend rule to configure its delays.
3. Click Edit to bring up the Trend Alarm Rule dialog.
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8.1.1

8.1.1

4. Below the sample of data in the dialog, configure the delay values in seconds using the
corresponding spin boxes.

5. Click OK.

The alarm rule that you have modified will now delay the setting and/or clearing of an alarm instance by
the amount of time you specified.

.4. Specifying a File Length for Data Collection

Specify file lengths for data that you want your monitoring devices to collect when asset conditions set a
higher severity alarm.

Before you begin, configure a trend alarm rule (page 67).

InsightCM uses the value you specify for the file length to determine the size of the data collection when
asset conditions set an alarm and cross a higher severity threshold.

o This option will override the collection settings determined by the operating state.

Complete the following steps to specify a file length for the data collected for an alarm.

1. Click the Navigation menu (~) and select Alarms > Trend Rules.
Find and select the trend rule to configure its custom file length.

Click Edit to bring up the Trend Alarm Rule dialog.

> N

At the bottom of the dialog, uncheck the Use default collection length checkbox to activate the File
Length text field.

5. Use the File Length text field to specify how many seconds of data InsightCM will collect when
conditions set a higher severity alarm.

6. Click OK.

The alarm rule you have just modified now collects trend data files for the length of time you specified for
File Length.

.5. Specifying a Pre-Trigger Length for Data Collection

Delay the start of data collection when asset conditions set a higher severity alarm.

Before you begin, configure a trend alarm rule (page 67).

InsightCM uses the value you specify for the pre-trigger length to determine how long after asset
conditions set an alarm and cross a higher severity threshold to wait before collecting data.
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o This option will override the collection settings determined by the operating state.

Complete the following steps to specify a pre-trigger length for an alarm.

Click the Navigation menu (~) and select Alarms > Trend Rules.
Find and select the trend rule for which you want to specify a pre-trigger value.
Click Edit to bring up the Trend Alarm Rule dialog.

M wnp o~

At the bottom of the dialog, uncheck the Use default collection length checkbox to activate the
Pre-Trigger text field.

5. Use the Pre-Trigger text field to specify how many seconds InsightCM will wait after asset conditions
set a higher severity alarm before collecting data.

6. Click OK.

The alarm rule you have modified now waits the length of time you specified for the pre-trigger before
collecting data.

8.1.1.6. Defining a Trend Alarm Rule for Asset Types

Define a trend alarm rule for all assets of a certain type.

Edit an asset definition to configure a trend alarm rule for all assets of a certain type.

The changes you make to the definition of an asset type will apply to all applicable
current and future assets.

Click the Navigation menu (¥ ) and select Systems > Asset Definitions.
Select a definition to edit and click the Trend Alarm Rules tab.
Click Add to display the Trend Alarm Rule dialog box.

M w o~

Choose the feature you want the rule to apply to from the pull-down menu in the dialog box.

Only features that have been toggled to default in the Features tab for this asset
type will be available options in this pull-down menu.

5. Inthe adjacent pull-down, specify whether this alarm triggers for trend values that are greater than or
less than the compare value.
6. Choose the operating state to which you want this trend alarm to apply using the Operating States

pull-down menu.

If you choose to make the trend alarm active in all operating states, you will be
unable to auto-configure levels from the baseline because baselines will differ for
each state.
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7. Use one of the following two methods to set levels for the trend alarm rule.

Methods Instructions

Set levels 1. Click Addin the Levels section to display the Trend Alarm Rule Level dialog box.
based on a set
Compare value
that you define.

2. Specify the urgency of the level using the Severity pull-down menu. Spectral alarm
rules are only calculated on the server.

3. Specify the multiplier to which you want the web application to compare trend values in
the Compare To spin box.

4. Check the Send Email checkbox to enable email options for the web application to use
when the alarm trips.

If you have not configured an address group and a specific email
template for an alarm type, you may do so for the default group and
email template that the web application already has loaded.

5. When prompted about applying the alarm rule to all the assets of this type, select Yes or

No.

Set levels 1. Check the Auto-configure level from baseline checkbox and a new Edit button should
basedona appear.
value 2. Click the Edit button that appears next to the checkbox label to display the Auto-
calculated ) ;

: Configure Alarm Rule dialog.
from previously
acquired data. 3. Inthe Calculation pull-down menu, specify how you want the web application to

calculate the Compare To value.
4. Click Add to display the Trend Alarm Rule Level dialog.
5. Specify the urgency of the level in the Severity pull-down menu.

6. Inthe Compare To field, specify the initial value that the web application uses to
calculate the compare value for the level.

7. Place a checkmark in the Send Email checkbox to enable email options for the web
application to use when the alarm trips.

8. Ifavailable, use the following options to override the collection settings determined by an operating
state.

= User default collection length—Uncheck this option to enable the File Length and Pre-Trigger
Length options. InsightCM uses the values you set for these options when the alarm condition is
triggered and when the alarm severity changes.

= File Length—Specify how many seconds of data to collect while the alarm rule is active.

= Pre-Trigger Length—Specify how many seconds of data to collect before the event that triggers
the alarm rule.

8.1.2. Configuring Spectral Alarm Rules
Configure an alarm for spectral frequencies to monitor the energy level of each frequency.

Before you begin, ensure that you have collected data from the sensor asset you are setting a spectral
alarm for.
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o Spectral alarm rules are only calculated on the server.

A spectral alarm rule allows you to set alarms for every frequency of a spectrum to ensure that the energy
level at each frequency is acceptable.

Complete the following steps to configure a spectral alarm rule for a sensor asset.

1. Click the Configuration button ( & ) to navigate to the Asset Configuration page.

2. Select the sensor asset you want to configure a spectral alarm for.

Motor (MCSA) and Voltage Bus are equipment assets that also support spectral
alarms.

Click the Spectral Alarms tab and click Add to display the Spectral Alarm Rule dialog box.

Choose an operating state and integration type.

Select a data event from the list.

Expand the Add Level pull-down menu and select the severity level you want to specify.

N o o s~ W

Draw the line representing the severity level on the graph.

a. Using the preview ling, align your cursor to the g rms height with the corresponding length of the
waveform and click to set the severity level.

b. Fordata that fluctuates along the length of the waveform, raise or lower your cursor, move it
along the length of the waveform, and click to set the same severity level for another section of
the waveform.

8. Click the checkmark button to commit the line of severity levels you have drawn.

data, but you can disable the auto-scale and set a maximum scale by clicking Set
Scale.

o InsightCM sets the scale of spectral frequencies automatically based on collected

9. Inthe top right corner of the dialog, click Done.
10. (Optional) Repeat steps 5 through 9 to configure additional alarm levels as needed.

11. Click OK to save your changes.

8.1.3. Operating States
Operating states set different collection settings and/or alarm levels for your assets.

For many assets, it is useful to define discrete operating states that have different collection settings
and/or alarm levels. For example, if a motor is running, you may want to collect data more frequently than
when the motor is idle or off. Consider the following examples of operating states turbine which has a
tachometer sensor with a speed feature.
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Operating Settings
States

Run-Up = Enter state when RPM rises above 200
= Collect a data set every 30 seconds
= Write data sets whose length is 10 seconds

= Exit state when speed is above 1200 RPM for 20 seconds or speed is less than 200 RPM for
20 seconds

Default = Collect a data set once per hour

= Write data sets whose length is 4 seconds, including 1 seconds of pre-trigger data

8.1.3.1. Transitions Between Operating States

Defining an operating state for unique equipment conditions allows the device to dynamically switch
between collection behaviors. As the Run-Up operating state in the previous example shows, operating
states express a condition to enter the state and a condition to exit the state. While in the state, the
collection settings and conditions can be configured differently than when the asset is in the default
state.

8.1.3.2. How Operating States Affect Data Visualization

The metadata pane on the Data Viewer page displays the operating state that was active when the
device collected the data.

1
‘an
AccelerometerX
= Derived Peak (g)
Desktop
Periodic Event
Operating State: Default
Speed: 180 RPM
2016-08-23 19:59:59
Waveform -
Sample Rate: 10240 | Downsampled
Fmax: 4000 | LoR: 16000 | Downsampled
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8.1.3.3. Editing an Operating State

Change operating states that you can assign to an alarm.

Select the Navigation menu ( ¥ ) and select System > Operating States.
Select an existing operating state and click Edit.

Adjust the name and weight of the operating state as needed.

> w N o=

Create additional operating states by clicking the Add button and specifying the name and weight of
the new operating state.

8.1.3.4. Gating Conditions for Data Sets and Tags

Use gating conditions to prevent data from being acquired when the condition is not met.

When you enable a gating condition for an operating state, the server evaluates each data set collected
under that operating state to see if the gating condition is true. For example, you might want to store data
sets only when the equipment is running as indicated by an RMS above 0.1 g. If the gating condition is
true for a data set, the server stores the data set. Otherwise, the server discards the data set.

o Force trigger always stores a data set and ignores gate conditions.

Trigger Type Evaluated

Time
Delta EU

Alarm

IRNENIER

Force

The gating conditions set for an operating state do not affect burst mode data sets.

o Instead, burst mode data sets are evaluated for gating conditions set in the Burst Mode
Collection Conditions (page 79) section on the Device Properties tab of the Device
Configuration page.

8.1.3.5. Delta EU Triggers

You can define one or more delta EU triggers that initiate an acquisition when a feature or spectral band
changes by at least a specified amount. Both positive and negative changes in value cause a delta EU
trigger to fire.

If the device is unable to calculate the spectral bands on the device, the delta EU
triggers will not fire on the bands.

This setting can be found on the Operating States Tab of the Asset Configuration page.
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The following process explains how the InsightCM Server monitors delta EU triggers.

Device Action Example

When a device starts running, it sets the current value of the Consider a feature whose value is 1 upon

feature or spectral band as the baseline EU value. startup. The baseline EU value is therefore 1.

The device monitors the feature value regularly and compares it Consider a delta EU trigger with a delta level of

to the baseline value to check for a difference greater than the 3. Given the baseline EU value of 1, the device

trigger level. checks for values less than -2 and greater than
4 to see if the trigger condition is met.

If the current value increases or decreases by the delta level, the If the current value is 8, the device performs

trigger fires and the device performs an acquisition. one acquisition.

The device sets the value that caused the trigger to fire as the The new baseline EU value is 8.

new baseline value.

The device continues to calculate the feature value to see if the Given the new baseline of 8, the device checks

difference from the baseline is greater than the delta level. for values less than 5 and greater than 11.

Only the initial start-up value and values that cause delta EU triggers to fire can serve as the baseline EU
value. In other words, when a device performs a time-, alarm-, or force-triggered acquisition, the device
does not update the baseline EU value with the feature value from that acquisition.

8.1.3.6. MCSA Operating States

An electric motor has discrete operating states such as On (Default), Startup, and Off. The following table
lists the default operating states of MCSA devices.

Operating Default Settings
States

Default

Collect a data set once per hour.

Collect trend values every 5 minutes.

Write data sets whose length is 3 seconds, including 1 second of pre-trigger data.

Startup = Enter state when Percent Full Load Amps rises above 200% Full Load Amps (FLA), where FLA
specifies the motor full load current in amperes according to the motor nameplate.
= Collect a data set when entering state. The length of this data set is 30 seconds, including 1
second of pre-trigger data.
= EXxit state when Percent Full Load Amps is less than 110% FLA for 5 seconds or the state lasts for
30 seconds.
Off = Enter state when Percent Full Load Amps falls below 25% FLA.

= Collect a data set once per hour.

= Collect trend values every 5 minutes.

= Exit state when Percent Full Load Amps rises above 25% FLA.

8.1.3.7. Methods for Initiating Data Set Collection

Cutsforth Monitoring Devices continuously or wirelessly monitor data from equipment. However, these
devices collect and log data only when initiated by one of several types of triggers.

Use one of the following triggers to collect and log data.
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Automatic Triggers

Either the software on the devices or the server automatically initiates a data set collection when the
following triggers fire.

Use Case

Type Description Where to Configure

Time Interval Collect a data set at specific times of day or intervals of Operating States tab on the
time. Ensure that trends are complete enough to provide Asset Configuration page
a useful display of machine conditions.

Delta EU Collect a data set when a feature or spectral band value
changes by a specified amount. Ensure data is collected
at the time that a rapid change in measurements occurs.

Enter Condition Collect a data set when the enter condition for an
operating state is met. View the measurements from the
time that equipment changed its status.

Exit Condition Collect a data set when the exit condition for the
operating state is met. View the measurements from the
time that equipment changed its status.

Alarm Set Collect a data set whenever an alarm condition is met. Alarms page
Access data from the time an alarm condition occurred.

when the threshold for new maximum
severity is crossed. Otherwise, only
trend points are sent to the server,
including when an alarm clears.

o Data sets are sent to the server only

Alarm Clears Collect a data set whenever an alarm clears. Access
trend point data from the time an alarm condition ends.

Burst Mode Collect high-resolution data sets at specific times of day Device Properties tab on a
or intervals of time. Troubleshoot equipment with data device's configuration page
that may indicate an issue.

Example: Relationships Between Different Trigger Types

The variety of triggers available in the InsightCM Server means that devices can perform collections
more frequently than the standard time-based intervals. Consider a device whose configuration includes
the following settings.

Setting Value

Total collection duration 1 time unit

Time-based trigger Every 7 time units

Delta EU trigger level 3 engineering units

Alarm rule = Set Point - 75 degrees
= Condition - Above
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High-Resolution Data Acquisition with Burst Mode

What happens to the device while burst mode is active?

The device suspends normal operation and does not check for changes, such as alarms or operating
states, for about 30 seconds before and after acquiring high-resolution data to allow the acquisition
anti-aliasing filters to settle.

What happens to high-resolution data if the device cannot connect to the server?
By default, InsightCM discards high-resolution data if the device cannot connect to the server.

Requesting a Periodic Acquisition

Collect data by using force trigger and view a periodic acquisition.

Complete the following steps to force trigger and view a periodic acquisition.

1. Click the Action menu ( = ) on the Trend viewer toolbar and select Force Trigger.
2. Ifthe Trend viewer already contains curves for the features or sensors of interest, click the Refresh

trend data button ( e ). You might need to wait several seconds to see force-triggered data in
viewers because devices must perform the periodic acquisition, and then InsightCM must receive
and store the data.
Manual Data Acquisition
To view new trend values and sensor measurements between scheduled periodic acquisitions, you can
manually request that a device perform an acquisition. These requests are known as force triggers. Force

triggers are useful when you want to view current asset data without waiting for the next scheduled
acquisition.

You can perform a force trigger from the Action menu ( =) on the Trend viewer toolbar on the Data
Viewer page or on the Devices or Device Dashboard page.

What Is the Duration and Sampling Rate of the Acquisition?

Devices perform force-triggered acquisitions according to the sampling rate, duration, and other
periodic-acquisition settings configured in the web application.

Do Force Triggers Affect Regularly Scheduled Periodic Acquisitions?

No. Force-triggered acquisitions do not affect the timing of scheduled periodic acquisitions that devices
perform.
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Scheduling Temporary High-Resolution Data Acquisition

Schedule a high-resolution data acquisition on a device.

You can also schedule a burst data set collection to run on a device periodically so you can compare
high-resolution data over time.

Complete the following steps to schedule high-resolution data acquisition on a device:

1. Click the Configuration pull-down ( - ) and select Devices.

2. Double-click a device and select the Device Properties tab.

o This tab is not available for thermal imaging device configuration pages.

Select the Enable burst mode checkbox.
In the Burst Collection Conditions section, click Time.

In the Edit Condition dialog box, specify how frequently to acquire high-resolution data.

© o~ W

In the Burst Collection Settings section, specify the sample rate in Hz and acquisition length in
seconds that you want InsightCM to use for the scheduled high-resolution data acquisition.

7. Update the device configuration.

8.1.4. Setting up Email Alarm Notifications
Configure InsightCM to send alarm notification emails.

Alarm notification emails are setup via one of two options, either the SMTP Configuration Option or the
Microsoft 365 Email Configuration Option; only option can be used at a time.

Before you begin, configure your role with serverSettings_edit permissions, create an address
group (page 85), and create an email template (page 86). Refer to Relationships Between User
Accounts and Permissions (page 153) for more information about permissions.

8.1.4.1. Email Configuration Options

The following steps describe the two options to setup alarm notification emails via either the SMTP
Configuration Option or the Microsoft 365 Email Configuration Option.

SMTP Configuration Option

1. Onthe server machine, in File Explorer, navigate to the ProgramData\Cutsforth\insight CM\Auth
folder.

2. Open the SmtpConfiguration.json file in a text file editor.

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

o The InsightCM Server acts as an SMTP client and sends messages to an SMTP
server when you edit this file with information about the SMTP server.
3.  Modify each line category according to your server information.
"Host'': ''<servername>",
"Port': "<port number>",
"UseSsl": <true or false>,
"RequireAuthentication”: <true or false>,
"Username': ''<username>",

"Password': "Secret\\Password", "'Secret\"Password"

If your password contains backslashes or double quotations, you must use double
backslashes or a backslash and double quotations respectively as shown in the
above example.

"TimeoutSeconds': <number>,
"FromAddress": "yes-reply@localhost",
"TestMode': <true or false>

Test Mode prevents the server from sending emails, even when you run commands
from the InsightCM console. Enable the SMTP.Emails tracepoint to view messages
that the server writes to the trace log.

4. Save the json file and open Windows Services.
Find and select InsightCM <version> and click Restart.

o Restarting the InsightCM service enables the software to read the new SMTP
settings.

Add an email template and address group to an alarm (page 87).

Microsoft 365 Email Configuration

Entra ID (formerly Azure Active Directory) Configuration
Follow these steps to connect InsightCM to your Microsoft 365 tenant to send email notifications.
1. Loginto the Azure portal as an administrator of your tenant.

2. Navigate to Entra ID.

3. Onthe Overviewpage, make note of your 7enant ID. Use this value for the Tenant D property in the
InsightCM configuration.
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4. Create an app registration for InsightCM.
a. Navigate to App registrationsin the left navigation menu.
b. Click New registration.
i.  Give the registration a descriptive name (e.g., "InsightCM Email").
ii. ForSupported account types, select Accounts in this organizational directory only.
ii. A Redirect URlis not necessary.

c. After creating the app registration, take note of the application (client) ID. Use this value for
the ClientID property in the InsightCM configuration.

Home > MSFT | App registrations

= InsightCM Email 2

[:"kﬁ'ﬁ'ir' I 4 'E' Delate @ Endpoints [ Preview features

B overview
# Essentials

& Quickstart
Dasplay name Chent credentials

&' Imegration assistant Insighiche Email 2 Add 3 centificate of sacret
Applcation fchent) 10 Redirect URIs

b Add 3 Rediract UR

E granding & properties Object ID Application ID UR

Add an Apphcateon I LR
B Authentication

Carectory (tenant] 1D

in local directony

Certificates & secrets

1! Token configuration

5. Create client credentials for your app registration.

a.  We support two options for Microsoft 365 credentials in InsightCM: client secrets (i.e.,
application passwords) and certificates. It is recommended to use a certificate for production
applications.
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To use client secret credentials:

In your app registration in Entra ID, navigate to Certificates & secrets.
Under the Client secretstab, click New client secret.
A. Enter a description and an expiration date, and click Add

Take note of the secret value. This value will not be shown again after navigating away from
this page. Use this value for the ClientSecret property in the InsightCM configuration.

Home risaghtCM Email

InsightCM Email 2 | Certificates & secrets # ®

T A7 Got teedback?
B overvew

Credentials enable confidential applications to identify themsebes to the authentication senvice when resenang
& Quickstant tokans at & with addrissable location {using an HTTPS schemigl. For & higher kvl of aisurance. we recommend usang
a certificate (instead of & clent secret) as a credential
A ntegration assistant
Marage i
Certificates (J)  Client secrets {1} Federated credentials (0}

B eranding & propaties
& gecret string that the application uses Lo prove its identity when reguesting a token. Also can be referred to as

3 Authenbicatnon applation password

Cartificates & secrefts
< s T Niw chent secret

!|' Talokn configuration
Description Expires Value Secret 1D

ICM password 31072024 [

AP permissions

& Expote 3n AN

To use certificate credentials:

Vi.

Procure a certificate from a certificate authority, or generate a self-signed certificate (not
recommended for production applications).

In your app registration in Entra ID, navigate to Certificates & secrets.
Under the Certificates tab, click Upload certificate.
Select your certificate (public key) for upload, and provide a description.

Once the certificate has been uploaded, take note of the certificate thumbprint. Use this
value for the ClientCertificateThumbprint property in the InsightCM configuration.

Import the certificate (with its private key) to a certificate store on the InsightCM server.
Take note of the name and location of the certificate store where it is imported. Use these
values for

the ClientCertficateStoreName and ClientCertificateStoreLocation proper
ties in the InsightCM configuration.

6. Provide appropriate permissions to your app registration.

a
b.

C.
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Navigate to "API permissions" within your app registration.

Click Add a permission.

Select Microsoft Graph.

Select Application permissions.

Find and select the MailSendpermission.
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f.  Click Add permissions.

g. Grantadmin consent for permissions change by clicking Grant aamin consent for [TENANT
NAME].

7. Getuser object ID for mailbox to send from.
a. From Entra ID, navigate to Users.
b. Select the user account from which you want to send email.

c. Take note of the user's Object ID. Use this value for the UserObjectld property in the
InsightCM configuration.

Home » MSFT | Users » Users

2 Brian Henry

| Boarch | & wdtproperties [ Dwbete () Rafresh Y, Reset password (3 Revokesesmons (50 Manage vew & Got feedhack?
& Overview J
Chverview Menitonng Properties
E Auct log
D sigrein fogs Basic info

&* Ciagnase and sohw prablems

Manage Brian Henr
SATUECEER L0

B Custom security stiributes Rt oM
=
& Assigned roles
B Adreereirative units Wser principal name —cnmlcrmoftccm [Ik] Group membe_. T
5 Gous Objeti I
Applications

B appestices Created date time Aug 24, 2023, 352 b

2 Assigned ol

W Loenses WSET Type Member

i Devices Edentities R -ricroicttcom Assigned Been.

8. Provide configuration info to InsightCM.

a. Locate and open the Microsoft365SendMai IConfiguration. json file
from C:|ProgramDatalCutsforthlinsight CMIAuth.
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b. Setthe Enabled property to true.
c. Enter the values from Entra ID gathered in the previous steps.

d. TheCredentialAuthorityHost property can usually be left as nul I, which defaults
to the Azure Public Cloud. If your Microsoft 365 tenant is hosted in an Azure
National Cloud, enter the appropriate Azure AD authentication endpoint URL for
the CredentialAuthorityHost property.

9. Restart the InsightCM service to adopt the new configuration.
Microsoft 365 Test Tenant Setup (For Internal Testing)

To test InsightCM Microsoft 365 email integration internally, create a Microsoft 365 developer sandbox.
You can create the sandbox with preconfigured sample users so you won't have to create your own.

= Note: Emails sent via Graph API through a Microsoft 365 trial account (e.g., a dev sandbox) will be
rejected by other email providers and will not be delivered (not even to a spam folder). To verify that
emails are being sent successfully, you have two options:

1. Contact Microsoft support through your developer sandbox, explain that you are unable to send
emails through the Graph API because your Microsoft 365 tenant has a trial license, and request that
your tenant IP be added to an exclusion list.

2. Instead of verifying that the emails are delivered, log in to the sandbox user's Outlook account
(using the webapp) and verify that the ICM emails are in the "Sent" folder. There should also be
"bounceback" emails in the sandbox user's inbox from the failed deliveries.

Testing Certificate Credentials

Follow these instructions to create and export a self-signed certificate for testing in PowerShell.

= Note: If you create the certificate on a different machine than InsightCM is running on, make sure to
export the certificate with its private key (i.e., as a .pfxfile). Then, import the certificate (with private key)
on the InsightCM server.

8.1.4.2. Creating Address Groups

Create and maintain lists of email addresses to which InsightCM sends alarms and other notifications.

If there are several users that need to receive certain email notifications, create an address group. Use
address groups to keep a diverse portfolio of users informed regarding the state of InsightCM or the
equipment it is monitoring. Complete the following steps to create a new address group and assign the
group to an alarmrule.

To customize the email sent for a specific alarm rule, create an email template and
assign it to the alarm rule. Refer to Creating Email Templates (page 86) to learn how to
do so.

1. Click the Navigation menu (¥ ) and select Options.
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2. Navigate to the Notifications section, select Address Groups,and click the Add button.
Enter a name for the address group in the Name text box.

4. Enter valid user email addresses and separate each email address with a comma, new ling, space, or
semicolon.

5. Configure the level of visibility that individual users have regarding other recipients of the same email
notification by using the various recipient text boxes.

6. Click OKto add the new address group to the Selected Group pull-down list.

Once you add email addresses to an address group, keep at least one email
address saved to the address group.

8.1.4.3. Creating Email Templates

Create templates for email notifications that the InsightCM Server sends when an alarm is set.

Click the Navigation menu (¥ ) and select Options.
Scroll down to the Notifications section and select Email Templates.
Select the default option from the Template pull-down.

(Optional) Click the Edit button to give the email template a descriptive name and click OK.

a > v o=

(Optional) Write a brief description of what information this template will send about an alarm.

o The contents of this description do not show up in the alarm email.

6. Write an informative subject line for the email template.

7. Write the contents of the email and click OK.
Define email templates independently of address groups to pair one address
group with multiple email templates or one email template with multiple address
groups. You may want to notify a single individual when a low-severity alarm occurs,

but notify several individuals with the same message when a high-severity alarm
occurs.

Add your email template to an alarm rule (page 87).

8.1.4.4. Alarm Template Tokens

Email templates support the following tokens:
= Asset Name: %AssetName%
= Severity: %Severity%

= Alarm Level: %Level%

= Timestamp: %Timestamp%
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= Value: %Value%
= OnDelay: %0nDelay%
= OffDelay: %OffDelay%

For example, the following email template string will indicate which asset fired the alarm: "An alarm was
raised on the following equipment: %AssetName%"

8.1.4.5. Adding an Email Template and Address Group to an Alarm

Assign an email template to an alarm level.

Before you begin, create an email template (page 86) and create an address group (page 85).

Click the Navigation menu (¥ ) and select Alarms.

Select an alarm and click Edit.

Under Levels, select an alarm severity level and click Edit.
Select the Send Email checkbox.

Select an address group.

Select an email template.

Click OK.

N o ok N =

8.1.4.6. Testing Email Notifications

Use the console to test whether InsightCM sends email notifications successfully.
Before you begin, set up email alarm notifications (page 80).

1. Onthe server computer, open Command Prompt.

2. Navigate to the folder in which InsightCM is saved using the following command:

cd C:\Program Files\Cutsforth\InsightCM

3. Execute the following commands to test email notifications:

InsightCMConsole.exe sendtestemail -grp [address group name]

4. Verify whether a test email notification is sent to those in the address group.

8.1.5. Acknowledging an Alarm

View the relevant data for and acknowledge a trend alarm.

1. Click the Navigation menu ( ¥ ) and select Alarms > Active Trend.

2. Selectan alarm and click View to see the relevant Trend viewer data in the Alarm dialog.
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3. Click Acknowledge.

As a result, you moved the alarm instance from the Active Trend Alarm tab to the Alarm Instances
dialog, though you did not clear the instance.

If the data rises above the set point a second time, InsightCM displays the alarm
instance again on the Active Trend Alarms tab.

8.1.6. Conditions for Setting and Clearing Alarms

Alarm states and whether you acknowledge or clear the alarm determine the notification behavior of your
configured alarms.

8.1.6.1. Alarm States

Once you begin collecting data, define conditions that set or clear an alarm. Alarms can have a
combination of the following states.

Set InsightCM detected that conditions for an alarm rule have been met and created an alarm
instance.

Acknowledged A user indicated awareness of the alarm.

Acknowledging an alarm does not clear it, so that if the conditions for setting
the alarm are met again, a new alarm instance is not logged.

Clear InsightCM detected that the alarm rule is no longer true. A cleared alarm remains on the Active
Trend Alarms tab or Active Spectral Alarms tab until you acknowledge it.

The following table lists the different alarm states the web application displays on the Alarms page.

Set? Clear? Acknowledged? Location on Alarms page
o & & Active Alarms tab

o 4 & Active Alarms tab
o & W Active Alarms tab
W o o

Alarm Instances dialog box

8.1.6.2. Alarm Changes State Without Acknowledgment

To demonstrate how an alarm enters a Set state, consider the following illustration where an alarm is

set and cleared twice. Assume that you never acknowledged the alarm. In this example, the same alarm
instance remains on the Active Trend Alarms tab or Active Spectral Alarms tab the entire time even
though its status transitions to Cleartwice. Since the first instance of the alarm was not acknowledged,
InsightCM collects no additional data sets and issues no new notification when the alarm enters the Set
state the second time.
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Sat Point =

@ Alarm set

@ Alarm clear

8.1.6.3. Alarm Changes State with Acknowledgment
Consider the same scenario and data as in the previous section. If you acknowledge the alarm at either

time indicated by @ in the following illustration, the web application moves the first alarm instance from
one of the Active Alarms tab to the Alarm Instances dialog. When the data crosses the set threshold the
second time, the web application displays a new alarm instance an Active Alarms tab.

Since the first instance of the alarm was acknowledged, InsightCM collects a new data
set and issues a new notification when the alarm enters the Set state the second time.

Sat Point =

@ Alarm set

@ Alarm clear

@ Times when acknowledging the alarm will cause the web application to move the first alarm instance
to the Alarm Instances dialog box after its status becomes Clear.

8.1.6.4. Viewing Alarm State Timestamps

To see the timestamps of an alarm entering Set, Cleared, or Acknowledged states, double-click the alarm
instance on the Active Alarms tab.
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Active Trend Alarms Trend Rules Active Spectral Alarms Speciral Rules
filter asset n Auto Refresh: | 30sec ~ H =
O | Asset Operating State Setat | Current Value Current State = Max Severity
! Equip 2 > Accel 1 (Crest Factor)  All 2019-01-14 15:41:13 4.246 Low (1) Low (1)

8.2. Data Sources

8.2.1. Modbus Communication

The InsightCM monitoring devices can read data using Modbus TCP or serial communication. Modbus
data will be included in the trend points stored on the server and can be used in collection triggers and
alarms.

= Serial communication—The device can address one or more Modbus slaves and the Modbus slaves
can communicate directly with the device.

= Ethernet communication—The device establishes a TCP connection with a Modbus slave on a specific
IP address and port. The device can support TCP connections to multiple Modbus slaves.

8.2.2. OPC UA Communication

The device acts as an OPC UA (Open Platform Communications Unified Architecture) client and initiates
queries from the OPC UA Server. The device establishes a connection with the specific URL of the OPC
UA Server. The device typically connects through TCP.

8.2.3. Historian Software
The device connects through TCP to the InsightCM server to access the historian software data.
8.2.4. Creating and Configuring a Data Source

Configure a data source from external sources, such as a Modbus Register, an OPC UA Tag, or a Historian
Input.

1. Click Configuration ( & ) and select Assets.

Click the Action menu (
Click Add.

Select the type of data source you want to create via the listbox.

) and select Data Sources to display the Data Sources dialog box.

Specify a name for the data source and click OK.

SR T

Select the new data source in the asset tree and configure the appropriate properties in the
configuration panel.
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7.

Select the Registers (for Modbus), Tags (for OPC UA), or Points (for Historian Input) tab.

8. Click Add and configure the appropriate data source item properties.

9.

Click Close.

8.2.5. Data Source Type Properties

8.2.5.1. Modbus Read Channel Properties

The Modbus register supports properties that affect how the device reads data.

Property Name Description

Register Type

= Discrete Input—The register addressed represents a sensor input or other Boolean value
to read.

= Coil—The register addressed represents an output or internal bit to read.

* Input Register—The register addressed represents an analog input value or other integer
value to read.

= Holding Register—The register addressed represents an analog output or internal number
to read.

Address

The address of the Modbus Register to read

32-bit data type

If true, 32 bits will be read from the Register at the specified Address.

First word low (32-
bit data type)

If checked, the 32-bit value read from the Register will have the low order word in the first 16
bits.

Floating-point (32-

If checked, the 32-bit value read from the Register will be interpreted as a floating-point

bit data type) number.

Unit Specifies the unit to be used for the Engineering Value read from the Register

Slope The slope value, represented by m in the following equation: Engineering Value = m(Raw
Value) + b.

Offset The offset value, represented by b in the following equation: Engineering Value = m(Raw

Value) + b.

8.2.5.2. Modbus Serial Data Source Properties

The Modbus Serial data source supports configurable properties that affect how the device
communicates with the Modbus slave.

Property
Name

Address

The address of the Modbus slave with which you want to communicate

Modbus Serial properties are available only after you add a Modbus Serial data
source (page 90).

Description

Interval (sec)

How often the device process reads the Modbus slave, in seconds
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Property Description
Name
Serial Type The type of data transmission through serial ports:

* RTU—Sends data using the Remote Terminal Unit (RTU), which is a binary data unit

* ASCIl—Sends data using human-readable characters

Baud Rate The baud rate of the Modbus slave with which you want to communicate. The default is 9,600.

Parity The parity of the Modbus slave with which you want to communicate
= None—Use no parity bit. If you specify Vibration for parity, the number of stop bits indicating the
end of a frameis 2.

* Odd—Use odd parity. If you specify Odd for parity, the number of stop bits indicating the end of a
frameis 1.5.

= Even—Use even parity. If you specify Even for parity, the number of stop bits indicating the end of

aframeis 1.5.
Stop bits The number of stop bits used by the Modbus slave should reconfigure the misguided syntax
globally you want to communicate with. You can select 1 or 2.
Data bits The number of data bits used by the Modbus slave with which you want to communicate. You can
select7 or 8.
Flow Control The flow control of the Modbus slave with which you want to communicate.

= None—Does not use flow control. The transfer mechanism assumes buffers on both sides of the
connection to be large enough to hold all data transferred.

XON/XOFF—Uses the XON and XOFF characters to perform flow control. When the receiving
buffer is almost full, the transfer mechanism controls the input flow by sending XOFF. When
the buffer receives XOFF, the transfer mechanism controls the output flow by suspending
transmission.

RTS/CTS—Uses the RTS output signal and the CTS input signal to perform flow control. When
the receiving buffer is almost full, the transfer mechanism controls the input flow by unasserting
the RTS signal. When the buffer unasserts the CTS signal, the transfer mechanism controls the
output flow by suspending the transmission.

XON/XOFF and RTS/CTS—Uses the XON and XOFF characters, the RTS output signal, and the
CTS input signal to perform flow control. When the receiving buffer is almost full, the transfer
mechanism controls the input flow by sending XOFF and unasserting the RTS signal. When
the buffer receives XOFF, the transfer mechanism controls the output flow by suspending
transmission.

DTR/DSR—Uses the DTR output signal and the DSR input signal to perform flow control. When
the receiving buffer is almost full, the transfer mechanism controls the input flow by unasserting
the DTR signal. When the buffer unasserts the DSR signal, the transfer mechanism controls the
output flow by suspending the transmission.

XON/XOFF and DTR/DSR—Uses the XON and XOFF characters, the DTR output signal, and the
DSR input signal to perform flow control. When the receiving buffer is almost full, the transfer
mechanism controls the input flow by sending XOFF and unasserting the DTR signal. When the
buffer receives XOFF and unasserts the DSR signal, the transfer mechanism controls the output
flow by suspending transmission.

Read How long the read process waits for a response from the Modbus slave when initializing or reading
Timeout from the device. If the Modbus slave does not respond within the specified timeout, the device
(sec) attempts to re-open a connection after 30 seconds.
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8.2.5.3. Modbus TCP Data Source Properties

The Modbus TCP data source supports configurable properties that affect how the device
communicates with the Modbus slave.

Modbus TCP properties are available only after you add a Modbus TCP data
source (page 90).

Property Name Description

IP Address The TCP/IP address of the Modbus slave with which you want to communicate.

Port The TCP port of the Modbus slave with which you want to communicate. The default is 502.

Interval (sec) How often the InsightCM device process reads the Modbus slave device, in seconds.

Read Timeout How long the read process waits for a response from the Modbus slave device when initializing

(sec) or reading from the device. If the Modbus slave device does not respond within the specified
timeout, the InsightCM device attempts to re-open a connection after 30 seconds.

8.3. Madifying Device Communication and Configuration

Review, update, and configure your devices for your condition-monitoring needs.
Before you begin, add a Cutsforth monitoring device (page 43).
Complete any of the following tasks to customize your devices in InsightCM.

= Change Settings in Device Configuration (page 94)-Configure device settings, such as endpoint
mappings, data groups, channel mappings, sample rate, and hardware configuration.

» Reintegrate Quarantined Endpoint (page 94)-Re-establish communication with an endpoint without
rebooting the wireless gateway.

= Configure Units of Data (page 95)-Allow or restrict specific units for channels with a certain
measurement type.

= Change Units to Metric (page 96)-Change measurement type units to metric.

= Update Device Software (page 96)-Review the application types and versions running on each device
and update the application and firmware that the device runs.

= Review Detailed Device Information (page 98)-Review a summary of device information based on the
most recently acquired sensor data.

= Learn about Device Property Configurations (page 99)-Learn how to fine-tune file transfer and
network performance for wireless and CMS devices.

= Reset Device to Factory Settings (page 1071)-Reset a device to its original application image.

Now that you have customized your devices in InsightCM, learn about and integrate a historian
software (page 157).
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8.3.1. Changing Device Configuration Settings

Configure device settings, such as endpoint mappings, data groups, channel mappings, sample rate, and
hardware configuration.

1. Click Configuration ( £ ") and select Devices.
2. Double-click a device to open its configuration page.

3. Configure the settings you want to modify using the tabs in this device's configuration page.

Mapping Device Map each sensor to a device channel.

Channels (page 46)

Creating and Configuring Data Configure a data source from external sources, such as a Modbus
Sources (page 90) Register, an OPC UA Tag, or a Historian Input.

Device Property Learn how you can fine-tune file transfer and network performance for
Configurations (page 99) wireless and CMS devices.

Updating a Device's Hardware Update your device's configuration in the web application, including the
Configuration (page 94) placement of modules within chassis slots, to match the physical device.

4. Click Back to Devices.
5. Select the device you updated and click Update Configuration to apply the changes.

8.3.1.1. Updating a Device's Hardware Configuration

Update your device's configuration in the web application, including the placement of modules within
chassis slots, to match the physical device.

1. Click the Configuration pull-down ( & ) and select Devices.

2. Double-click the device whose hardware configuration you need to update and select the Hardware
tab.

Click Edit Hardware.

Configure the IP address, controller type, and module arrangement as needed in the Edit Hardware
dialog box.

o The module options for each slot may be limited according the slot place in the
chassis.

8.3.2. Reintegrating Quarantined Endpoints
Re-establish communication with an endpoint without rebooting the MON-10496.

When an endpoint fails to communicate 5 times, the MON-10496 quarantines the endpoint, or ceases
to attempt communication with the endpoint. Until you correct the cause of failure and re-establish
communication, data is not collected from the quarantined endpoint.

Common reasons an endpoint fails to communicate:
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= The battery needs to be changed.
= There is a significant obstruction between the endpoint and the MON-10496.

1. Onthe main Dashboard, click Wireless to access the Wireless Dashboard.
2. Select the quarantined endpoint.

Click the Action menu ( — ) and select Clear Quarantine.

4. Confirm that the endpoint's status changes and that communication with the endpoint has been
re-established.

[t may take several minutes for the endpoint status to update. The MON-10496
to communicate with endpoints 5 times every 15 minutes before quarantining
unresponsive endpoints again.

8.3.3. Adding or Removing Units of Data
Allow or restrict specific units for channels with a certain measurement type.

The default setting for units in the web application is imperial. Refer to Changing Measurement Type Units
to Metric (page 96) to switch from imperial to metric.

Each sensor type can have one or more allowed units. The units you allow for a sensor
type also determines in what units InsightCM calculates features.

1. Click the Navigation menu (¥ ) and select System > Units.
2. Selectasensor type.

3. Click Add Unit or Remove Unit to specify what units each sensor type can use.

8.3.4. Supported Units

See the imperial and metric units for each measurement type.

Measurement Type Imperial Metric
Acceleration g m/s2

Current amp amp
Displacement mil, volt, in m, mm, micron
EMSA uv uv

Resistance ohm ohm

Speed RPM RPM
Temperature F C

Velocity ips m/s, mm/s
Voltage volt volt
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8.3.5. Changing Measurement Type Units to Metric
Complete the following steps to switch to metric units.

1.  Open the following directory:

C:\ProgrambData\Cutsforth\InsightCM\Definitions\AssetNodeTypes
2. Open a sensor definition you would like to update (e.g. Accelerometer.json) in a text editor.

3. Find the property definition where the key value is Unit and change the value of DefaultValue to the
appropriate metric unit.

4. Save the file and repeat steps 2-3 for all the sensor definitions you would like to update.

Open a command prompt on the server machine and change to the following directory:

<Install Drive>:\Program Files\Cutsforth\InsightCM\

6. Run the following command:
InsightCMConsole.exe import-definitions

8.3.6. Updating Device Software

Review the application types and versions running on each device and update the application and
firmware that the device runs.

1. Click Configuration ( £ ") and select Devices.

2. Click the Software tab and select one or more online devices.

o The devices you select must be of the same type.

3. Depending on your updating goal, complete one of the following steps.

Update the application on one or Click Update Application.

more devices to the latest version on

InsightCM. = This operation requires devices to reboot
and might take several minutes to complete.

= The web application does not allow you
to update applications for devices with a
disabled connection status.

Verify the latest application is running on Compare the Configured Version and Latest Version columns in
a device. the device table to see if a more recent application version is
available on the server.

Resolve persistent errors with the device
operation. This step should only be
taken with a recommendation from
Cutsforth, as there may be solutions
other than formatting the device.

Click the Action menu ( — ) and select Format Device.
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8.3.7. Upgrading Device Hardware

Upgrade your device hardware in InsightCM to match the device types that you have while keeping
existing asset mappings intact.

Click Configuration ( £ ') and select Devices.
Select a device and click Edit.

Select the Hardware tab and click Upgrade Hardware.

> L n -

Specify which device type you are upgrading to using the pull-down and click OK.

Since this action cannot be undone, ensure that you are upgrading the correct
device before confirming the change.

The changes are applied automatically.

5. Ifthe IP address of your upgraded device has also changed, click Edit Hardware to update that
information.

8.3.8. Uploading or Removing Software Packages

Update the system image on your monitoring devices by uploading the new image versions to InsightCM
and deploying the image to your devices.

Before you begin, download the version of the device image you wish to deploy.
To add or remove firmware versions from InsightCM, complete the following steps.
1. InlInsightCM, click the Navigation menu (¥ ) and select Utilities > Package Management.

Click Upload, select the system image you wish to deploy to your devices, and click Open.
Select the outdated image(s) and click Remove.

Click Configuration ( ¥) and select Devices to navigate to the Device Configuration page.
Select the Software tab.

Select one or more devices of the same toolkit and type.

N o g A

Click Update Application to apply the new image.

o To update the firmware for your devices, click the Action menu ( — ) and select

Update Firmware.

8. Verify that the Deployment Status updates to Successful.

8.3.9. What Happens to Files When You Update Device Applications

When you update applications on a device, the device deletes log files (including the tracelog) and
configuration files.
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To manually retrieve any type of file from the device disk, Cutsforth recommends using WebDAV, a
protocol that enables you to securely manipulate files on your target, to retrieve files. Files on the device
are located at/ hone/ | vuser/ nati nst/LabVlI EW Dat a/ | nsi ght CM

from the device, visit ni . cont i nf o and enter the Info Code WebDAVTr ansf er to
access the Cutsforth support document Using WebDAV to Transfer Files to Your Real-
Time Target.

o For information about configuring WebDAV on a host computer and transferring files

8.3.10. Review Detailed Device Information

Review a summary of device information from the most recently acquired sensor data.

@ S & Device Dashboard InsightCM 0 v
(]

Q
]

Last refreshed 2020-10-06 20:29:52 Auto Refresh: 30sec

CMS-9065 1B99127 9232

10.2.33.70 since 2020-09-29 19:09:33
Features Filter by Name (x] Status
Name T Value Updated at T
N 1B99127 Accels B
1899127 Accels A > Accelerometer 1 Crest Fa...  invalid 2020-10-06 20:29:54
1B99127 Accels A > Accelerometer 1 Derived ...  invalid 2020-10-06 20:29:54
‘ i Operating State: Default
1899127 Accels A > Accelerometer 1 High Fre..  invalid 2020-10-06 20:29:53
1B99127 Accels A > Accelerometer 1 Peak-Pe...  invalid 2020-10-06 20:29:54 Entered State at: 2020-08-31
18:35:48
1B99127 Accels A > Accelerometer 1 RMS (g) invalid 2020-10-06 20:29:54 -
- Data Events (last 81
24h):
Trend Alarms Health :
Last File Sent at: 2020-10-06
Asset Set at C.. C. M. Stat Value = Updated at 20:14:58
Response Time (ms) 4 2020-10-062... =
Low Rate Count - 1B99... 15 2020-10-06 2... 1B99127 Accels A
Low Rate Count - 1B99... 15 2020-10-06 2...
CPU Utilization 10.8.. 2020-10-06 2...
Operating State: Default
Memory Utilization 43.6... 2020-10-06 2...
‘ L Entered State at: 2020-08-31
Disk Utilization 19.6.. 2020-10-06 2... 18:35:48

1. Click the Configuration pull-down ( & ) and select Devices.

2. Watch data update while the device performs an acquisition, reboots, or you test its connection

)

1]

using the Action menu (

3. Click the Viewmenu ( ) to navigate to the Device Configuration page and update settingsin a
device's configuration.
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o The Features table updates only when data is available from a channel whose status
is okay.

4. Click the Viewmenu () to navigate to the Device Health Dashboard page and evaluate the health
of a device by viewing statistical data, including graphs of available memory, CPU usage, drive space,
and the response time to pings, over a configurable time range.

8.3.11. Device Property Configurations

You can fine-tune file transfer and network performance for wireless and CMS devices using the following
features.

Burst Mode - A mode that you can configure on a device to enable the manual or scheduled acquisition
of high-resolution data.

Sample Rate - You can configure the sample rate for channels on Cutsforth 923x modules only. Devices
always sample from static channels on other module types at 1 Hz and for one second. For more
information, refer to Frequently Asked Questions about Sample Rates and Durations (page 99).

Time Trigger Offset- An amount of time, in seconds, to delay time-based acquisitions. For example,
if a device is configured to perform an acquisition daily at 1:00 PM, and the value of this property is
110 seconds, the device waits until 1:01:50 PM to perform the acquisition. This property is useful for
spreading out network traffic when many devices are configured to perform acquisitions at a specific
time of day.

8.3.11.1. FAQs on Sample Rates and Durations

Q: At what sample rate do devices acquire data?

A You can configure the sample rate for waveform channels on dynamic modules, such as the Cutsforth
9232, on the Device Configuration page by double-clicking on a device and selecting the Device Properties
tab. However, devices always sample from channels that produce single-point values, such as voltage and
temperature, at 1 Hz. If a device contains both types of channels, the device samples them at different rates.

Q: Can you configure unique sample rates or acquisition durations for each channel?
A No:

= Allwaveform channels on a device share the same configurable sample rate.

= All single-point channels are sampled at 1 Hz.

If you must sample from two nearby sensors at different rates, consider using two different devices, each with
a unigue sample rate.

Q: How do devices log single-point data during a multi-second acquisition?

A: When a device contains both waveform and single-point channels, you configure the duration of acquisitions
on the Operating States tab of the Asset Configuration page for the equipment the device is monitoring.
However, devices always log only the final value from single-point channels. Consider the following example
where a device acquires from one waveform channel and one single-point channel for four seconds.
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Channel 2
Temp

Channel 1
Acceleration

Tima (s}

The full, four-second acquisition. The device logs waveform data throughout the acquisition.

The temperature value from the final second. This is the only temperature value the device logs from this
acquisition.

8.3.11.2. MCSA Device Properties

The Device Properties tab contains a table of properties of the device sample rate and the minimum and
maximum current RMS value for the device to calculate all the configured Motor (MCSA) asset features.

The following are built-in properties:

= Sample Rate—Sample rates of 5,000 Hz and 10,000 Hz are supported.

= Minimum Working Current (%FLA)—The minimum current RMS value of a motor for the device to
calculate all the configured features (except Percent Full Load Amps) that belong to the Motor channel,
as a percentage of the motor Full Load Amps. The default is 25%.

= Maximum Working Current (%FLA)—The maximum current RMS value of a motor for the device to
calculate all the configured features (except Percent Full Load Amps) that belong to the Motor channel,
as a percentage of the motor Full Load Amps. The default is 200%.

If the instantaneous current RMS of a motor is below Minimum Working Current or above Maximum
Working Current, the device only calculates the Percent Full Load Amps feature. The Rotor Bar Sideband
feature returns a -100 dB value and other non-calculated features return a zero value.
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8.3.12. Resetting a Device to Factory Settings

Reset a device to its original application image.

1. Click the Configuration pull-down ( #") and select Devices.
2. Select the Software tab.

3. Select adevice.

4. Selectthe Actionmenu ( = ) and select Reset to Factory Default.

8.4. Modifying an Asset Type

Modify properties, default feature sets, default trend alarm rules, data validation, and default fault
frequency sets for all assets of a specific type.

1. Click the Configuration button ( ~ ") and ensure that you are on the Asset Configuration page.

=

2. Click the Action menu ( — ) and select Edit Asset Definitions.
Select the asset type that you would like to edit.
4. Select the tab within the asset type editor in which you would like to make changes.
o = The web application will automatically save and apply edits you make to the

properties or data validation tabs to all existing and future assets of this type in
your asset tree.

= You need to select and toggle to default new or existing features to apply them to
existing and future assets.

8.4.1. Editing the Behavior of an Asset Type

Edit how an asset type behaves in the web application.

1. Click Configuration ( - ) to navigate to the Asset Configuration page.

2. Click the Action menu ( — ) and select Edit Asset Definitions.
= Enable operating state, speed reference, and streaming capabilities for an asset type.

= Click the Edit button in the Capabilities field to see the configuration options for whatever
capabilities are available for an asset type.

» Define categories to describe an asset type.
= Click the Edit button in the Categories field to display the Select Categories dialog box.

= Add, remove, and reorder categories to describe the asset type.
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The categories assigned to a definition determine which capabilities are available
for that asset type.

» Define the kind of measurement you want the asset type to perform.

= Place a checkmark in the Waveform or Single Point checkbox to indicate how you want the
asset type to acquire data.

= Use the Measurement Type listbox to specify the kind of measurement you want the asset type
to perform.

Note the kinds of measurements an asset of any type can perform are limited by the
kind of channel to which the asset is assigned.

» Add, remove, or edit asset types derived from a source asset type.
= Use the Local Definition Types section to specify the asset types you want to be derived from

the source and how many instances of the derived asset type a user can create.

o Only asset types with Local Scope enabled appear in the Type listbox.

= Define a scheme for automatically creating unique names for derived assets when a user adds
them on the Asset Configuration page.

= In the Name Format field, enter a name that describes the asset type and include the variable
{0} somewhere in the name.

When a user adds an asset of this type, the web application automatically replaces

o {03} with the name of the source asset type. For example, if a user adds an asset
type with a name format of {0} Double Integrated as a derived asset on an asset
named Main Accelerometer, the web application automatically generates the
name Main Accelerometer Double Integrated.

» Specify what label the web application displays for the derived asset type.
= Enter avalue in the Label that describes the derived asset type and differentiates it from other
derived assets.

This is the label that appears on the Properties tab of any instance of the source
asset on the Asset Configuration page next to the button for adding or removing
the derived asset.

8.5. Collecting Data

Update data collection configurations for assets according to your condition monitoring needs.

Description
Configuring Data Collection for Wireless Select the endpoint type, set the sample rate,
Equipment (page 103) acquisition length, collection time(s), gate source, and

sensors associated with the device.
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Task Description

Configuring Collection Conditions for Thermal Imaging Specify how often the device collects data, a delta EU
Devices (page 104) trigger, or an advanced collection condition.
Deactivating Sensors (page 104) Shut off data collection for sensors.

Disabling Assets (page 105) Shut off data collection for an asset and all child assets.

8.5.1. Configuring Data Collection for Wireless Equipment

Configure data collection behaviors for your wirelessly monitored asset.

—_

Click Configuration > Assets.

2. Selectawirelessly monitored equipment asset with a vibration monitor. If a vibration monitor is not
previously configured, follow the steps to add equipment assets and to add monitors (page 26).
3. Select the Vibration tab.
4. Select the endpoint type Wireless (NI) in the Monitor tab using the Type pull-down.
5. Configure Sample Rate and Acquisition Length using the text fields in the Collection tab.
These settings may affect the wireless gateway device's data acquisition and
battery life performance.
6. Use the Collect At pull-down to define the time(s) you want your device to collect data.
7. (Optional) To change the gate source, click the Edit button near Gate and click the Edit button within

the Select Gate Source dialog box.

You can only select the features for each sensor asset within the wirelessly
monitored equipment.

8. (Optional) Use the Compare To spin box to configure a feature value, then click OK.

o If the feature data falls below the Compare To value, no data will be collected.

9. Choose when and how often to retry the acquisition if the gate condition is not met.

10. Under the Sensors tab, click the pencil icon to map sensors associated with the equipment you want
to monitor. Select the wireless device and click OK.

11. Configure wireless device endpoints in the Sensor tab by expanding the Endpoints Add pull-down
and select Discover.

Sensors are automatically added when they're created. If a sensor is not listed, you
can manually add them.

12. Map sensors by clicking “Click to map sensor” in the Channel tab and select the sensor channel for
the particular endpoint.
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8.5.2. Configuring Collection Conditions for Thermal Imaging Devices

Collection conditions are evaluated on the thermal imaging device to determine when to send data sets
and trend points to the server.

Complete the following steps to specify when a device collects camera data.

1. Click Configuration ( & ) and ensure you are on the Asset Configuration page.

2. Select athermal equipment asset with an IR monitor. If an IR monitor is not previously configured,
follow the steps of adding equipment assets and adding monitors.

3. SelecttheRtab.
4. Select the camera type in the Monitor tab using the Type pull-down.

Add thermal imaging sensors for the camera asset by clicking Add, expand Thermal Imaging, and
select the camera sensor.

6. Inthe Sensors tab, click the pencil icon in the Device section.

7. With the equipment asset (Thermal imaging), Camera (Optris or FLIR), and sensor (e.g., ROI, ROI
Delta), the camera should be displayed within the equipment asset Sensors tab within the IR tab.

8. ROls are managed within Properties tab of the camera asset. Select Manage ROls in the ROIs
section.

9. Select a camera from the list in the Cameras dialog box and select Data Collection (within the
Operating States tab).

10. Configure the Time, Delta EU, and/or Advanced conditions as needed.

After you configure the device, cameras, ROIls, and collection conditions, you must

o notify the device that the configuration has been changed. Select the device from
the list of devices on the Devices tab of the Device Configuration page and click
Update Configuration.

8.5.3. Deactivating a Sensor

Shut off sensor data collection to minimize the collection of erroneous data due to a faulty sensor.

1. Click Configuration ( - ).
2. Locate the sensor you need to deactivate.

3. Right-click the sensor and select Deactivate.

A notification pops up and the sensor should have a red marking to indicate when you successfully
deactivate a sensor.

4. Repeat steps 2 and 3 as needed.
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8.5.4. Disabling Assets

Shut off data collection for assets (including child assets and sensors) to minimize the collection of
erroneous data.

1. Click Configuration ( & ).
Locate the asset you need to disable.

3. Right-click the asset and select Disable.

A notification pops up and the asset should have a red marking to indicate when you successfully
disable an asset.

Child assets or sensors of the disabled asset also do not collect data though they
are unmarked.

4. Repeat steps 2 and 3 as needed.

8.6. Adding Bearings or Fault Frequency Groups to an Asset

Configure the web application to note known frequencies that are problematic on the Asset
Configuration page.

1. Click Configuration ( £ ") and ensure you are on the Asset Configuration page.

2. Right-click on an asset and select Add fault frequencies to add the Fault Frequencies tab to your
asset's configuration panel.

3. Click Add in the Bearings section.

Select a bearing from the database. 1. Find and select the bearing you want to add.
2. Click OK.

Create a new bearing. =
9 Click the Action menu ( = ) and select Create.

—_

2. Provide a unique name to the bearing.

3. Provide values for FTF, BSF, BPFO, and BPFI.
4. Click OK.

5. Find and select the bearing you created.

6. Click OK.

4. Create fault frequency groups to define a set of fault frequencies to refer to by name.

*  Click Add in the Fault Frequency Groups section.
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Select a fault frequency group from the 1. Find and select the fault frequency group you want to
database. add.
2. Click OK.
No fault frequencies will be
found the first time you add
a fault frequency group.
Create a new fault frequency group. ) ) =
1. Click the Action menu ( — ) and select Create.
2. Provide a unique name to the fault frequency group.
3. Click Add.
4. Provide a unique name for the fault frequency.
5.  Select the type of frequency.
6. Designate what level the frequency is.
7. Click OK.
8. Repeat steps 3-7 to add new fault frequencies as
needed.
9. Click OK.
10. Select the fault frequency group you created and click
OK.

8.7. Assigning Features to Sensors

Specify what features you want an asset to calculate.

1. Click Configuration ( £ ') and select a sensor-level asset.
2. Click the Features tab in the asset's configuration panel.

o This tab is available only on sensors that produce data sets.

Click Add.
Select one or more features in the Add Features dialog box and click OK.

Define what feature property is calculated for an asset by selecting a feature.

o Not all features have properties to edit.

Click Edit to display the Properties dialog box for that particular feature.

Configure any properties you want to and click Close.

If you do not see the feature you want to add, you may need to add the feature on
the Asset Definition (page 108) page.
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8.7.1. Defining Feature Options for Sensors

Define which features are appropriate and available by creating a default set of features for the server to
automatically assign to each sensor type.

Complete the following steps to review the predefined sets of features in the web application and to make
changes at the system or asset level.

o You can also manually assign additional features that are not part of a sensor's set of
features.

1. Click Configuration ( - ) and ensure you are on the Asset Configuration page.

2. Click the Action menu ( = ) and select Edit Asset Definitions.
Select the sensor for which you want to add a feature.

4. Click the Features tab in the definition panel.

Some items in the features list have Yes in the Default column to indicate the items

o are predefined features. Features can have their default setting toggled to Yes so
that all new sensors will have that feature. Removing the toggled default setting
does not remove features from existing sensors.

5. Click the Add button and a dialog box will prompt you to select from additional features you can
assign to the asset definition.

o If the dialog box is empty, no additional features are available.

6. Select one or more features to add to an asset definition and click OK.

To push the added feature to future instances of this sensor type, highlight the feature list and click
the Toggle Default button.

8. Add to the features available in the system.

Click the Navigation menu.

a

b. Hover over System and select Features.

c. Click Add and hover over or select the type of feature you would like to add to the system.
d

Enter a name and parameters for a new feature in the resulting dialog box and click OK.

o Any features you add to the system will be identifiable by the user glyph.

8.8. Batch Editing Assets

InsightCM allows users to edit multiple assets at one time using an exported spreadsheet.
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Complete the following steps to update an exported asset spreadsheet and apply the changes to the
asset tree in the web application:

1. Inthe navigation bar at the top of the page, click Configuration ( s ') to navigate to the Asset
Configuration page.

2. Clickthe Action menu ( — ) and select Import/Export » Export Asset Spreadsheet. You can choose
to export the entire asset tree or only the section you have selected.

Navigate to the exported spreadsheet on your computer and open it.
4. Fill out the relevant sections (page 108) in the spreadsheet.

Save the file after you have finished making changes.

—

6. Backonthe Asset Configuration page, click the Action menu (
Asset Spreadsheet to display the Import Asset dialog box.

) and select Import/Export » Import

7. Click the Browse button () to select the exported spreadsheet from your computer and apply your
changes to the asset tree.

8.8.1. Asset Definition Spreadsheets

InsightCM allows users to edit multiple assets at one time using an exported spreadsheet.

4 : ; c

FullName PropertyName PropertyValue

NI|Austin | Mopac C|Central Plant| CWP P-1| Chilled Water Pump P-1 NominalSpeed "175

NI|Austin| Mopac C|Central Plant| CWP P-1]| Chilled Water Pump P-1 Smpld NI| Austin| Mopac C|Central Plant| CWP P-1
NI|Austin | Mopac C| Central Plant] CWP P-1| Chilled Water Pump P-1 SmpKey Pump

NI| Austin | Mopac C| Central Plant| CWP P-2| Chilled Water Pump P-2 NominalSpeed M175

NI|Austin | Mopac C| Central Plant| CWP P-2 | Chilled Water Pump P-2 Smpld NI|Austin| Mopac C| Central Plant| CWP P-2

AssetNodeProperties

Asset spreadsheets contain the following tabs with their respective columns:

= AssetNodes—The settings that determine the functionality of an asset.

= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]Accelerometer

= Type—The name of the asset type, such as Accelerometer, Tachometer, or true.

= Disabled—Disables the asset if set to true.

» MeasType—Indicates whether the asset acquires data as a waveform or a single point and what type
of measurement you want the asset to perform. For example,
Waveform| Tachometer

= Categories—Categories that describe the asset type and determine what capabilities are available
for the asset type, such as Dynamic, RotatingEquipment, or Accelerometer.
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= AssetNodeProperties—The properties that are available for an asset.
= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]Accelerometer
= PropertyName—The name that the InsightCM web application displays for the property.

= PropertyValue—The value you want the InsightCM web application to set for the property when you
import the spreadsheet.

= OperatingStates—The operating states that are available for an asset.
= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]|Accelerometer
= Name—The name of the operating state that the InsightCM web application displays.

= OperatingStateProperties—The properties an operating state has when it is assigned to a specific
asset.

= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]|Accelerometer

= OperatingState—The operating state to which the property defined in this row applies.

= PropertyName—The name of the property that the InsightCM web application displays.

» PropertyValue—The value you want the InsightCM web application to set for the property when you
import the spreadsheet.

= Triggers—The triggers that are available on an operating state assigned to a specific asset.
= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]|Accelerometer
= OperatingState—The name of the operating state to which the property applies.

= Type—The kind of trigger you want to configure. For example,

EnterTrigger
= Expression—The expression or combination of expressions required to activate the trigger.

= TriggerConditions—The trigger conditions that are available for each trigger on an operating state
assigned to a specific asset.

= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]Accelerometer

= OperatingState—The name of the operating state to which the trigger condition applies.

= TriggerType—Which trigger the condition applies to.
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Type—Specifies whether the trigger is time-based, such as- Cron, Timespan, or Trend.
Source—The feature that determines a feature-based trigger.

Operator—How the InsightCM web application compares the trend value to the compare value (For
example, Greater thanor Equal to).

CompareTo—The value that the InsightCM web application compares the trend value to.

DwellSeconds—How long the trigger condition must be true before the InsightCM web applications
activates the trigger.

= Features—The features that are available for an asset.

FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,

Location]Equipment]|Accelerometer

Feature—The name of the feature that the InsightCM web application displays.

= FeatureProperties—The properties a feature has when assigned to a specific asset.

FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,

Location]Equipment]|Accelerometer

Feature—The name of the feature to which the property applies.

PropertyName—The name of the property that the InsightCM web application displays.

PropertyValue—The value you want the InsightCM web application to set for the property when you
import the spreadsheet.

= TrendAlarmRules—Alarm rules for features assigned to a specific asset.

Document #:

FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,

Location]Equipment]Accelerometer

Id—The string that other sections of the spreadsheet use to reference the alarm rule.
TrendName—The name of the feature to which the alarm rule applies.

Operator—How the InsightCM web application compares the trend value to the compare value. For
example, Greater thanorEqual to.

OperatingState—The operating state or states to which the alarm rule applies.

Hysteresis—An offset from the set point whose value causes InsightCM Server to clear the alarm
when crossed.

OnDelaySeconds—The amount of time, in seconds, the set point must remain crossed before
InsightCM Server sets the alarm.

OffDelaySeconds—The amount of time, in seconds, the hysteresis level must remain crossed before
InsightCM Server clears the alarm.

AutoConfigCalc—Specifies whether to automatically configure levels from baseline values.

Disabled—Disables the alarm rule when set to true
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TrendAlarmLevels—How alarm levels are calculated for specific alarm rules.

Ruleld—A string that specifies which alarm rule the level applies to.
Severity—The urgency of the level.
CompareTo—The value that the InsightCM web application compares the trend value to.

AutoConfig—Specifies whether to automatically configure levels from baseline values.

AlarmActions—Specifies whether the InsightCM web application takes any action when a specific
alarmis set.

Alarmld—A string that specifies which alarm rule the action applies to.
Severity—The urgency of the alarm level.
ActionName—A name that distinguishes this action from others.

Type—Specifies whether to send an email notification when the alarm is set.

AlarmActionProperties—The action the InsightCM web application takes when a specific alarm is set.

Alarmld—A string that specifies which alarm rule the action applies to.

Severity—The urgency of the alarm level.

ActionName—The name of the action the property applies to.

PropertyName—Specifies whether this property specifies an address group or an email template.

PropertyValue—A string that specifies a particular address group or email template.

SpectralAlarmRules—Spectral alarm rules for features assigned to a specific asset.

FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,

Location]Equipment]Accelerometer

Id—The string that other sections of the spreadsheet use to reference the alarm rule.
OperatingState—The operating state or states to which the alarm rule applies.

Unit—Specifies the units used to measure sensor data on the asset the sensor monitors.
Integration—Specifies the type of integration, if any, to apply to asset data to check for this rule.

Cutoff—Specifies the frequency, in Hz, for the highpass filter when performing double integration on
asset data.

SpectralAlarmLevels—How alarm levels are calculated for specific spectral alarm rules.

Ruleld—A string that specifies which alarm rule the level applies to.
Severity—The urgency of the level.

CompareTo—The value that the InsightCM web application compares the trend value to.

SpectralAlarmActions—Specifies whether the InsightCM web application takes any action when a
specific spectral alarm is set.

Alarmld—A string that specifies which alarm rule the action applies to.
Severity—The urgency of the alarm level.

ActionName—A name that distinguishes this action from others.
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» Type—Specifies whether to send an email notification when the alarm is set.

= SpectralAlarmActionProperties—The action the InsightCM web application takes when a specific
spectral alarm is set.

= Alarmld—A string that specifies which alarm rule the action applies to.

= Severity—The urgency of the alarm level.

= ActionName—The name of the action the property applies to.

» PropertyName—Specifies whether this property specifies an address group or an email template.
= PropertyValue—A string that specifies a particular address group or email template.

= FaultFrequencies—Known frequencies that are problematic for an asset so that the InsightCM web
application notes them on the Data Viewer page.

= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]Accelerometer

= Name—A unique name for the fault frequency.

= Type—Specifies whether the fault level is in orders or frequency.

= Level—The fault level.

= NamedGroups—The name of a group of fault frequencies assigned to an asset.

= FullName—The full path to the asset in the asset tree with each level separated by pipes. For
example,
Location]Equipment]|Accelerometer

= Type—Enter

fault frequencies

as the value for this column.

= Name—A unique name for the fault frequency group.

8.8.2. Batch Updating Device Configurations with a Device Spreadsheet

Edit batch configurations in a device spreadsheet to make updates to multiple devices that you already
configured in the web application.

1. Click Configuration ( £ ") and select Devices.
2. Select the device(s) you want to update.

3. Fromthe Action menu ( = ), hover over Import/Export, select Export Devices Spreadsheet, and then
choose whether to export configurations for devices you selected in step 2 or all devices.

4. The web application downloads a spreadsheet file to your computer. Create a copy of the
downloaded file. If you introduce errors while editing the spreadsheet and then import the errors,
you can then import the copy, which allows you to return device configurations to a working state.
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5. Open the xIsx device spreadsheet file.

configuration properties. The spreadsheet links related properties in separate
worksheets via the names in the spreadsheet. For example, the Channels
worksheet identifies which data group owns the channels by specifying the data
group name as defined on the DataGroups worksheet.

o The spreadsheet contains several worksheets that define different types of device-

6. Edit the properties of interest in the spreadsheet. For example, you might want to change the sample
rate on multiple devices at the same time.

7. Toapply your changes to the device configurations in the web application, return to the Device

)

Configuration page, and select import the device spreadsheet from the Action menu (

8.9. Validating Sensor Data

Ensure that sensors are returning valid data.

Ensure that sensors are returning valid data. Review data validation errors on the Notifications page.

1. Click the Navigation menu (¥) and select System > Asset Definitions.

2. Choose and complete one of the tasks below for an asset type according to how you need your
sensor data validated.

» Enable data validation rule options.
1. Ensure that the Data Validation checkbox is enabled.

= Setarule to check that waveform values are within a specified range.
1. Ensure that the Range Check checkbox is enabled.

2. Use the Maximum EU and Minimum EU fields to specify a range of acceptable values. See
Difference Between Range Check and Input Range (page 114) for more information.

= Set arule to check that consecutive waveform values do not remain the same for more than the
specified number of samples.

1. Ensure that the N Rule checkbox is enabled.

2. Use the Maximum Samples field to specify the maximum number of consecutive samples for
which waveform values can remain the same.

= Set arule to check that consecutive waveform values do not have the same sign for more than a
specified amount of time.

1. Ensure that the Z Rule checkbox is enabled.

2. Use the Maximum Time field to specify the maximum amount of time that consecutive
waveform values can have the same sign.

= Set a rule to ensure that all waveforms have a minimum percentage of unique values.
1. Place a checkmark in the U Rule checkbox.

2. Use the Minimum Percent field to specify the minimum percentage of unique values for a
given waveform.
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Set a rule to check that the ratio of the Peak feature to the Peak-Peak feature is within the range
you specify.

1. Ensure that the Pk/Pk-Pk checkbox is enabled.

2. Use the Minimum Ratio and Maximum Ratio fields to specify a range of acceptable peak ratio
values.

Set arule to check for a suspect amount of energy at line frequency.
1. Place a checkmarkin the Line Noise checkbox.

2. Use the Line Frequency field to specify the line frequency.

The InsightCM Server does not apply this rule if the running speed is within
20% of the specified line frequency.

Set a rule to check for waveforms with low RMS levels.
1. Ensure that the Low Signal checkbox is enabled.

2. Use the Maximum RMS field to specify the highest acceptable RMS value.

Set a rule to check for too much low frequency energy.

1. Ensure that the Ski Slope checkbox is enabled.

8.9.1. Difference Between Range Check and Input Range

The Range Check: Minimum and Range Check: Maximum properties are the minimum and maximum
values you expect to measure after any scaling. These values are sometimes confused with the Input
Range property. Input Range refers only to the input range of a particular device, in the pre-scaled

units the device measures. For example, the Input Range for a module might be O to 10V, but that
module might be used with a temperature sensor that outputs 100 mV for every 1 °C. The Range Check:
Minimum and Range Check: Maximum in that case could be O to 100 V, with 10 V corresponding to 100
°C.

In this example, you could set the Custom Scale: Slope property to 0.01 to implement the conversion
from V to °C.

8.9.2. Audit Logger Tab on System Page
The server logs errors and certain events, such as when services start and when an asset is updated.

Ensure that you are on the Audit Logger tab of the System page by clicking the Navigation menu,
hovering over Utilities, and selecting Audit Logger.

By default, only the last 30 days of events are retained on the server. You may filter the data events by
clicking the Filter By... button, or by clicking header of each column to automatically filter in ascending
order.
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9. Viewing Data

Access collected data in InsightCM™ and use different chart viewers for closer analysis of outlying
measurements.

Viewing Trend Data (page 115)-View trend data for the features calculated on the device.

Watching a Live Stream (page 120)-View streams from all equipment or from one equipment as
streams begin.

Loading Historical Streams (page 121)-Load streams that are stored in the server and view them on
the Data Viewer page.

Deleting Data (page 137)-Delete data you no longer need but that the server retained to conserve
space and memory.

Creating a Trend Baseline (page 140)-Trend baselines determine the values that InsightCM uses to
create trend alarms.

Viewing Historical Data (page 141)-Analyze historical periodic data by loading a feature in the Trend
viewer and then loading the data set in a waveform, spectrum, or other sensor data viewer.

Comparing Measurements from Different Sources or Times (page 143)-Compare measurements from
multiple points in time or from multiple pieces of equipment by creating data event references that you
can show in a chart later.

9.1. Viewing Trend Data

View trend data for the features calculated on the device.

Ensure that you have collected data from your equipment.

Document #:

Click the Data Viewer ( s ) button in the navigation bar,
In the asset tree, locate one of the sensors you added to monitor your equipment and expand it.

The asset tree should now contain features nested under each sensor.

Click a feature in the asset tree. The trend viewer in the top window populates with trend data for that
feature.

Click the Annotate Data Sets button in the Trend Chart and double-click above or below a data set.

The other two viewer charts will automatically populate waveform and spectrum data.
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9.2. Parts of the Data Viewer

The Data Viewer page is a customizable environment with components that provide access to data and
a workspace that contains charts, or viewers. You can add and remove different viewers, load historical or
live data, and use various tools to examine features of interest in more detail.

The following image is an example of the Data Viewer page.
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@ Data Viewer Toolbar

@ Asset tree

@ Trend viewer

@ Metadata pane

@ Viewers with sensor data

9.2.1. Operating Modes
The Data Viewer page has two operating modes designed for viewing specific types of data:

= Periodic Data—Data trends over a customizable time range.

= Stream Data—Live or historian data acquired continuously during an operating state, such as run-up
or coast-down. The time range for which you can access data is restricted to the duration of the
operating state.

To provide a starting point for your analysis tasks, both modes have a default layout of viewers and a
customized toolbar for working in that mode.

9.2.2. Switching between Periodic and Stream Data Modes
To load stream data or subscribe to a stream, view the Data Viewer page in Stream Data mode.

When the Data Viewer page is in Stream Data mode, switch to Periodic Data mode by clicking the Switch
to periodic view button on the Data Viewer page toolbar.

9.2.3. Auto-refresh

~
Viewing auto-refresh can be configured by clicking on the auto-refresh icon (%=
are Off, 30 seconds, 1 minute, 5 minutes, and 10 minutes.

). Auto-refresh options

9.2.4. Multiple Trend Viewer Cursors

Multiple cursors allow viewing waveform data from two or more locations on the trend value timeline (e.g.,
10 a.m. and 1:00 p.m. on a particular day or different days).

The following steps describe the actions to create multiple cursors:

1.  The first cursor can be created by double clicking in the trend viewer chart or by clicking on the
cursor selector in the trend viewer and selecting Add Cursor.

Note: Clicking on the double vertical lines will show or hide the cursor.

2. Within the cursor menu click its Action menu and select Add Cursor. Repeat step to create additional
Cursors.
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3. Each cursoris listed with a timestamp and description. The active cursor is indicated by a solid red
circle. Double clicking in the trend viewer will move the active cursor. Click on any other non-solid red
circle to make that cursor the active cursor.

9.3. Streams of Data

Cutsforth monitoring devices, such as Condition Monitoring Systems (CMS), are designed to detect
when a piece of equipment enters a particular state of behavior, and then collect and group a series of
data files until the equipment reaches a steady state. For example, a device detects that a turbine begins
a run-up when the speed measured by a tachometer increases to above 200 RPM; it then enters an
operating state in which it collects and groups files. When devices group files in this way, the resulting
files are referred to as a stream. The Data Viewer page provides several features for displaying data that
has been acquired as part of a stream.

9.3.1. Introduction to Streams

A stream is a single entity that combines many measurements from one device for the purpose of
visualizing the data as a group. This is useful because by interacting with a single stream, you can
quickly view all data the device acquired when the equipment was experiencing the behavior of interest.
In the case of run-ups and coast-downs, where speed measurements cause a data group to enter a
stream-enabled operating state, a stream contains the trend of speed measurements throughout the
run-up or coast-down, as well as data from each sensor in the data group.

9.3.2. How Streams Work

The following steps describe the actions that occur during a stream-enabled operating state to produce
a stream:

1. Adevice detects when a speed condition is met and starts collecting files. For example, a device
detects a run-up when the speed increases to above 200 RPM,; it then starts a cycle of collecting ten
seconds of data, waiting for fifteen seconds, and then repeating.

Users configure stream settings on a per-equipment basis on the Properties tab of
the Asset Configuration page.

Streams can only be triggered on the Speed Feature of an Asset.

2. InsightCM Server receives data from the device and makes the data available for viewing on the Data
Viewer page.

On the Data Viewer page, you can subscribe to the stream to update viewers with
live data. See Watching a Live Stream (page 120).

3. The device detects the stop condition that indicates the equipment reached a steady state, and then
stops performing stream acquisitions.

4. Onthe Data Viewer page, you can load the stream of data that the server created.

The following illustration shows the role of each component.
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9.3.3. Run-Up Example

The following workspace shows the Data Viewer page with a run-up stream loaded. Notice the following
characteristics:

= The workspace is in continuous-data mode.

= The Trend Viewer contains a single trend of speed values from the tachometer whose measurements
indicate a run-up and trigger stream acquisitions.

= The Trend Viewer time axis is restricted to the duration of the run-up. In other words, you cannot adjust
the time range to show other historical measurements that occurred before or after the run-up.

= Other viewers contain measurements from several different sensors.

= If you place a cursor in the Trend Viewer and move it with the arrow keys, the data in the other viewers
will update to match the timestamp of the Trend Viewer.
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9.3.4. Behavior when Devices Monitor Multiple Pieces of Equipment or Multiple
Devices Monitor the Same Equipment

Streams consist of all the data that sensors on a specific data group acquire. A data group is a set

of channels mapped to sensors that monitor the same piece of equipment. Data groups are useful in
situations where a single device connects to sensors on multiple pieces of equipment whose data you
want to acquire according to different parameters.

If a device monitors two pieces of equipment, each with unique operating behaviors, ensure the pieces of
equipment belong to separate data groups. Otherwise, if the data group experiences an enter condition
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that is relevant for only one piece of equipment, the device includes data from the second piece of
equipment as part of the stream.

9.3.5. Streams versus Periodic Acquisitions

Data streams are similar to periodic acquisitions in the following ways.

= The InsightCM Server stores both types of data.

= The Trend Viewer displays values from both types of acquisitions.

Streams differ from periodic acquisitions in the following ways:

Users can configure a device to continuously collect files at intervals of only a few minutes or delta

EUs when it enters a stream-enabled operating state. However, periodic acquisitions might occur much
less frequently, such as only when a time interval elapses or a delta EU or alarm condition evaluates
true.

Separate aging rules apply to stream and periodic data files.

9.4. Watching a Live Stream

View streams from all equipment or from one equipment as streams begin.

When a stream-enabled operating state is in progress, data viewers can display live trends and
measurements as devices acquire data from equipment. Choose one of the following ways to begin
viewing a stream.

Document #:

Click the Data Viewer ( s ) button.
Determine how you want to view a stream.

» See when any of the equipment you have configured on the Asset Configuration page starts a
stream.

1. Above the asset treg, click the Load Stream button.
2. Inthe Load Stream dialog, click Available Streams.
3. Selectanitem to start updating viewers with data acquired from the equipment.

= To view a stream from a particular equipment asset, complete the following steps.

1. Click the Subscribe to Stream () button to allow all viewers to update with live data.

If necessary, the Data Viewer page automatically switches to Stream Data
o mode So you can access viewers and other features that are useful for
analyzing stream data. When a stream begins, the viewers automatically
begin updating with data. If a stream is not in progress, the viewers remain
empty. The Subscribe to Stream button is disabled until you select a piece of
equipment with a stream-enabled operating state in the asset tree.
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9.5. Loading Historical Streams

Load streams that are stored in the server and view them on the Data Viewer page.

In Stream Data mode, you can load streams of data that occurred in the past and are stored in InsightCM.
Complete the following steps to load a previously acquired stream.

1. Click the Data Viewer ( e ) button.

2. Click Load Stream (E"'-h'l) to view a list of previously recorded streams for each piece of equipment in
the asset tree.

Select a piece of equipment from the tree on the left to load available streams for that equipment.
4. Inthe list of streams that populates on the right side of the dialog box, select the stream of interest
and click OK.

If necessary, the Data Viewer page automatically switches to Stream Data mode

o SO you can access viewers and other features that are useful for analyzing stream
data. When a stream begins, the viewers automatically begin updating with data. If
a stream is not in progress, the viewers remain empty. The Subscribe to Stream
button is disabled until you select a piece of equipment with a stream-enabled
operating state in the asset tree.

When you load a stream, you can perform the same tasks you use to analyze data in periodic data
mode.

5. Move the cursor through the Trend Viewer point by point. By default, the Trend Viewer loads the
speed feature from the tachometer that detected the stream-enabled operating state.

6. Watch the timestamp and cursor value update in the metadata pane.

7. Analyze data from all supported sensors in various viewers, even if the sensors are not loaded in the
Trend Viewer.

o You cannot load trends from assets that are not part of the stream.

The time range in viewers is restricted to the duration of the stream you load, so you
cannot see additional data even from equipment that is part of the stream.

9.6. Data Packages

1. Collect some data, including waveforms (any monitor type: vibration, wireless, ESA, etc.)
2. Inthe data viewer, select a feature and zoom the trend to a time span you want to export.

3. Inthe trend menu, click Export Data Package. In the export dialog, select a monitor and provide a
name and a description. Click Export. The data package file (icmdp.zip) will download.

Optional: switch to a different ICM server (same version).
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9.7.

4. Clear the data viewer. In the data viewer toolbar (@above the asset tree), click the Import and view data
packages button. In the dialog, click Import and select your data package. Import the package. The
package name description and timestamps show up in the packages dialog.

5. Select the import data package and click View in Data Viewer. The data package tree is loaded below
the regular asset tree. All sensors from exported equipment/monitor are available.

6. Select features from data package sensors to trend data. The trend time range is the same as what
was exported.

7. Double click on trend to load waveforms. Try using different chart types specific to the data you
exported.

Open the data packages dialog. Select your data package and click Delete.

To delete a data package, open the data packages dialog, select a data package, and click Delete.
The package is removed from the data packages grid.

Viewers

Viewers contain charts in which you analyze data from sensors as well as trends in features calculated
from sensor data.

For example, Waveform is sensor data of acceleration values from an accelerometer, and the RMS value
is a feature for which you can calculate trends from the waveform. The workspace provides viewers for
both waveform and trend data.

= Trend viewer—Displays trends in features over time. The workspace always contains a single Trend
viewer in the top row.

= Sensor data viewers—Display raw sensor data as waveforms, spectrums, orbits, and other sensor data
types. The workspace can contain as many or as few sensor data viewers as you want.

Relationship Between Feature Trends and Sensor Data

The peak may not be a point represented on the graph because it may fall between two
recorded points.

The callout numbers on the following workspace show the relationship between sensor data and trends.
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@ Feature trend values—Represent the feature values from acquisitions over time.
@ Cursor within trend curve—Controls which data set appears in sensor data viewers.
@ Sensor data—Represents the data set where the Trend viewer cursor lies.

9.7.1. Adding Harmonic and Sideband Cursors to Viewers
Ensure you are on the Data Viewer page by clicking the Data Viewer button.

You can enable harmonic or sideband cursor indicators in spectrum viewers. Harmonic and sideband
cursors are particularly useful in analyzing and diagnosing spectrums.

To add harmonic or sideband cursors to a viewer, click the Cursor button on the viewer toolbar and select
Harmonic or Sideband, then click the point on the chart where you want to place the cursor.

You can reposition the cursors by double-clicking another point on the chart, or by single-clicking the
sideband or harmonic you want to select.
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The pull-down menu for the Cursor button ( " ) on the viewer toolbar contains the following options.

1. Normal—Displays only the fundamental cursor in the viewer.

2. Harmonic—Displays cursors to the right of the fundamental cursor at fixed intervals that are integer
multiples of the x-axis value of the fundamental cursor. For example, when the fundamental cursor is
at 100 Hz, the first harmonic cursor will be at 200 Hz, the second at 300 Hz, the third at 400 Hz, and
S0 on.

3. Sideband—Displays cursors at fixed intervals on the left and on the right side of the fundamental
cursor.

4. Change the number of harmonic and sideband cursors.

a. To change the number of cursor lines that display when you enable the harmonic or sideband
cursor, click the Settings button on one of the viewer toolbars and select Viewer Settings .

b.  Specify the numbers you want in the resulting dialog box.
c. Click OK.

9.7.2. Adding, Changing, and Removing Viewers
Customize the workspace by adding, removing, or changing the types of viewers in the workspace.

If you create a layout you want to reuse, you can save that layout and restore it later. When you exit the
Data Viewer page or switch modes, the workspace does not preserve your changes to the layout unless
you save the layout.

Complete the following steps to add a new viewer to the workspace.

Click the Data Viewer ( ¥* ) button.
Click the Layout menu in the top right-hand corner of the Data workspace.

Click New Row to add an empty row to the bottom of the workspace.

A w -

Click Add Chart and choose which row you want to add your viewer to. The Data Viewer page adds
an empty area at the row you selected. The Trend viewer is always the left-most viewer in the top row.

5. Change the type and size of a viewer.
= Viewer Type—Click the Layout menu in the toolbar for any viewer except the Trend viewer and
select Chart type > Type.

o You cannot change the Trend viewer to a different viewer type.

» Size—Hover over and drag the separating bars around any area, including the asset tree and
properties pane.

6. Remove rows and charts.

» To remove any viewer except the Trend viewer, click the Layout menu on the viewer toolbar and
select Remove this chart.
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= To remove an entire row of viewers, click the Layout menu on a viewer toolbar and select Remove
entire row.

o The Trend viewer is always visible, and you cannot remove it from the workspace.

9.7.3. Stacking Charts in the Same Viewer
Stack multiple charts in the same viewer.

Some viewers can display plots in separate, stacked charts within the same viewer. Complete the
following steps to stack multiple charts in the same viewer.

1. Click the Data Viewer ( e ) button.

2. Inthe asset tree, <Ctrl-click> or <Shift-click> multiple features to load them in the viewers.

()
Click the Stacked Charts (%) button on the viewer toolbar.

4. (Optional) Click the Normalize Y-Axis Scales button on the viewer toolbar to give each separate chart
the same y-axis values.

9.7.4. Madifying Default Units and Scaling for Data

1. Click the Navigation menu (™) and select Options.

2. Intheresulting dialog box, select Units and Scaling under the Data Viewer section in the navigation
pane.

3. You can do the following.
= Change the units to integrate and differentiate.
» Specify the default value for Single Integration Cutoff and Double Integration Cutoff.

» Change the acceleration, velocity, and displacement scaling for Spectrum, Full Spectrum, and
Waterfall viewers.

9.7.5. Viewer Types

The following table lists the types of viewers you can add to the Data Viewer workspace, the sensors they
support, and requirements for configuring the assets to which the sensors are mapped.

Use Case How to Use Supported
Sensors
Auto- Display the measure of Move the cursor along a trend curve Vibration sensors
Correlated how similar a spectrum to update this viewer with the spectrum that acquire
Spectrum signalis to itself with a measurement at different times. waveform data,
time lag. Find repeating such as
patterns in the signal. acceleration.
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Viewer Use Case How to Use Supported
Sensors
Auto- Display the measure of Move the cursor along a trend curve Vibration sensors
Correlated how similar a waveform to update this viewer so it displays the that acquire
Waveform signalis to itself with a measurement at different times. waveform data,
time lag. Find repeating such as
patterns in the signal. acceleration.
Bode' Contains two charts The data group to which these sensors Sensors with
that display the phase are assigned must specify a tachometer as both 1x Phase
measurement and the the speed reference. Configure the Speed and 1x Magnitude
amplitude response. Reference for the asset on the Properties or 2x Phase and
tab of the Asset Configuration page. 2x Magnitude
features.
EMSA EMSA Spectrum Set the cursor on a data set on the Trend High frequency
Spectrum viewers display the Viewer to view the frequency spectrum. current
frequency spectrum transformer
measured by an HFCT. (HFCT).
EMSA The EMSA Waterfall Set the cursor a data set on the Trend High frequency
Waterfall viewer simultaneously Viewer to view the spectra of successive current
displays the EMSA sensor measurements. transformer
spectra of successive (HFCT).
measurements from a
sensor. Shows how
spectral data changes
over time.
Envelope The Envelope Spectrum Use this viewer with the Envelope Vibration sensors
Spectrum viewer displays the Waveform viewer to detect ringing that acquire
power spectrum of impulses, such as bearing defects. waveform data,
the envelope waveform such as
data. acceleration.
Envelope The Envelope Waveform Use this viewer with the Envelope Spectrum Vibration sensors
Waveform viewer displays the viewer to detect ringing impulses, such as that acquire
amplitude demodulated bearing defects. waveform data,
signal from sensor data. such as
acceleration.
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Viewer

Full Spectrum

Use Case

The Full Spectrum
viewer displays a
spectrum of an orbit. A
full spectrum takes two
separate sets of sensor
data from orthogonal
probes, and transforms
the two spectrums

to create the full
spectrum. The positive
frequencies indicate
forward precession,
where the direction of
shaft orbit is the same
as the direction of shaft
rotation. The negative
frequencies indicate
reverse precession,
where the direction

of shaft orbitis the
opposite direction of
shaft rotation.

How to Use

Configure the following settings on the
asset's Propertiestab:

= Specify the name of the other sensor for
the Pair Sensor property of each sensor.

= Assign the sensors to a data group with a
tachometer as the speed reference.®

InsightCM 3.11.1
USER MANUAL

Supported
Sensors

Pairs of
displacement
sensors that
acquire
waveforms from
orthogonal
probes. 2

component magnitude value.

The following
parameters in the ESA
Spectrum viewer have
fixed values:

= frequency range: 0 to
310 Hz

= frequency resolution:
0.016667 Hz

= lines of resolution:
18,600

ESA Envelope This viewer displays Motor current

Spectrum the spectrum of the sensors that ESA
envelope waveform devices support.
data and finds smaller
signals, such as pole
pass, mechanical speed,
and fault frequencies.

ESA Spectrum ESA Spectrum viewers The spectrum resolution of the ESA Motor current
display a high-resolution Spectrum viewer is higher than that of the sensors that
spectrum of the motor Spectrum viewer. The spectrum based on Electrical
current magnitude for the motor current magnitude is in decibels. Signature
motor analysis. The decibel reference is the fundamental Analysis (ESA)

devices support.
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Viewer Use Case How to Use Supported
Sensors
ESA Torque This viewer displays the The accuracy of the calculated torque Virtual motor
Waveform calculated time-domain waveform may be affected if the motor sensors that
torque waveform of Stator Resistance is configured improperly. Electrical
the motor output for Signature
analysis. The duration Analysis (ESA)
of the ESA torque devices support.
waveform is shorter
than the voltage and
current waveforms due
to internal processing
delay.
Orbit The Orbit viewer When you turn on integration, the viewer Pairs of
displays the actual shaft populates the orbit using integrated time- displacement
centerline movement domain data. Configure these settings on sensors that
inside the bearing the asset's Properties tab: acquire
housing. waveforms from
= For the Pair Sensor property of each orthogonal
sensor, specify the name of the other probes. 2
sensor.
= Assign sensors to a data group with a
tachometer as the speed reference?®.
Order The Order Spectrum Use this viewer with the Order Waveform Vibration sensors
Spectrum viewer displays the viewer to see data when the equipment that acquire
power spectrum of the speed is changing or when comparing waveform data,
order waveform data. data acquired at different machine speeds. such as
Assign the sensors to a data group with a acceleration.
tachometer as the speed reference.
Order Displays the waveform Use this viewer with the Order Spectrum Vibration sensors
Waveform data re-sampled to a viewer to see data when the equipment that acquire
constant number of speed is changing or when comparing waveform data,
samples per revolution. data acquired at different machine speeds. such as
Assign the sensors to a data group with a acceleration.
tachometer as the speed reference.
Park Clarke The Enhanced Park Move the cursor along a trend curve Virtual motor
Vector algorithm is used to update this viewer so it displays the sensors that
to create a DQ Plot measurement at different times. Electrical
where circularity and Signature
thickness of the plot Analysis (ESA)
indicate potential stator devices support.
electrical imbalance
issues.
Phasor Displays the voltage and Phasors with angles from -180 degrees Motor current
Diagram current phasors relative to O degrees lag the reference, while sensors that
to phase A voltage. phasors with angles from 0 degrees to Electrical
+180 degrees lead the reference. Signature
Analysis (ESA)
devices support.
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Viewer Use Case How to Use Supported
Sensors
Polar’ Display data in polar The polar plot zero degree point is Sensors with
coordinates and see always located at the angular position both 1x Phase
phase changes in the of a transducer. Compare data from and 1x Magnitude
range of zero to 360 orthogonally-mounted displacement probe or 2x Phase and
degrees. pairs with a polar plot. The data group 2x Magnitude
must specify a tachometer as the features.
speed reference. You can configure the
Speed Reference property on the asset's
Properties tab.
Pole Profile Display data events Configure an Air Gap Group with some Air Air Gap sensors.
from Air Gap sensors. Gap sensors and collect data. Change one
of the viewers to the Pole Profile and drop
trends from configured Air Gap sensors.
Rotor Shape Display calculations of Drop trends from configured Air Gap Air Gap sensors.
Air Gap trend data in SEensors.
the shape of a rotating
stator.
Shaft Plots the average Assets must have gap features. Pairs of sensors
Centerling’ radial shaft position connected to
to show changes orthogonal
in shaft position probes.2 3
during run-up or coast-
down in relation to
the surrounding, fixed
bearing. To indicate
the distance from the
center point of the
bearing, the viewer
contains a dashed line
that begins at the zero
point of the axis system
and ends at a point
of the curve where the
viewer cursor lies.
Spectrum Displays the frequency Move the cursor along a trend curve Vibration sensors
domain representation to update this viewer with the spectrum that acquire
of an acquisition measurement at different times. waveform data,
measurement. suchas
acceleration.
Table Observe features Tables show the value of each feature All sensor types.
from multiple sensors loaded in the Trend viewer at the time where
simultaneously when the cursor lies.
you move the cursor
or view a stream in
the Trend viewer. An
empty cell means that
InsightCM Server is not
configured to calculate
that feature for a
particular sensor.
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Viewer Use Case How to Use Supported
Sensors

Thermal Compiles temperature Set the cursor on a data set on the Trend Cameras that

Imaging data collected from a Viewer to view temperature data. Thermal Imaging
thermal camera into an (IR) devices
image based on the support.
color palette you select.

Trend Shows the plotted This viewer is always visible on the All sensor types.
values of features and Data Viewer page workspace. Display any
spectral bands over number of features from any number
time. of sensors. The x-axis represents the

system time. The y-axis represents feature
values that InsightCM Server calculates
from measurements. Static sensors (i.e.
digital inputs and temperature sensors) do
not produce waveform data and therefore
support only the Trend and Table viewers.

TSA (Time Displays the power Move the cursor along a trend curve Vibration sensors

Synchronous spectrum of the TSA to update this viewer with the spectrum that acquire

Averaging) waveform data from a measurement at different times. waveform data,

Spectrum specific acquisition. such as

acceleration.

TSA Waveform Displays the time- Move the cursor along to a trend curve Vibration sensors
domain representation to update this viewer to display the that acquire
of a measurement measurement at different times. waveform data,
with reduced noise such as
and non-snychronous acceleration.
energy from a specific
acquisition.

Waterfall Displays the spectra Set the cursor a data set on the Trend Vibration sensors
of successive Viewer to view the spectra of successive that acquire
measurements from a sensor measurements. waveform data,
sensor simultaneously. such as
Shows how spectral acceleration.
data changes over time.

Waveform Displays the time- Move the cursor along a trend curve Any sensors that
domain representation to update this viewer to display the acquire waveform
of a measurement from measurement at different times. data, such as
a specific acquisition. acceleration.

1Trend viewers that show feature data over time rather than data from a specific acquisition.

2The actual angle between orthogonal probes does not need to be exactly 90 degrees. Angles of 80-100 degrees

are typically acceptable.

SWhile not required, Cutsforth recommends you configure the bearing-clearance properties for orbit and Shaft

Centerline viewers in the Properties tab of the Asset Configuration page.

9.7.5.1. Configuring Default Options for Viewers

Click the Navigation menu () and select Options. Modify default options for waveform, spectrum, orbit,
waterfall, and table viewers in the resulting dialog box.
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9.7.6. Keyboard Shortcuts

Defines keyboard shortcuts that can be used on the Viewer page.

Keyboard Shortcuts
Left and right arrow keys

Description

Moves the cursor in the selected
viewer between collected data
sets.

How to Use Shortcuts

Double-click a viewer showing
data.

For the Trend Viewer, click the
Annotate Data Sets button to
view the data sets you can
move between.

Use the left and right arrow
keys to move the cursor
between the different data
sets.

Up or down arrow keys

Changes which feature data set to
display in the selected viewer when
two or more features are selected.

Does not apply
to the Trend
viewer.

Hold Ctrl and select more than
one feature in the asset tree.

Click within a viewer showing
data.

Use the up or down arrow keys
to change which feature data
set shows in the viewer.

Shift + left and right arrow keys

Changes the cursor you select and
enables you to adjust that cursor's
distance from the fundamental.

Double-click within a viewer
that has multiple cursors to
set a fundamental.

2. Click the Cursor ( " ) button
and select the last cursor
option to set equidistant
sideband or periodic cursors.

Applies only to
o viewers, like

the Spectrum

viewer, that

have multiple 3. Click to set the sideband or
cursors - such periodic cursors.

as, harmonic
and sideband. 4. Hold Shift and use the left

and right arrow keys to
change which cursor you have
selected.

5. Release the Shift key and
just use the right and left
button to adjust the distance
of the selected cursor from
the fundamental.
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Keyboard Shortcuts Description How to Use Shortcuts
Shift + up or down arrow keys Changes in which fault frequency is 1. Configure an asset with fault
displayed on the viewer. frequencies (page 105).
2. Double-click a data set in the
o Only applies to Trend viewer.
viewers that ) o ) .
support fault 3. Click within a viewer showing
frequencies data.
and when you 4. Hold Shiftand use the up or
have down arrow keys to change
configured the which fault frequency is on
displayed display.
asset with
multiple fault
frequencies.

9.8. Exit Conditions

Configure exit conditions to prevent your device from collecting a large number of data events for an
extended period of time.

Leaving a device in a stream-enabled operating state for an extended period of time might result in a
large number of data events. To prevent excessive data event creation, you can define exit conditions for
a stream-enabled operating state in: Asset Configuration page » equipment asset » Operating States tab.

9.9. Analyzing Data

9.9.1. Annotating Data
Add annotations to the data you have collected.
Availability: Periodic Data mode

In Periodic Data mode, you can annotate a data set by adding comments or attaching files to it. You and
other users can see this annotation when the data set is loaded in the Trend viewer.

Complete the following steps to add a comment or attachment to a data set:

1. Click the Data Viewer (¥ ) button.

2. Inthe Trend viewer, double-click to place the cursor at the data set of interest.
3. Click the Action menu ( = ) on the Trend viewer toolbar and select Add Comment.
4. Inthe resulting dialog box, click the Add comment or Add attachment button to annotate the data

set.
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9.9.2. Changing the Time Range of Trends

In Periodic Data mode, the Trend viewer has a time-range property that controls the length of trends you
load. Even if more data is available on the InsightCM Server, the Trend viewer displays only data from the
configured time range.

In Stream Data mode, the time range is restricted to the duration of the stream you load. If you change
the time range of the Trend viewer, the following viewers update to match the new Trend viewer time
range:

= Bode

= Polar

= Shaft centerline
= Waterfall

Complete the following steps to change the time range for which you want to view data.

1. Click the Data Viewer (¥ ) button.

2. Click the Set time range (E') button on the Trend viewer toolbar

3. Select or set a date and time range.

9.9.3. Compensating for Slow-Roll Data
Enable compensation for slow-roll data when viewing your data.

Vector Compensation - When you configure sensors, InsightCM provides 1x Magnitude Reference and
Tx Phase Reference properties that specify the magnitude and phase values when the shaft is at
slow-roll speed. The Data Viewer page uses these properties to compensate for slow-roll in Bode and
Polar viewers. If the configured reference values are incorrect, or you want to temporarily override them
with different values, you can compute and apply new slow-roll references within the Data Viewer page.
Complete the following steps to change the configured magnitude and phase references.

1. Click the Data Viewer ( e ) button.

(1]
2. Click the Layout (B®) button on one of the viewers, navigate to Chart type > Vibration, and select
Bode or Polar.

3. Click the Slow-Roll Override button on the Bode or Polar viewer toolbar to open the Set Slow-Roll
Override dialog.

4. Complete one of the following steps.
a. Modify the values in the Magnitude and Phase columns.

b.  Click Cursor Values to set the override values to the magnitude and phase feature values. In the
Bode and Polar viewers, you must place the cursor at a point on the chart in order to enable
Cursor Values.
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Waveform Compensation - To distinguish between data that indicates a physical imperfection in
equipment, such as a scratch on a shaft, and pure vibration data, the web application applies
waveform compensation for slow-roll data. When the Order Waveform or Order Spectrum viewer
displays a data set, the web application subtracts slow-roll data from that data set.

Complete the following steps to enable slow-roll compensation.

5. Onthe Order Waveform or Spectrum Order viewer, click Settings > Viewer Settings > Perform
slow-roll compensation.

9.9.4. Compensating for DC Gap Offset

Change the configured gap reference for the Orbit or Shaft Centerline viewers.

1. Click the Data Viewer ( s ) button to navigate to the Data Viewer page.

2. Select the Layout button for one of the bottom row charts and navigate to Chart Type » Vibration »
Orbit or Shaft Centerline.
This will change the chart type and the corresponding toolbar buttons.

3. Expand a Displacement sensor and select a feature that has calculated data to activate the chart's
toolbar options.

4. Click the Gap Override button on the chart toolbar.
In the resulting Set Gap Override dialog box, complete one of the following steps.
» Modify the values in the Override Value column.

= Set the override value to the corresponding gap feature value at that timestamp by clicking the
Gap Values button. In the Shaft Centerline viewer, you must place the cursor at Gap Values .

» Restore the configured gap reference value by click Configured Values in the Set Gap Override.

9.9.5. Analyzing Unusual Data Events

Configure your data dissection options and dissect a data event:

1. Select the Navigation menu (¥ ) and select Options.
In the Options dialog box, navigate to Data Viewer » Data Event Dissection.

3. Use the Data Event Dissection options to specify how to divide data events. You can divide data
events into static block-lengths, a number of equal-length blocks, or into blocks of progressively
shorter lengths. The Progressive data dissection option splits the last five seconds of the waveform
into 200 ms sections, the previous five seconds into 0.5 second sections, and the rest of the
waveform into one second sections.

4. Inthe Trend viewer on the Data Viewer page, double-click the data event you want to dissect.

5. Inthe Action menu ( — ) on the Trend viewer toolbar, select Dissect Data Event.

When you dissect a data event in the Trend viewer, you can use any of the other available viewers to
investigate the values of any of the features in your asset tree at the time of the data event.
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9.9.6. Integrating or Differentiating Data

Apply single or double integration or differentiation to acceleration, displacement, and velocity data from
your viewer.

Only the Orbit, Spectrum, Waterfall, and Waveform viewers support integration and differentiation.

1. Click the Integration (H) button on the viewer toolbar.
2. Select an option on the dialog box and set the cutoff for the integrations you want to perform.

3. Click OK and the viewer will update to show the integrated or differentiated measurements.

9.9.7. Correlations of Data to Speed and Events

9.9.7.1. Correlating Data to Speed
The Data Viewer page always displays the speed value from a sensor's speed reference in the metadata

pane. The speed reference can be a tachometer, a fixed, user-defined speed, or a data source - such as,
OPC UA or Modbus.

To view the metadata pane, click the Layout menu on the Data Viewer page toolbar and
select Show Metadata .
9.9.7.2. Correlating Data to Events
You can annotate data to document the cause of a fault, or you can add comments to record information

about a particular data set. InsightCM Server stores annotations with the data they apply to, and you can
view annotations for a trend plot by clicking the Annotate Comments button on the Trend viewer toolbar.

The following metadata pane shows the information displayed when you analyze displacement data from
a run-up stream. Notice the value of the speed reference at the time of acquisition.
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9.10. Preserving Data

Set exceptions to data-aging rules to retain data anomalies you want to view in the future.

InsightCM automatically deletes historical data when specified conditions are met if administrators set
data-aging strategies (page 171). Aging conserves space on the server, but you may want to ensure data
from a specific acquisition remains available for viewing. Preserve data by marking the file for retention.

Complete the following steps to have the server retain data associated with a specific acquisition:

—_

Click the Data Viewer ( s ) button to navigate to the Data Viewer page.
Expand the equipment and sensor for which you want to set an exception and select a feature.

Move the cursor to the point of interest in the Trend viewer and double-click it.

> W

Complete the following step according to the current workspace mode:

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




T —
CUTSFORTH "CSER MANUAL

THE POWER OF INNOVATION"

a. Periodic Data mode: Click the Trend viewer Action menu > Data Events ( — ) and select Retain
Data Event . The Data Viewer page identifies the sensor and acquisition to be retained and also
prompts you to enter an optional comment that the server will store with the data.

b. Stream Data mode: Click the Trend viewer Action menu > Data Events ( = ) and select Retain
Stream. The feature and sensor data remains accessible whenever the Trend viewer time-axis
contains the time at which the acquisition occurred.

The server will retain all data associated with the sensor acquisition, not just the trend value or curve
that was active when you clicked the Retain Data Event button. Retaining data means you have
access to feature values, the time waveform, and other measurements, such as the FFT curve.

5. To export a TDMS file for a data event, click Action menu > Data Events.

6. Select Export Data Event and open the downloaded file.

9.11. Deleting Data

Delete unneeded data retained by the server in order to conserve space and memory.

Before you begin, ensure that your role has the correct permissions to delete data.

Data that you delete for an entire asset is not limited to one or more sensor features in
the Trend viewer and includes trend and data collections.

1. Click the Data Viewer ( s ) button to navigate to the Data Viewer page.
2. Click and drag over the time range in the Trend viewer.
3. Complete the following step according to the current workspace mode:

—

a. Periodic Data mode: Click the Action menu ( — ) on the Trend viewer toolbar and select Delete

Data Events.

b. Stream Data mode: Click the Action menu ( = ) on the Trend viewer toolbar and select Delete
Stream. If you delete a data event that is part of a stream, you will delete the entire stream.

9.12. User-Initiated Triggers

Users manually initiate data set collections via the following triggers.

Description Use Case Where to Initiate

Force Collect a data set on Check the health of

Trigger dermand. equipment. Click the Data Viewer ( &= ) button, Action

menu ( = ), and select Force Trigger.
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Description Use Case Where to Initiate
Burst Temporarily collect Check the health of . . [N .
Mode high resolution data on equipment using high Click the Data Viewer (= ) button, Action
demand. resolution data. menu ( = ), and select Collect Burst Data
Sets option.

9.12.1. What Happens When Triggers Occur During Data Collection?

When triggers occur at the same time a device is acquiring data, the device buffers the first data set
collection trigger and begins another data set collection when the initial one ends. If two or more triggers
occur during the data set collection, the device ignores the second and subsequent triggers. Consider
the data set collection settings in the following example.

Setting Value

File Length 10 Seconds
Delta EU Trigger Level 3 Engineering Units
Alarm Rule Above 75 Degrees

The following table describes how this behavior affects the contents of the data events the device
creates and the way the data displays in on the Data Viewer page. Observe how the contents of the data
events do not always match the value of the collection condition field that displays below the equipment
name in the metadata pane when you select data on the Data Viewer page.

Data Event Trigger Contents Collection Condition

Displayed on the Data
Viewer Page

1 Force trigger Data from time 0-10 seconds, including the User Event
following events:

= Force trigger

= Delta EU change

= Alarm set
= Alarm clear
2 Delta EU Data from time 10-20 seconds Delta EU Trigger
change

9.12.2. Force Triggering an Acquisition for One Data Group
Use Force Trigger to acquire data from a single data group.

Complete the following steps to acquire data from channels associated with one equipment asset.

1. Click the Data Viewer ( e ) button.

2. Expand the equipment asset for which you want to force trigger an acquisition, expand one of the
sensors, and select one of the features to activate the Trend viewer chart.
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3. Inthe Trend viewer chart, click the Action menu and select Force Trigger to perform an acquisition
for that data group.

4. Wait several seconds for the acquisition to be complete and then confirm that data has been
acquired by clicking the Refresh button and reviewing the Trend viewer chart.

[t may take up to a few minutes for wireless monitoring gateways, wireless vibration
measurement devices, and wireless vibration sensors to complete the acquisition.

5. Repeat the force acquisition several times to acquire multiple data sets.

Before the data is available, devices must finish performing the acquisition and the

o InsightCM server must receive and store the data. The duration of a force-triggered
acquisition is based on the file length of the Default Operating States for the
equipment.

For a complete list of ways you can configure a device to perform acquisitions, refer to Methods for
Initiating Device Acquisitions (page 50).

To perform an acquisition of all the device's channels, refer to Performing an Initial Acquisition for
Continuous Devices (page 45).

9.12.3. Manually Requesting Temporary High-Resolution Data Acquisition

High-resolution data is useful for troubleshooting equipment. To collect high-resolution data, you can use
burst mode.

o Burst mode has to be configured.

Complete the following steps to force trigger and view a periodic acquisition.

1. Click the Configuration pull-down ( - ) and select Devices.
2. Double-click the device from which you want to collect high-resolution data.

3. Onthe Device Properties tab, select the Enable Burst Mode checkbox and configure the Burst
Collection Settings. If you make changes in this step, update the device configuration on the Devices
tab of the Device Configuration page.

4. Click the Action menu ( = ) on the Trend viewer toolbar and select Collect Burst Data Sets .
5. Ensure the workspace is configured to load data from the appropriate time range.

6. If the Trend viewer already contains curves for the features or sensors of interest, click Refresh trend

data ( e ) in the viewer toolbar. You may need to wait a few minutes to see high-resolution data in
viewers, because devices must switch to burst mode, perform the high-resolution data acquisition,
and send the data to the InsightCM server.
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9.13. Baselines and Data Event References

9.13.1. Creating a Trend Baseline
Trend baselines determine the values that InsightCM uses to create trend alarms.

Complete the following steps to create a trend baseline for an asset.

Click the Navigation menu (¥) and select System > Trend Baselines. .
In the Trend Baselines dialog box, select the asset for which you want to create a baseline.
Click Add.

In the Create Trend Baselines dialog box, select an operating state.

M w o~

InsightCM creates a baseline from the asset data acquired in the operating state
you select.

5. Click OK.

9.13.2. Displaying Individual Trend Values

When you view data, the cursor appears as a vertical red line that intersects the plot at a point where a
data set was acquired, as shown in the image below.
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Complete the following steps to move the cursor to a data set of interest on a trend plot.

1. Click the Data Viewer (¥ ) button.

2. Click the Annotate Data Sets button on the Trend viewer toolbar to show all points where data was
acquired.

3. Double-click the data set you want to inspect. You can also press the <Left-arrow> or <Right-arrow>
keys to move the cursor from data set to data set. Although the Trend viewer calculates feature trend
points even when no data is acquired, you can only place the cursor at points where there are data
sets.

When you place the cursor on a data set in the Trend viewer, the other viewers automatically update
with sensor data from the selected data set.

9.13.3. Viewing Historical Data

Analyze historical periodic data by loading a feature in the Trend viewer and then loading the data setin a
waveform, spectrum, or other sensor data viewer.

The Trend viewer serves as a master viewer for the workspace because you load and browse feature
trends to see sensor data.

Complete the following steps to load a trend and view the sensor data that comprise the trend:

1. Click the Data Viewer (¥ ) button.

2. Select an asset feature to load its data in the Trend viewer. To load data from multiple features in the
Trend viewer, <Ctrl-click> to select multiple features or <Shift-click> to select a range of features.

3. Click the Annotate Data Sets button on the Trend viewer toolbar to flag trend points that have data
sets associated with them.

4. Double-click a point on the trend plot that has a data set. The sensor data viewers update
corresponding to the data set for that trend value. If a viewer remains empty, it might not support
the sensor whose features you loaded. Refer to the Unsupported Sensors for Sensor Data Viewers
section below for more information.

The following workspace shows the result of selecting a feature from the asset tree. Notice the trend
plotincludes a point for each acquisition over a period of several days. The Waveform and Spectrum
viewers display the sensor data acquired at the position of the cursor within the Trend viewer.
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Unsupported Sensors for Sensor Data Viewers

Some sensor data viewers display data only when the Trend viewer contains features from certain
sensors. Consider the following examples:

= Waveform and Spectrum viewers support sensors that acquire waveforms rather than single-point
measurements such as temperature.

= The Orbit viewer supports only pairs of displacement sensors connected to orthogonal probes
that have the same tachometer reference.

In this situation, sensor data viewers remain empty until you load features from supported sensors in
the Trend viewer. Refer to Available Viewers and Options for Configuring Them (page 125) for sensor
support considerations for each viewer.

Conditions Where Data is Unavailable

Although you have access to all data stored on the InsightCM Server, the following factors can affect
your ability to load the data:

= |In Periodic Data mode, the Trend viewer has a time-range property that controls the length of
trends you load. Even if more data is available on the InsightCM Server, the Trend viewer displays
only data from the configured time range.

= |f administrators set data-aging rules, the server automatically deletes historical data when a set
amount of time passes. Aging is useful for conserving space on the server. However, to prevent
InsightCM from deleting certain trend values and sensor data due to its age, you can mark the data
to be retained.
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= |In Stream Data mode, you can only load trends from equipment that is part of a stream. Also,
the time range in viewers is restricted to the duration of the stream you load, so you cannot see
additional data even from equipment that is part of the stream.

9.13.4. Downsampling

Because of screen resolution constraints, the viewer may not be able to display every point in a data set.
As aresult, some viewers downsample data by default so that viewers can load data faster and conserve
memory. This means that the viewer displays only the data points necessary to generate an accurate
plot.

When you zoom within a viewer with downsampling enabled, InsightCM queries the server for new data to
display. Therefore, the viewer resolution remains the same even though the zoomed view displays fewer
points than the original view.

To disable downsampling, complete the following:

1. Click the Data Viewer (¥ ) button.

2. Inthe viewer toolbar, click the Action menu ( — ) button.
Select Settings.
4. Deselect Downsample if available.

Disabling downsampling may negatively impact the performance of the web
application.

9.13.5. Comparing Measurements from Different Sources or Times

Compare measurements from multiple points in time or from multiple pieces of equipment by creating
data event references that you can show in a chart later.

Complete the following steps to create a data event reference:

1. Click the Data Viewer ( e ) button.
Select an asset.

3. Selecta trend point to create a data event reference for the Trend viewer.

4. Click the Action menu ( = ) and select Data Event » Create Data Event Reference.

In the Choose Reference Type dialog box, choosing creates one of the types of references given
below. These references can be used to mark specific data events from an asset and show that data
alongside other data from the same asset.

a. Baseline—The default data reference.

b.  Slow-Roll—The reference InsightCM uses to calculate slow-roll compensation if you enable
slow-roll compensation on the Order Waveform or Spectrum viewer.
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c. Temporary—A data reference that disappears after 24 hours.
d. Other—A reference you create for any other reason.
6. Click OK.

On the Data Viewer page, click Select a Data Event Reference and select the data event reference
you created.

8. Inany viewer on the Data Viewer page, click Show Reference to display the reference you selected.
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10. Server Configuration and Maintenance

The InsightCM™ Server requires configuration and maintenance to ensure its functionality, accessibility,
and performance.

= Configuring InsightCM (page 145)-Manage the settings of your InsightCM server that enable web
client accessibility, security, and expandability.

= Maintaining InsightCM (page 169)-Optimize your system by managing packages and configuring an
aging strategy for data.

10.1. Configuring InsightCM

Manage the settings of your InsightCM server that enable web client accessibility, security, and
expandability.

Complete the following tasks to ensure that your system is accessible, secure, and complete.

1. Open Required Ports (page 145)-Open required network communication ports to access the web
application and to initiate data collection.

2. Enable and Require SSL Connections (page 150)-Configure your settings to require a secure
connection to access the web application.

3. Integrate InsightCM with Windows Active Directory (page 151)-Integrate InsightCM with your
Windows Active Directory to require users to log in with Windows account credentials.

4. Create Roles and Assign Permissions (page 152)-Manage roles with differing levels of permission for
editing or accessing your InsightCM system.

5. Learnabout and Configure Historian Software (page 157)-Learn how InsightCM Server can connect
to data historians with the purchase, activation, and enablement of the Enterprise Gateway option.

6. Configure Your Server Fleet (page 167)-Configure your server fleet by modifying the .json file that
installed to your server with InsightCM.

7. Define a Transceiver (page 168)-Configure your server fleet by modifying the .json file that installed
to your server with InsightCM.

10.1.1. Opening Required Ports for Communication

Open required network communication ports to access the web application and to initiate data
collection.

Before you begin, install InsightCM on your machine.

Open required ports to access the web application. Without opening the necessary ports, you cannot
configure your assets and devices or begin data collection.
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o The installer attempts to open these ports for you.

Complete the following steps to open the ports according to your monitoring needs.

1.  Review the following table of ports and the details provided for each to determine which ports you
need to unlock.

Port Type Description Details
80 TCP (outbound) Application Image Required
Deployment
82* TCP (inbound) HTTP Web Application Not required if enabling connection to the web
application via SSL.
482* TCP (inbound) HTTPS Web Application Only required if enabling connection to the
web application via SSL.
3580 TCP (outbound) Application Image Required
Deployment
5353 UDP (inbound) InsightCM Device Used to find devices on the server's subnet.
Communication Only affects the functionality of the "Browse"
button when adding devices.
5672 TCP (inbound) InsightCM Internal Service Only necessary if using the SDK to
Communication communicate with the server from another
device.
6343** TCP (inbound) InsightCM Device Web Retrieves device information relating to
Service hardware, system health, and connection.
Also, sends commands, such as reboot, to the
device.
8002 TCP (outbound) InsightCM Device Sends measurement and system data from a
Communication device to the server.
*Configurable through IS
**Configurable through InsightCM

2. Openthe necessary ports.

= Contact your IT department about opening the necessary ports.

= Using Windows Firewall Inbound and Outbound rules, allow the following program to communicate:

lkads.exe, installed at C:\Windows\SysWOW64

Now that you have opened the necessary ports to access the web application, secure your web
application by enabling and requiring SSL connections (page 150).

10.1.2. Generating an API Key

Create an APl key to enable access to InsightCM data services.

1. Click the Navigation menu (¥ ) and select Options.
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2. Scroll down to Security and click Web API Keys.

3. Click New to generate a new APl key.

o The key you generate is not editable.

4. Copy the APl key and save it in a text editor for reference later.

The key cannot be viewed again once you close the Copy Api Key dialog. Save the
key in a text editor for reference later as needed.

5. Delete a Web APl Key

Use the APl key (page 147) you generated to enable secure access to InsightCM data services from your
API.

10.1.3. Accessing InsightCM Data Services Using HTTP API

Access your InsightCM data services in your preferred programming language using the HTTP API.
Before you begin, generate an APl key (page 146).

Cutsforth recommends enabling Secure Sockets Layer (page 150) (SSL) or Transport Layer Security
(TLS) before proceeding to ensure that the key is encrypted as it is passed over the network.

1. Use the following web service API to connect to InsightCM programmatically and acquire data. All
endpoints return a JSON string.

Path Method Description

/lcmApi.svc/assets GET Get all the equipment asset
nodes and their parents.

/lcmApi.svc/asset-subtree/ GET Get all the descendants of an
{assetld} asset node.
/lcmApi.svc/assets/version GET Get the asset collection version.
/lcmApi.svc/data-events/ GET Get data events for an asset.
{assetld}?

startTs={startTs}&endTs={endTs
J&skip=0&take=100

/lcmApi.svc/trend-points/ GET Get trend points.
{trendld}?

startTs={startTs}&endTs={endTs
J&skip=0&take=100

/lcmApi.svc/data-event/ GET Get data sets.
{dataEventld}
/lcmApi.svc/archived-data-event/ GET Get archived data sets.

{assetNodeld}?ts={ts}
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Method Description

/lcmApi.svc/active-trend-alarms? GET Get active alarms.
skip=0&take=100

2. Provide the APl key as an HT TP Authorization header in your code. Refer to the examples below for
how this can be done in C# and Python.

3. Confirm that you can successfully call InsightCM data services by passing the URL of your
InsightCM Server and the APl key in the Command Line Interface (CLI) or in the interface for your
application

Providing the API Key in C#

var client = new HttpClient();
client_BaseAddress = new Uri(address);
client._Defaul tRequestHeaders.Authorization =
new AuthenticationHeaderValue("'Api-Key", key);

var response = await client._GetAsync("'lcmApi.svc/assets™);
response .EnsureSuccessStatusCode();

Providing the APl Key in Python

connection = http.client.HTTPConnection(address)
headers = {"Authorization": "Api-Key {0}".format(key)}
startTs = int((datetime.now() - timedelta(days=1)).timestamp())
connection.request("'GET", "/lcmApi.svc/dataEvents/
{0}?startTs={1}".format(asset["1d"], startTs), headers = headers)
response = connection.getresponse()
if response.status !'= 200:
raise Exception("'Request failed with status {0}".format(response.status))

Example 1. C# and Python Examples
10.1.3.1. InsightCM 3.10 REST API Changes

Data Event Endpoint Changes

The /1cmApi .svc/data-event/{dataEventld} and /lcmApi . svc/data-event-archived/
{assetNodeld}?ts={ts} APl methods have been removed. Replacing them are two new methods:

1. /lcmApi.svc/data-event/data-set/{monitorld}/{dataSetld}?ts={ts}
= This method returns a single data set from a given data event.

2. /lcmApi.svc/data-event/trend-points/{monitorid}?ts={ts}
= This method returns all trend point values collected with a given data event.

Both of these methods will retrieve archived and un-archived data

Both of these methods require a monitor ID to retrieve data. A monitor represents a data collection
technology (e.g., vibration, ESA, IR) for a equipment node. Monitor information can be found on equipment
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(asset) nodes returned from the ZIcmApi . svc/assets method. Here's an example of an equipment
node with a vibration monitor and an ESA monitor:;

{
"1d":""66c3a34a9188103f2eal13836",
"Type': "Equipment",
"Name'': "My Equipment",
"Mappings': [
{
"1d": "64e55ca0-2d29-4c3e-bd40-3cab4bl17¥129",
“"Type": "Esa",
"Deviceld": null,
"Properties": {},
"Disabled": false
3,
{
"1d": "f87cddd9-80c7-4dec-bca7-5f33a3a3b584",
"Type': "Vibration",
"Deviceld": null,
"Properties": {
"VibrationType': "‘cms",
""SpeedReferenceType': "FixedSpeed",
"NominalSpeed": ''1800"
3.
"Disabled": false
¥
1.
}

Monitor IDs can also be found on the data events returned from the /1cmApi .svc/data-events/
{assetld} API method.

{
“1d": "{9F295B29-625E-11EF-8FC0-00802F23CB60}"",

"AssetNodeld": '"66c3a34a9188103f2eal3836",
"Monitorld"”: "f87cddd9-80c7-4dec-bca7-5f33a3a3b584",
"Timestamp': 1724447999000,

"Properties": {

}.
"DataSetReferences™: [
{
"Sensorld": '66c3a34a9188103f2eal3839",
"DataSetld": "{9F2A51E7-625E-11EF-8FC0-00802F23CB60}"",
"DataSetType': "Waveform"
}.
{

"Sensorld": "66c3a3569188103f2eal383b"",
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"DataSetld": "{9F2B2607-625E-11EF-8FC0-00802F23CB60}"",
"DataSetType': "Waveform"

}
}

The new ZlcmApi .svc/data-event/data-set APl method also requires a data set ID. Data set IDs
can be found in the DataSetReferences array of the data events returned from the ZlcmApi .svc/
data-events/{assetld} API method, as shown in the example above.

Trend Point Object Changes
The trend point object returned from the ZIcmApi .svc/trend-points/{trendld} and /

IcmApi .svc/data-event/trend-points/{monitorld}?ts={ts} APl methods has changed in
InsightCM 3.10.

The trend point object no longer contains the DataEventld property or the Properties object.

The trend point object now contains an Status integer bitflag property which represents certain
metadata about the trend point. Below is a table showing what each bit position represents:

Bit position Meaning

0 (least significant) Invalid

1-2 Alarm severity

3 Alarm transitioned
4-8 Operating state

Cameras Endpoint Removed

The /1cmApi . svc/cameras APl method has been removed.

Cameras are now represented by asset nodes, so they can be retrieved through the ZIcmApi .svc/
asset-subtree/ API method.

10.1.4. Enabling SSL Connections

Enable Secure Sockets Layer (SSL) connections for access to the web application.
Before you begin, create or provide an SSL certificate.

By default, users do not need to access the web application via an SSL connection. However, as of
version 3.8.5 and newer, an SSL certificate will need to be added to the web server configuration for the
HTPPS site to function.

Once an SSL certificate has been created or provided, complete the following steps to enable SSL
connections to the web application.
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10.1

10.1

Open the Internet Information Services (IIS) Manager application from the Windows start menui.
In the Connections tree, expand the asset representing the server.

Expand Sites and select InsightCM.

In the Actions pane, click Bindings.

In the Site Bindings dialog box, select the https item and click the Edit button.

Select an SSL certificate you created.

N o ok W =

Click OK in the Edit Site Binding dialog box and then click Close to return to IIS Manager.

Users can now access the web application via the following URLs:/ / ser ver DNSHost name and
htt ps://server| pAddr ess. However, users are still able to access the web application through
non-SSL (HTTP) connections.

Now that you have enabled SSL connections, require SSL connections (see Requiring SSL
Connections (page 151)).

.5. Requiring SSL Connections

Require users to connect to the web application using HTTPS.
Before you begin, enable SSL connections.

After you apply an SSL certificate to the https site binding, users can still browse and open the web
application using an HTTP connection. Complete the following steps to require SSL connections.

1. Expand Sites and select InsightCM.
2. Double-click SSL Settings.

3. Check the Require SSL checkbox.
4. Click Apply in the Actions pane.

If you browse to ht t p: / / ser ver Name: 82, the browser displays an error because an SSL
connection viaa URL suchas htt ps: // ser ver DNSHost name is required.

Now that you have enabled and required SSL connections, further secure your system by integrating
InsightCM with the Windows Active Directory (page 151).

.6. Integrating InsightCM with Windows Active Directory

Integrate InsightCM with your Windows Active Directory to require users to log in with Windows account
credentials.

Complete the following steps to enable LDAP on your browser.

1. InFile Explorer, navigate to the following location:

C:\ProgramData\Cutsforth\InsightCM\Auth
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2. Openthe LoginAuth. json file in a text file editor.

3. Modify each line category according to a Windows account in your organization.

Do not set DisableBui I'tinAccounts to true until after you assign your
Windows credentials to an InsightCM role. You will be unable to log in because
your credentials lack the necessary permissions.

InsightCM uses the DirectoryEntry class to facilitate the LDAP

o connection. In the LoginAuth.json file, LdapServiceAccountUserName and
LdapServiceAccountPassword are the username and password by the
DirectoryEntry class. If you define an LdapDomainName, InsightCM adds it followed
by a backslash to the beginning of the username. The LdapConnectionString is
used as the path in the DirectoryEntry class. See the example below.

4. Save the changes you made to the file.

5. Loginto the web application with the Windows account used to modify the LoginAuth . json file.

{
"DisableBuiltinAccounts”: false,
"LdapConnectionString": "LDAP://icm.com/0OU=Test,DC=ICM,DC=COM",
""LdapDomainName": ""icm.com",
"LdapUsernameFilterToken": "sAMAccountName",
"SessionTimeoutMinutes™: 7200,
"LdapServiceAccountUserName': "Administrator",
"LdapServiceAccountPassword': ''SecretPassword"

}

Now that users are required to log in with their Windows credentials, assign roles and

permissions (page 152) to each Windows user. After adding Windows Active Directory users to
InsightCM roles, disable the built-in accounts and remove the stored LDAP username and password
in the json file.

o See Setting up Email Notifications (page 80) for password format requirements.

10.1.7. Managing Roles and Permissions
Manage roles with differing levels of permission for editing or accessing your InsightCM system.
Before you begin, integrate your InsightCM system with your Windows Active Directory (page 151).

Assign individual users to roles with specific permissions in the InsightCM web application to ensure
each user has the appropriate level of access.

1. Click the Navigation menu (¥ ) and select Options.
2. Inthe Options dialog, click Roles and Permissions under the Security category.
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3. Click the Role pull-down menu and select an existing role.

A list of permissions assigned to that role populates in the Permissions field below the pull-down.
4. Click Add next to the Permissions field to assign additional permissions to the role.

For a description of available permissions, refer to the List of InsightCM Web
Application Permissions (page 154).

5. Click Add next to the Active Directory Roles field to associate one or more Active Directory Roles
with the InsightCM role.

6. Enter each Active Directory account that you want to add to the InsightCM role, or use the Browse
LDAP by user for groups button to find which Windows accounts are recognized by the web
application.

7. Click OK to exit the Active Directory Role dialog, verify that the correct Active Directory account(s)
appear in the Active Directory Roles field, and click OK.

Any Active Directory user you associated with this InsightCM role has the corresponding permissions.

If you assign an Active Directory user to multiple InsightCM roles, the user receives the
permissions of all associated roles.

After assigning Windows Active Directory users to InsightCM roles, return to the
LoginAuth. json file and set DisableBui I'tinAccounts to true and remove the stored
LDAPServiceAccountUserName and LDAPServiceAccountUserPassword.

Unless you disable built-in roles, users can log into the web application by entering the
name of a role and no password.
10.1.7.1. Relationships Between User Accounts and Permissions

Permissions determine which features in the InsightCM web application a user can access after logging
in. Several factors determine which permissions a user receives:

Permissions The ability to see and/or configure specific pages or tabs in the web application. You assign
permissions to roles.

Role An administrator-defined persona with assigned permissions.

Refer to the Creating Roles and Assigning Permissions (page 152) topic to
learn how to define new roles and how to configure new or existing roles.

Active A group in the Windows Active Directory service running on the server machine that contains
Directory user accounts. Groups map to roles. Refer to Integrating Insight CM with Windows Active
group Directory (page 151) to require users to authenticate with Active Directory.

Directory. An alternative is allowing users to log into the InsightCM web

o The web application does not require you to authenticate users with Active
application with the names of built-in roles, which do not require a password.
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User account An account on the Windows domain whose credentials a user enters to log in to the
web application. Accounts belong to Active Directory groups and therefore, they receive the
permissions from any role to which their Active Directory group is mapped.

The following diagram shows the relationship between all four items. Notice that the user accounts
receive permissions via a group. In other words, you cannot apply a set of permissions to just one
account because you must apply a set of permissions to a group.

4 N

Assigned InsightCM Web Active Directory User
Permissions Application Roles Groups Accounts
( asset_edit, A ( A ( A ( A
alarm_edit, > ITEngineer -+ Corp_ALL_Admins -+ Userl
\_serverSettings edit, etc. \_ J \ J \ v
'S N ' N ' N 'S N
alarm_edit - Operator [+ Corp_ALL_Analysts - User2
'\ J . J . J '\ J
'S p N ' N ' N 'S N
t it,
asset_e I. > Technician - Corp_ALL_Techs -+ User3
alarm_edit
J . J '\ J

N AN N AN /

10.1.7.2. List of InsightCM Web Application Permissions

Permissions determine which features in the web application users can access when they log in.
Assigning permissions to a user is a two-step process: creating a role with the desired permissions,
and then mapping a user to the role.

If you have LDAP configured but have no explicit permissions assigned to your role, you
will be unable to log in to InsightCM. Refer to Integrating InsightCM with Windows Active
Directory (page 151) for more information.

The following list describes the permissions you can assign to web application roles:

alarm_edit

Features Locations Affected

Enables access to the Acknowledge button on the
Active Trend Alarms and Active Spectral Alarms tabs
of the Alarms page.

= Navigation menu (¥ )» Alarms » Active Trend

= Navigation menu (¥ ) » Alarms » Active Spectral

Displays option to force clear alarms. o v . .
= Navigation menu ( ™ ) » Alarms » Active Trend » Action »

Force Clear

= Navigation menu (¥ ) » Alarms » Active Spectral »
Action » Force Clear

Enables access to the Add Annotation button for

_— v .
spectral alarms, Navigation menu ( ¥ ) » Alarms » Active Spectral and

double-click an alarm instance
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alarm_rule_edit

Features Locations Affected

Allows the user to add, edit, and remove trend alarm = Asset Configuration page » Trend Alarms tab

rules. = Alarms page » Trend Rules tab » Action menu » History

asset_delete

Other permissions required: asset_edit, dataEvent_delete

Features Locations Affected
Enables the Remove button above the asset tree and access to the following options in Asset Configuration
the right-click menu within the asset tree: page

= Remove with descendants
= Remove and promote descendants

= Open Device Configuration

Enables access to the Remove button on the Devices tab. Device Configuration
page

asset_batch_edit

Other permissions required: asset_edit

Features Locations Affected

Allow users to add, edit, and remove features. o v
Navigation menu ( ) » System » Features

Allows users to add and remove units for features. o v .
Navigation menu ( ) » System » Units

Allows the user to edit asset definitions.

Asset Configuration page » Action menu ( — ) » Edit Asset
Definitions

Allows users to import asset spreadsheets. ) ) . =
Asset Configuration page » Action menu ( — ) » Import/
Export » Import Asset Spreadsheet

Allows users to import device spreadsheets. ) i ) ) =
Device Configuration page » Actionmenu ( — ) » Import/

Export » Import Devices Spreadsheet

asset_edit

Other permissions required: device_troubleshooting, alarm_edit, alarm_rule_edit

Features Locations Affected

Allows user to add to and edit names and locations in the asset Asset Configuration page
tree.
Displays option to disable an asset. Asset Configuration pages » asset tree

Document #:

ICM3.11.1 Rev A
2025-06-30 © Cutsforth 2025 | Cutsforth.com/Support




Features

T —
CUTSFORTH

THE POWER OF INNOVATION"

InsightCM 3.11.1
USER MANUAL

Locations Affected

Allows user to apply, edit, import, export, or remove an asset
template.

Asset Configuration page » Action menu (
Manage Templates

)»

Allows the users to add and edit fault frequencies.

Asset Configuration page » right-click menu for
a selected asset

Allows the user to import and export asset definition files.

mn

Asset Definition Editor » Actionmenu ( = )

Allows the user to create and reset trend baselines.

Data Viewer ( s ) » Trend viewer » Action menu

(=)

Allows the user to create data event baselines.

Data Viewer ( s ) » Trend viewer » Action menu

(7)

Allows user to edit device configurations.

Device Configuration page

Allows user to change the device name that appears throughout
the InsightCM web application.

Device Configuration page » Action menu (

)

Enables access to the Update Application button.

Device Configuration page » Software tab

Displays option to disable the device so the device does not try

Device-related pages » Action menu (

)

to contact the server or transfer data events.

Displays option to upload, download, and delete devices

o v -
applications and firmware. Navigation menu ( ™ ) » Utilities » Package

Management

Allows users to edit the Auto-Configuration section of the L " .

Options dialog box. Nawgaﬂon_menu (¥ )» Options » Auto-
Configuration

dataEvent_delete

Features Locations Affected

Allows users to set aging options for data events and

streams in the Options dialog box. Navigation menu ( ¥ ) » Options » Periodic Aging

Strategy OR Streaming Aging Strategy

Allows users to delete data events and streams from Data Vi [ Acti
InsightCM Server. ata Viewer (&= ) » Action menu (

) » Data Events

device_troubleshoating

Features Locations Affected

Displays the option to reboot a device. )

Device Configuration page » Action menu (

Displays option to reset the connection information for the . . . . =
device. Device Configuration page » Action menu ( — ) page
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historian_edit

Features Locations Affected

Allows user to perform tasks on the Historian page, including the following: o v
Navigation menu ( ¥ ) » System »

» Add, edit, remove, import, and export Pl point mappings Historian page
= Add and apply point name patterns

= Edit custom feature names

icm_show

Features Locations Affected

Allows user to view only data and configurations. The entire web client

This permission is granted with all
other permissions.

notification_report

Features Locations Affected

Allows users to add, edit, and remove only email address o ~ . T
Navigation menu ( ™ ) » Options » Notifications »

groups.

Address Groups

Allows users to configure only daily notification reports. o v . o .
Navigation menu ( ¥ ) » Options » Notifications » Daily

Reports

serverSettings_edit

Features Locations Affected

Allows user to edit all of the Server Settings section of the Options o v .
; Navigation menu ( ¥ ) » Options » Server

dialog box. .

Settings

Allows user to edit the Security section of the Options dialog box. o v . .
Navigation menu ( ¥ ) » Options » Security

Allows user to edit spectral alarm rules. o v
Navigation menu ( ¥ ) » Alarms » Spectral

Rules

10.1.8. Historian Software

Learn how InsightCM Server can connect to data historians with the purchase, activation, and
enablement of the Enterprise Gateway option. Connecting InsightCM to your historian software makes it

possible for InsightCM to write new data to existing historian points and to pull data from historian points
for feature calculation or visualization.

= AVEVA eDNA Enterprise Data Management (page 158)—Map data sources in the InsightCM Server to
historian points on AVEVA eDNA software. When a device calculates a trend point value, InsightCM
writes it to the corresponding historian point.
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= OSlsoft PI System software (page 159)—Map data sources in the InsightCM Server to historian points
on OSlsoft PI System software. When a device calculates a trend point value, InsightCM writes it to the
corresponding historian point.

10.1.8.1. Interfacing with eDNA Historians

Connect InsightCM to AVEVA eDNA historian software.

1. Download and install the eDNA User Client Services or eDNA Admin Client Services from AVEVA.

Specify the eDNA server's IP or computer name when configuring the DNASYS.INI
o file during installation.
2. Request the following 64-bit DLLs from AVEVA:
= EZDnaServApi64._dll
= EzDNAServApiNet64.dl1
3. OntheInsightCM server, save the 64-bit DLLs in the same location as the DLLs that are included
with Client Services.

The default location for DLLs included with the installation of Client Services is
o C:\Program Files (x86)\eDNA.

4. Save a copy of the following DLLs to the same folder in which InsightCM is saved:

= EZDnaApiNet64.dl (A different DLL than mentioned above)
= EzDNAServApiNet64.dl1

o The default InsightCM install location is Cz\Program
Files\Cutsforth\lnsightCMm.

5. Open File Explorer and navigate to where the eDNA configuration file was saved:
C:\ProgrambData\Cutsforth\InsightCM\Auth\eDNAConfig.json

6. Open the eDNAConTig. json file in a text editor and edit each field to match your eDNA server.

E eDMACenfig - Notepad
File Edit Format View Help

i
"PrimaryUnivServicelp": "127.8.8.1",
"PrimaryUnivServicePort”: 8088,
"SecondaryUnivServicelp”: "127.8.8.1",
"SecondaryUnivServicePort”: 80886,
"SiteMame”: "EDNA",
"UnivServicelame”: "UNIV",
"CachePath™: "C:\\ProgramData\\Cutsforth\\InsightCM",
"CacheSizekb": 208088
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The eDNA API caches data updates if the APl loses connection to the eDNA server.
Configure the location of the cache file and the maximum size of the cache by
editing the CachePath and CacheSizeKb properties respectively.

7. Restart the InsightCM service to integrate a data historian.
a. Start Windows Services.
b. Find and select InsightCM <version>.
c. Click Restart.

8. InlInsightCM, click Dashboard ( & ) and select the Historian tab to check the connection status.

10.1.8.2. Interfacing with OSlsoft Pl System Software

Enable InsightCM to interface with OSlIsoft Pl System software.

Before you begin, install the OSlsoft Pl Asset Framework (AF) Client and activate a run-time license on the
same machine that runs InsightCM Server.

1. Launch Windows Services.
2. Select the InsightCM <version> entry in the list of services.
Click Restart .

o Restart the InsightCM software to integrate a data historian.

4.  Launch InsightCM.

Click the Navigation menu (¥') and select System > Historian.
Assign the following permission to web application users working with point mappings.

» historian_edit— Allows you to add, edit, remove, import, and export mappings to historian
points, add and apply point name patterns, and customize the feature names that appear in point
names.

Components for Writing Values to Historian Points

Map sources of data in InsightCM to historian points to write values to the historian software. Whenever
the source produces a value, InsightCM writes the value to the corresponding point in the historian
software.

Components for Writing to Historian Points

InsightCM uses the following components to write data to your historian software.
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Component Description

Historian Point A time-stamped value stored in the historian software. InsightCM uses the
point mappings you create in the web application to write values to your
historian software.

Feature A measurement derived from collected data. For example, the most recent
RMS value from acceleration data that a particular sensor acquires is a
feature. Create a point mapping for a feature and InsightCM will write values
from that feature to a historian point on the historian software.

Point mapping The mapping of a feature in InsightCM to the name of a historian point in the
historian software.

Troubleshooting Missing Historian Points

If the status of a sensor is open, InsightCM does not write the values of features or spectral bands to
the historian software, which may result in missing historian points. To check historian points, refer to
Reviewing the Latest Value (page 163) or Querying the Historian Software (page 163).

Adding Point Mappings for Equipment Assets

Add point mappings for one or more assets to enable InsightCM to write data to the historian software.

1. Click the Navigation menu ( ¥') and select System > Historian.
2. Inthe Point Mappings tab, click Add.

o You can only add point mappings for sensor assets that are children of equipment
assets.

3. Inthe Choose Assets dialog, select one or more assets.
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Choose Assets b 4

Select all/none

Farm > Vibration > CMS5-9055 1E5D64A 9205 9207 9208 > 1E5D64A Amps A
Farm > Vibration > CMS5-9055 1E5D64A 9205 9207 9208 > 1E5D64A Volts A
Farm = Vibration > CMS-9055 1ESD64E 9232 9425 9426 > 1ESD64E Accels A
Farm = Vibration = CMS-9055 1ESD64E 9232 9425 9426 > 1E5D64E Accels B
Farm > Vibration = CMS-9055 1ESD64E 9232 9425 9426 > 1E5D64E Digital A
Farm > Vibration > CMS-9055 1ESD64E 9232 9425 9426 > 1ESD64E Digital B
Farm > Vibration > CMS-9065 1899118 9230 > 1B99118 Accels A

Farm > Vibration > CMS-9065 1899127 9232 > 1B99127 Accels A

Farm > Vibration = CMS-9065 1899127 9232 > 1B99127 Accels B

O00O0O0O0O0OO0O0aOo

Farm = Vibration = CMS-9036 1C95BF3 9232 9229 = 1C95BF3 Prox A

Cancel

4. Click Preview to review the list of features associated with the equipment asset that you are creating
point mappings for.
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Historian Tag Preview x
Select All/None & Edit

Asset Tag Name Ena...
[ #  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  Yes
¥ ¢  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  No
¥ &  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  Yes
¥ ¢  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  No
¥ ¢  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1ESD64A 9205 9207 92...  Yes
¥ ¢  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  No
¥ &  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  Yes
¥ ¢  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  No
¥ &  Farm|Vibration|CMS-9055 1ESD64A 92059207 9..  Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  Yes
¥ &  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  No
¥ ¢  Farm|Vibration|CMS-9055 1ESD64A 9205 9207 9... Farm_Vibration_CMS-9055 1ESD64A 9205 9207 92...  Yes
[ #  Farm|Vibration|CMS-9055 1E5D64A 9205 9207 9... Farm_Vibration_CMS-9055 1E5D64A 9205 9207 92...  Yes
V¥ ¢  Farm|Vibration|CMS-9055 1ESD64A 9205 9207 9... Farm_Vibration_CMS-9055 1ESD64A 9205 9207 92...  Yes

Apply Cancel

5. Ensure that features you want to create point mappings for are selected and that both the asset and
the point name are correct.

If you want to edit the name of an asset or a point name, select the point mapping

and click Edit.

6. Click Apply to create the point mappings.

Creating Point Names Automatically

Create a point name pattern to automatically generate point mappings for assets.

1. Click the Navigation menu (¥ ) and select System > Historian.

2. Onthe Point Name Patterns tab, select an asset type and click Edit.

Enter the static text and tokens you want InsightCM to replace with dynamic information about the
tag source.

The following list contains tokens you can include in point name patterns. Surround each token with
curly braces, as shown. Asset name values are static within historian points and source names.
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Historian points and source names do not reflect any changes you make to an
asset name.

Token Description

{name} Asset name

{path} Asset path including all parent assets
{feat} Feature or spectral band name
{unit} Units of the feature or spectral band

You can replace the names of features and spectral bands in the InsightCM Server with
custom names.

Now that you have created a new point name pattern, add point mappings for equipment
assets (page 160).

Reviewing the Latest Value

Review the latest value of one or more historian points.

1. Click the Navigation menu (¥ ) and select System > Historian.

2. Select one or more point mappings.

3. Click the Action menu ( = ) and select Get Point Values.

You can query the historian software. Refer to Querying the Historian
Software (page 163) for more information.

A value of Pt Created means the point exists on the historian server, but the
InsightCM Server has not written a value to it.

Preventing InsightCM from Writing to Historian Points
Prevent the InsightCM Server from writing values to specific historian points on the historian software to

avoid storing invalid data from a faulty sensor.

1. Click the Navigation menu (¥ ) and select System > Historian.
2. Select one or more point mappings.
3. Click Edit.
4

Remove the checkmark from the Enabled checkbox.
Querying the Historian Software

Query the historian software to troubleshoot or review historian points that InsightCM wrote to the
historian software using point mappings.
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1. Click the Navigation menu ( ¥') and select System > Historian.

2. Click the Action menu ( — ) and select Query Points.

3. Because the historian software typically returns too much data and causes a timeout error, replace
the default query string:

tag="lcm**
= If you use OSlsoft Pl Server software, refer to the Pl SDK Utility Help for more
information about query syntax.

= Queries are limited to 1,000 results.

Exporting Point Mappings

Export information from all pages of the point mappings table to an Excel spreadsheet.

1. Click the Navigation menu (¥) and select System > Historian.

1]

).
3. Select Export Point Mappings Spreadsheet.

2. Click the Action menu (

Importing Point Mappings

Change point mapping names and enablement by importing an Excel (. xs Ix) spreadsheet with the
correct information.

You can update only the point mapping names and point enablement by importing a
point mappings spreadsheet.

1. Click the Navigation menu ( ¥ ) and select System > Historian.

I

).
3. Select Export Point Mappings Spreadsheet.

2. Ontheright, click Action menu (

You download an Excel spreadsheet with information for every point mapping.
4. Edit the outdated point mappings in the Excel spreadsheet.
5. Save the spreadsheet and return to InsightCM.

I

).
7. Select Import Point Mappings Spreadsheet.

6. Ontheright, click Action menu (

8. Select the document you saved and click OK.
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Adding a New Point Name Pattern

Add a new point name pattern to make the name of InsightCM data points match the name of historian
points in your historian software.

1. Click the Navigation menu (™) and select System > Historian.
2. On the Point Mappings tab, click Add.

Enter static text and tokens you want the web application to replace with dynamic information about
the tag.

4. Select the asset type you want to apply the pattern to.

N\ Verify that the web application successfully applied point name patterns by
/A \ checking the historian point names on the Point Mappings tab.

List of Tokens that Insert Dynamic Information in Point Names

Use tokens as you configure InsightCM's data point naming conventions to match your OSlsoft PI
system.

The following list contains tokens you can include in point name patterns.

o Surround each token with curly braces, as shown below.

Asset name values are static within Pl point and source names. If you change the name
of an asset, Pl point and source names do not reflect the change.

Token Description

{name} Asset name

{path} Asset path including all parent assets
{feat} Feature or spectral band name’
{unit} Units of the feature or spectral band

TYou can replace the names of features and spectral bands in the InsightCM Server with custom names.

Refer to Point Name Patterns (page 165) and Defining Custom Feature Names (page 166) for examples of
using these tokens.

Point Name Patterns

You must activate InsightCM Enterprise Gateway to use point mappings.

To ensure that point names follow a uniform pattern and contain minimal errors, define patterns
that create and insert static characters and dynamic information into point names. For example,
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a point name pattern of Location_{path}_ {unit} resultsin a point name that looks similar to
Location_NorthSite Motor_AccelerometerX RMS g.

o The default point name pattern is the {path} token.

Defining Custom Feature Names
Define custom names to replace default feature names in point mappings. InsightCM inserts the custom

names when you apply a point name pattern that contains the {feat} token.

1. Click the Navigation menu (™) and select System > Historian.

2. Use one of the following methods to define custom names to replace the default names of features.

Customize a 1. Switch to the Point Name Patterns tab.
feature name. 2. Selectafeature.

3. Click Edit and enter the {feat} token in the Pattern field.

4.  Click OK.

5. If applicable, select the Point Mappings tab and re-add the affected assets to apply

changes to existing mappings.
o The list contains entries for features that InsightCM supports.

Insert feature 1. Onthe Point Mappings tab, click Add or select an existing point mapping and click Edit
names to point to add or to edit a point name.
mappings. 2. Enter the {feat} token in the point name pattern.

3. Click OK.

10.1.8.3. Noatifications Page

InsightCM aggregates and lists daily error and alarm notifications on the Notifications page.

1. Click the Navigation menu (¥ ) and select Notifications.

2. View the notification summary for a date within a seven day range.
a. Click the History button to display the Select Report Date dialog box.
b. Choose which report to display.

3. Change the parameters of a notification.

Select a notification.

o o

Click Edit to change parameters such as the time range or number of transitions covered by the
notification.
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o Editing is not available for all notifications and the parameters available for
editing vary for each notification.
4. Export a notification report spreadsheet to your computer.
a. Click the History button to choose the date for which you want to save a report.
b. Click OK.
c. Click Export.

10.1.8.4. OPC UA Data Source Properties

The OPC UA data source supports configurable properties that affect how the device communicates
with the OPC device.

Property Name Description

Server Endpoint URL The OPC UA server URL.

Interval (sec) How often the InsightCM device process reads the device, in seconds.

Read Timeout (sec) How long the read process waits for a response from the OPC server when the client is
reading from the server. If the OPC UA server does not respond within the specified timeout,
the InsightCM device attempts to re-open a connection after 30 seconds.

When you specify the file names for your server and client certificates, ensure that all
certificate files are in the following directory:.

C:\ProgrambData\Cutsforth\InsightCM\Auth\eDNAConfig.json

10.1.8.5. Historian Data Source Property

The Historian data source supports properties that affect how the device communicates with the
historian software.

Property Name Description

Interval (sec) How often the InsightCM device process reads the device, in seconds.

10.1.9. Configuring Your Server Fleet
Configure your server fleet by modifying the .json file that installed to your server with InsightCM.

1. Open File Explorer and navigate to the following location:
C:\ProgramData\Cutsforth\InsightCM\Fleet

2. Find the Example.json file and create a copy of the file for each additional InsightCM server that you
want to add to your fleet.

3. Rename each file with a descriptive name and modify each line category according to information for
each server you are adding to your fleet.

= "Name" : "Example",
"Host": "localhost",
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"User': "Messagebusconfiguration.json>Username",
"Password": "‘Messagebusconfiguration.json>Password",
"Port": 82

The username and password for each server you add to your fleet is located in
the
C:\ProgramData\Cutsforth\IlnsightCM\MessageBusConfiguration.
Json file on that server.

4. Once you have created and modified a copy of the Example. json file for each server, restart the
service and log into the web application.

A new Fleet tab appears on your main dashboard.

10.1.10. Defining a Transceiver

Identify the server machine so your devices can locate the server.

Complete the following steps to configure the device transceiver settings so that the device can reliably
communicate with InsightCM Server.

—_

A LN

Click the Navigation menu (¥) and select Options.
Navigate to the Server Settings section and select Transceiver.
Click Alternate IP Addresses to view all possible addresses for your server.

Determine what to use as your hostname.

Static IP If your server has a static IP address or you don't expect your server IP address to change,
address copy the IP address to use as the hostname.
Fully qualified If you are using a DNS server on your network and you expect your server IP address to

server name

change, copy the fully qualified server name to use as the hostname. The server name
dynamically links to the server IP address even if the IP address changes. However, using the
server name is less reliable than using the IP address. Only use this option in cases where
using the IP address is impractical.

5. Paste the address or name into the Hostname field.

6. Uncheckthe Use IP Address checkbox if you want the transceiver to use the address that you
specified in the Hosthame field rather than the default IP address. When you save the server
settings, the Transceiver value automatically updates to match the Hostname value.

7. Click OK to restart InsightCM Server and apply the change.

After you save the new server settings, reset the device connection to get the device to send the
updated connection information files to the server.

10.1.11. Transferring InsightCM Data to a New Server

Follow the process outlined below to transfer InsightCM data and configuration to a new server:
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1. Stop the InsightCM and InsightCM MongoDB services.

2. Locate the database and data directories on disk and transfer them to the new server. These are the
default locations on disk:

= Database Directory: C:\\ProgramData\Cutsforth\Insight CM\MongoDB
» Data Directory: C:\ProgramData\Cutsforth\Insight CM\Files

3. Install the version of InsightCM that was previously used on the old server. Be sure to select the
correct database and data directories if the default locations are not being used.

» To upgrade to a newer version of InsightCM, Cutsforth recommends first installing the previously
used version of InsightCM to ensure successful data transfer. After confirming the new server is
functioning properly, an upgrade to a newer version can be performed.

4. Configure the server's transceiver (page 168) settings and reconnect all devices by selecting
Connection » Reset Connection from the Devices page.

5. Additional configuration may still be required to connect to historian, enable SSL connections, and
integrate with Windows Active Directory. See Configuring InsightCM (page 145) for more information.

10.2. Maintaining InsightCM

10.2.

Optimize your system by managing packages and configuring an aging strategy for data.

Before you begin, ensure that you have added Cutsforth monitoring devices (page 43), mapping, and
have acquired data (page 48).

Complete the following tasks to manage application packages and to conserve disk space.

1. Manage Packages (page 169)-Upload and download software packages, which this page refers to
as system images or firmware.

2. Configure an Aging Strategy (page 171)-Conserve disk space by configuring a strategy that
automatically deletes historical data when certain conditions are met.

1. Managing Packages
Upload and download software packages, which this page refers to as system images or firmware.

The InsightCM Server installs some default software packages. If you create or receive updated or
patched packages, use this page to upload it so you can apply the packages to devices.

You cannot manage packages using Windows 10. Refer to support documentation for
more information.

= Click the Navigation menu ( ¥') and select Utilities > Package Management.

= Complete one of the following tasks according to your package management goals.
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Update the application
that runs on one or more

devices. 2. Select one or more devices and click Update Application.

1. Click Configuration ( ;") and select Devices.

This operation requires devices to reboot and might take
several minutes to complete.

Upload a software 1. Click Upload.

package to the server. 2. Navigate to the package you want to upload to the server.

3. Click Open to begin the upload.

10.2.2. Aging Strategies
An aging strategy prompts the server to delete historical data if certain conditions are met.

Systems with many devices or with devices performing frequent acquisitions can require significant
disk space to store data. InsightCM provides features for automatically discarding data events after
configurable conditions are met. This automatic process, called aging, conserves disk space while
maintaining a desirable collection of data.

InsightCM applies the periodic aging strategy to individual data events that are not part of a stream. The
streaming aging strategy is used to discard entire streams. InsightCM does not retain partial streams.

Trend data is aged separately from data events, which contain data sets. By default, trend data is retained
with the following policy:

Stage Length in days Retained values per day

1 7 All
2 90 24
3 Forever 4

If you need to change the default settings, contact the Cutsforth support team for assistance.

InsightCM ignores periodic data events triggered by an alarm transition and never
deletes them due to aging.

10.2.2.1. Calendar-Based Aging Strategy

A calendar-based strategy enables you to determine which and how much data to discard. This strategy
follows a time-based schedule to discard data events after a configurable number of days. You can
configure the strategy to discard all data sets except those collected at a specific time. For example, you
can retain some data to trend over an extended period of time by configuring a calendar-based strategy
that deletes all periodic data events except those collected at 12:00pm after two days elapse.

You can also choose to retain data events that have alarms or comments associated with them and
exclude data events from a particular operating state.
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The aging strategy runs every fifteen minutes, so InsightCM might not discard data
immediately after the aging condition is met.

10.2.2.2. Identifying Data that Is Exempt from Aging

You can identify data that InsightCM exempts from aging on the Trend viewer. The Trend viewer shows
data points from times that are exempt from aging rules. For example, if InsightCM is configured to delete
all periodic data three days after collecting it, but the Trend viewer displays a value that is five days old,
that data point is exempt from aging.

10.2.3. Configuring an Aging Strategy

Conserve disk space by configuring a strategy that automatically deletes historical data when certain
conditions are met.

To learn more about the periodic and streaming aging strategies, refer to Aging Strategies. Complete the
following steps to configure an aging strategy.

1. Click Navigation menu ( ¥) and select Options.
2. Navigate to Server Settings.

3. Select Periodic Aging Strategy or Streaming Aging Strategy.

Both periodic and stream aging strategies are system-level strategies that apply to
data events from all devices.

Use the Aging Strategy pull-down to select the Calendar-Based strategy.

Use the text box below the pull-down to specify how many days' worth of data events to retain.

Specify time(s) when the device permanently retains the data events it collects.

N o o k&

Use the corresponding checkboxes to configure whether data events collected with alarms or for all
MCSA Startup events are always retained and whether to retain burst data sets.

8. Use the Never retain data events from pull-down and select an operating state.
9. Click OK.

The following table compares how two different aging strategies operate on data. In these examples,
assume Day 1 begins with zero data events.

Collec Delete Total Collect Delete Total Stored Collect Delete Total
t Stored Stored
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Strate Day 1 Day 2 Day 3
ay

Calen 3 0 3 3 0 6 4 All 3 7
aar- collect
based edon
— Day 1
Retain
from
the
past
two
days

Calen 3 0 3 3 0 6 4 All
agar- collect
based edon
— Day 1
Retain except
from the
the one
past collect
two ed at
days, 12:00
and PM
then
perma
nently
retain
the
data
event
collect
ed at
12:00
PM
every
day

o0

The calendar-based strategy in the second row is useful when you want to access all acquired data only
during the recent past. For example, if an equipment asset fails, you may want to review data from every
acquisition that occurred 2 days prior to the failure. However, you may only need to view data from one
acquisition per day twenty days prior to failure.

Now that you have configured an aging strategy, learn how to preserve some data events from aging
strategies (page 172).

10.2.4. Preserving Data from Aging Strategies
Ensure data from a specific acquisition remains available for viewing regardless of aging rules.
Before you begin, you need to have acquired data.

Feature and sensor data remains accessible whenever the Trend viewer time-axis contains the time at
which the acquisition occurred. When you choose to retain data, InsightCM retains all the data associated
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with the sensor acquisition, such as feature values, the time waveform, and other measurements, such as
the FFT curve.

Complete the following steps to identify which data events you want to retain.

1. Click the Navigation menu (¥ ) and select System > Data Events.

2. Inthe Data Events dialog, select an equipment asset from the asset tree to bring up corresponding
log data events on the right.

Select the data event of interest that contains data sets.
4. Click Retain.

Remove the retain property by selecting a data event marked for retention and
clicking Retain.

Click OK.

6. Verify that the data event has been marked for retention.

o Click the Action menu ( = ) above the data events log and select Export to export a
TDMS file for a data event.
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11. Troubleshooting

11.1. Logging Important Event Details

A tracepointis a flag that, when enabled, instructs the server to log messages about when particular
events occur. For example, the Storage .MajorOps tracepoint flags events related to file I/0. Review a
dynamic list of tracepoints that update as they become available.

1. Click the Navigational menu » Utilities » Trace Logger.
2. (Optional) Double-click a tracepoint in the table to enable or disable a specific tracepoint.
3. (Optional) Create an exception that inverts the status of a tracepoint for a specific device.

o Exceptions work differently depending on whether the tracepoint is enabled or
disabled.

* Enabled tracepoints - An exception prevents the server from generating
messages for the exception item.

= Disabled tracepoints - An exception allows the server to generate messages for
only the exception item.

a. Selecta tracepoint whose name begins with Device in the table.

o Exceptions are valid only for tracepoints whose names begin with Device.

b. Click the Edit button.
c. Click Add and enter the name of the device you want to create an exception for in the text field
that appears.

o Exceptions are case-sensitive.

4. Download logs of a tracepoint or server-crash information as text files.
a. Click the Action menu.
b. Select Download Trace Log or Download Crash Log.

11.1.1. Exceptions for Device-Related Tracepoints

Exceptions are useful for storing tracepoint information from a select number of devices instead of all
devices.

For example, if you only care about a specific device that is experiencing issues rather than every
device in the system, you might disable the Device.SystemEvent.Level1 tracepoint. Additionally, you
might create an exception for the one device you are interested in tracking so that the server generates
messages for any events that device might have. Exceptions are case-sensitive, so when you add an
exception, enter the exact device name.
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11.1.2. Notable Tracepoints

Please note that this is not a complete list of all available tracepoints.

Tracepoint Name Tracepoint Description Use Case
Authentication.Srptracing Reports about operations related to You are bringing devices online
authenticating device credentials. and troubleshooting connection
Provisioning.StateChange Each time a device tries to connect, ISSues.

reports specific issues related to the
device status, such as the software
configuration or application being out of
date.

TransceiverConnections Reports when devices connect,
disconnect, or become authorized to
connect to the InsightCM Server.

Device.FileManager.SendData Reports when the device sends data See when a device sends data to
events to the server. the server.

DataStorage.MajorOps Reports general operations for storing Monitor the server receiving data
data events. events from devices.

PIHistorian.TagWritten Reports whenever InsightCM Server You want to monitor activity by
writes a value to the Pl software. historian software.

11.2. Resolving and Clearing an Invalid Configuration

Enable your device to collect data again by changing the collection settings and conditions for an asset.
When unresolved errors, such as reaching CPU and/or memory capacity, occur and persist in the device
application, the device can enter a state of Invalid Configuration. This state works like an idle state where
the application does not respond to any internal or external requests except requests to restart.

Complete one of the following steps to resolve and then clear the invalid configuration state of a device.

Click the Configuration pull-down and select Devices.

Double-click the device with the Config Status of Invalid Configuration.
Identify which equipment asset sensors are mapped to the device.

Click the Configuration button to get to the Asset Configuration page.
Select the equipment mapped to the device with an Invalid Configuration.

In the equipment's configuration panel, select the Operating States tab.

N o ok N2

In Data Set Collection Settings, configure the file length so that it is lower than its current setting.

You may also free up memory or CPU by lowering the Sample Rate in the
device's configuration page and/or removing integrated features from sensor asset
properties.

©

Navigate to the Device Configuration page in the web application.

©

Select the device that still has a Config Status of Invalid Configuration and select the Action menu.
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10. Select Clear Invalid Configuration to make the device responsive to requests again.

If your device's application re-enters an Invalid Configuration state due to issues unrelated to memory or
CPU, contact technical support.

11.3. Troubleshooting Deployment Issues

Complete the following steps to troubleshoot deployment issues.
1. Expand the navigation menu and select Utilities » Deployment Status.

2. Referto the Action Status column for the failed entry to find the System Configuration API error code
associated with that type of failure.

11.4. Troubleshooting Devices That Do Not Come Online

Bring your device(s) online by applying troubleshooting steps for one of several possible causes.

Wait several minutes for devices to download configurations, update an application,
and/or reboot before troubleshooting.

Status on Device Possible Cause Troubleshooting Steps
Dashboard
Disabled The device was On the Device Configuration page, select the device and
manually disabled via then select Action menu » Enable Device.

the Action menu
item on the Device
Configuration page.

Offline The deviceisin the Wait several minutes to see if the status changes.
process of rebooting.
The device does 1. Select the device and then select Action menu »
not have connection Connection » Test Connection.
information.

2. Ifthe device responds to the ping with a message
other than "All tests passed", complete the following
steps.

a.  Wait a few minutes before repeating the test. If
the same message recurs, continue to the next
step.

b.  Verify the IP address is correct.

c. Withthe offline device selected, select
Connection » Reset Connection from the Action
menu.

d. If the device fails to reset, physically reboot the
device using the Reset button on the controller.
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Status on Device Possible Cause Troubleshooting Steps
Dashboard
The device is not = Verify the physical connections to power and the
powered on or not network.

connected to network. « Watch the USERT LED on the device. This LED blinks in

one-second increments to indicate normal operation.

= Physically reboot the device using the Reset button on
the controller.

Unconfigured The device IP address is 1. Double-click the device to modify its configuration.
not con_ﬂgured and has 2. Select the Hardware tab and then select Edit
never tried to connect to Hardware
the InsightCM Server. '
3. Update the IP Address for the device and click OK.
Unauthorized The device does 1. Select the device and then select Action menu »
not have credentials Connection » Test Connection.
that mgtch what 2. Ifthe device responds to the ping with a message
the InsightCM Server " " ;
other than "All tests passed", complete the following
expects.

steps.

a. Wait several minutes before repeating the test. If
the same message recurs, continue to the next
step.

b.  Verify that the device IP address in the web
application matches the device's current IP
address.

c.  With the offline device selected, select
Connection » Reset Connection from the Action
menu.

d. Ifthe device fails to reset, physically reboot the
device using the Reset button on the controller.

UpdatingFirmware The deviceisin the 1. Wait several minutes after the last action you
process of downloading performed in the web application before refreshing
firmware and rebooting. it to see if the status changes.

2. Change the device type if the incorrect value is in
the Device Type column by selecting Action menu »

Change Device Type.

UpdatingConfiguration You saved the Wait at least five minutes after the last action you perform
device configuration, or in the web application to see if the status changes.

changes to the server
triggered the InsightCM
Server to update the
configuration on the
device.

11.4.1. Logging Information about the Connection Process

Enable the following tracepoints on the System page >Trace Logger tab to log events that occur
specifically during the provisioning process.
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Refer to the help documentation for the Logging Important Event Details (page 174)
topic for more information about enabling tracepoints and accessing the logs they

produce.
Tracepoint Name Tracepoint Description
Provisioning.StateChange Reports changes in the status of a device, such as when the software configuration
or application is out of date.
Device.SystemEvent.Levell Reports about device operations, such as acquisition triggers that fire and their
cause.
This point is not available until the first device connects to the
InsightCM Server.
Authentication.Srptracing Reports about operations related to authenticating device credentials.
TransceiverConnections Reports when devices connect, disconnect, or become authorized to connect to the
InsightCM Server.

11.5. Troubleshooting the Connection between the Server and a
Device

Determine why the server and a device are not connecting and establish/restore the connection.

The Test Connection dialog box checks common issues that prevent a device from connecting to the
InsightCM Server and coming online.

—_

Check for common issues by testing the connection between the server and the device.
a. Select the pull-down by Configuration » Devices.
b. Select Action menu» Connection » Test Connection.

2. (Optional) If the test results in All tests passed, you may need to deploy a supported application to
the device before it will come online.

o The device may be formatted correctly, but not yet running a supported application.

a. Select the pull-down by Configuration » Devices.
b. Click the Software tab and select the device.
c. Click Update Application.

11.6. Troubleshooting Email Delivery

Debug possible reasons email delivery fails using tracepoints.

Refer to the Setting Up Email Alarm Notifications (page 80) topic for steps to configure settings for an
SMTP server.
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If the InsightCM Server fails to send alarm notification emails, complete the following steps to log
information about the failure.

—_

Click the Navigation menu (¥ ) and select Utilities >> Trace Logger.

N

Double-click the SMTP.Emails tracepoint to enable it.

Click the Navigation menu (¥ ) and select Options.
4. Inthe tree onthe left, select SMTP.
Select Test Mode.
o Test Mode prevents the server from sending emails, even when you run commands

from the InsightCM console. Enable the SMTP.Emails tracepoint to view messages
that the server writes to the trace log.

6. Trigger an alarm that sends an email notification.

The server attempts to send an email to that address group and logs information about the attempt
in the trace log.

Return to the Trace Logger tab and select the Action menu ( — ) and Download Trace Log.

8. Open the log file with a text editor and search for the tracepoints labeled SMTP . Emai Is for email
delivery information.

11.7. Error Values for Integrated Features

11.7.

Symptoms of Issue

= Features appear in the web application with incorrect values (by default, -1), which indicates an error
occurred.

= The features are for a measurement type derived by single or double integration. For example, features
calculated from velocity data that you derive from acceleration data via single integration.

Possible Cause

The time-domain data from which the InsightCM Server calculates the features might not be of a
sufficient duration. To calculate features from integrated data, the InsightCM Server requires enough
time-domain data to allow for filter settling time.

1. Common Causes of This Issue

As mentioned previously, this issue occurs only when single or double integration is enabled for a
channel. Also, the issue often occurs in data acquired as part of a run-up or coast-down stream because
those acquisitions can be very short. For example, consider a device configured to perform stream
acquisitions with a length of 10 revolutions. For fast-moving equipment, the revolutions might occurin a
very short amount of time, meaning the resulting waveforms do not contain enough data for InsightCM
Server to calculate feature values.
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11.7.

11.7.

This issue can still occur even if you ensure that acquisitions always last at least one second. For
example, consider an accelerometer channel with single integration enabled in order to perform velocity
measurements. If features calculated from the acceleration data are valid but velocity features have error
values, the cause might be that the velocity time-domain data is too short. This occurs because of the
way the InsightCM Server filters integrated time-domain data.

2. How Filtering Affects the Duration of Integrated Data

To account for integration settling time, InsightCM discards the first 7seconds of the integrated time-
domain data before calculating features from it, where the following equation determines the value of 7.

n=(1/Integration Cutoff)* x

As the following table explains, the value of Integration Cutoff and x vary according to whether the
InsightCM Server performs single or double integration.

Type of Integration Source of Integration Cutoff Value ! Value of x Constant
Single Single Integration Cutoff property 3
Double Double Integration Cutoff property 10

1Set these properties for each channel on the Device Configuration page»Channels tab»Properties tab.

3. Working Around This Issue

To avoid situations where integrated time-domain data is too short, set the acquisition duration to be
a number of seconds such that the waveform is at least one second longer than the integration filter
settling time.

Also, if you change the value of the Single Integration Cutoff or Double Integration Cutoff property for a
channel, ensure the new value does not cause the integration settling time to become too long.

11.8. Replacing a Device in InsightCM

Bring replacement devices online in InsightCM.
Ensure that you have another device to replace your original device.
Complete the following steps to replace a device in the web application as you do so in person.

1. Click the Configuration pull-down and select Devices.
2. Click the Action menu and select Disable Device.

Disabling the device prevents it from attempting to communicate with the
InsightCM while you are replacing it.

3. Power off the old device.
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4. Setthe IP address of the new device to be the same as the device you are replacing.

This allows the new device to connect to InsightCM and come online when it powers on.

5. Mount the new device in place of the old device, connecting to the network, sensors, and power.

6. Inthe web application, on the Device Configuration page, click the Action menu and select
Connection » Test Connection.
This prompts the device to connect to InsightCM.

7. Click the Action menu » Connection » Reset Connection to send a new connection information file to
the device.
The connection file includes new credentials so that the device can come online.

8. Check the device status on the Device Configuration page to ensure it comes online.

If the model of the new device is different from the old module, update the device configuration.

11.9. Testing Sensors to Validate Hardware

Test sensor asset connections in the Test Panel page.

Task Action

Viewing feature values Browse to any device-related page, such as the Devices page or a Device Dashboard

for every assetona page, and then select Test Panel from the View menu.

device. Click the Feature Chart tab and select an asset from the pull-down menu in the top-left
of the tab.

Configuring the feature Browse to any device-related page, such as the Devices page or a Device Dashboard

trends tab page, and then select Test Panel from the View menu.

Click the Feature Trend tab.

Expand the Select Data Group pull-down menu and select a data group.

Click Select Trends and use the resulting dialog box to manage what trends appear in
the graph.

(Optional) Click the Set Scale button, remove the checkmark from Auto-scale, and enter
the minimum and maximum axis values.

Displaying the trend of Browse to any device-related page, such as the Devices page or a Device Dashboard
feature values page, and then select Test Panel from the View menu.

Click the Feature Trend tab and select a data group to view feature values for in the
pull-down menu in the top-left of the tab.

Viewing live domain data Browse to any device-related page for an EMSA device, such as the Devices page or a
Device Dashboard page, and then select Test Panel from the View menu.

Click the Time Domain tab and configure the options in the left side of the tab.

Viewing live data on the Time Domain tab pauses the current
spectrum sweep. The sweep resumes when you pause the live data

view again.
Recording live domain Browse to any device-related page for an EMSA device, such as the Devices page or a
data Device Dashboard page, and then select Test Panel from the View menu.
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Click the Audio tab and configure the options in the left side of the tab.

current spectrum sweep. The sweep resumes when the recording

o Recording live time domain data on the Audio tab pauses the
finishes.
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